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DAQ Quick Start Guide for NI-DAQ  7.0
This guide describes how to install NI-DAQ 7.0 driver software and a data 
acquisition (DAQ) device and confirm your device is operating properly. 

This guide does not apply to NI-DAQ for the Macintosh operating system, 
Mac OS. Refer to the NI-DAQ for Macintosh distribution.
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Conventions
The following conventions are used in this guide.

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options, and the names of LEDs. 

italic Italic text denotes a cross reference or an introduction to a key concept. This 
font also denotes text that is a placeholder for a word or value that you must 
supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, the proper names of disk drives, paths, directories, programs, 
functions, filenames, and extensions.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.

Where Do I Start?
Figure 1 shows the steps for installing NI-DAQ 7.0 and a DAQ device, and 
where to find the relevant information in the documentation.



© National Instruments Corporation 3 DAQ Quick Start Guide

Figure 1.  Installation Process Overview

* Device signal and terminal connections are available online from the Measurement & Automation Explorer Help for Traditional 
NI-DAQ and Measurement & Automation Explorer Help for NI-DAQmx, which you access from the Measurement & Automation 
Explorer (MAX) Help menu. In addition, device signal connections and additional signal information is in the device documentation 
available from the Device Document Browser. Refer to Step 10. Browse or Install Device Documentation for instructions on using 
the device documentation.

Check the NI-DAQ 7.0 Readme
for Operating System, Application Software, Programming

Language, and Device Support in NI-DAQ 7.0 to see which parts of 
NI-DAQ 7.0 to install and use in your application. Do not install 

NI-DAQ 7.0 if your existing applications include 
unsupported components.

NI-DAQmxTraditional 
NI-DAQ 

Use the DAQ Assistant, accessible 
from MAX or NI application software, 
to configure channels and measure-

ment tasks. Refer to the DAQ 
Assistant Help and Measurement 
& Automation Explorer Help for 

NI-DAQmx.

Use MAX to configure 
channels. Refer to Measurement &

Automation Explorer Help for 
Traditional NI-DAQ.

You have installed and configured your devices.

Install your driver software and documentation 
using the instructions in this guide.

Install, configure, and test your DAQ device as described in
this guide. Helpful information is also in the Measurement &
Automation Explorer (MAX) help files for Traditional NI-DAQ 

and for NI-DAQmx, and the device terminal help*.

Read about the new NI-DAQmx application programming
interface (API) and the other API choices in NI-DAQ 7.0,

described in this guide.

Confirm in the
NI-DAQ 7.0 Readme you have

installed the correct version of the application
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Upgrade using the instructions in
the application software.Yes

No

Yes

Install, configure, and test the 
module and/or chassis as described 

in the SCXI Quick Start Guide or 
NI Switches Getting Started Guide.

Configure channels 
as described in this guide. What API 

are you using to program
each device? 

Do you need to
install an SCXI or switch 

module? 

No
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NI-DAQ 7.0 Software
National Instruments measurement devices are packaged with NI-DAQ 
driver software, an extensive library of functions and VIs you can call from 
your application software, such as LabVIEW or LabWindows™/CVI™, 
to program all the features of your NI measurement devices. Measurement 
devices include DAQ devices such as the E Series multifunction I/O (MIO) 
devices, SCXI signal conditioning modules, and switch modules. Driver 
software has an application programming interface (API), which is a 
library of VIs, functions, classes, attributes, and properties for creating 
applications for your device.

NI-DAQ 7.0 includes two NI-DAQ drivers, each with its own API, 
hardware configuration, and software configuration. 

• Traditional NI-DAQ is an upgrade to the earlier version of NI-DAQ. 
Traditional NI-DAQ has the same VIs and functions and works the 
same way as NI-DAQ 6.9.3, except that you can use Traditional 
NI-DAQ and NI-DAQmx on the same computer. 

• NI-DAQmx is the latest NI-DAQ driver with new VIs and functions 
and development tools for programming measurement devices. 
NI-DAQmx has advantages over Traditional NI-DAQ.

– DAQ Assistant—a graphical way to configure channels and 
measurement tasks for your device for use in LabVIEW, 
LabWindows/CVI, and Measurement Studio. You also can use the 
DAQ Assistant to generate NI-DAQmx code for the task for use in 
NI application software programs.

– Increased performance, including faster single-point analog I/O 
and multithreading.

– Simpler, more intuitive APIs for creating DAQ applications using 
fewer functions and VIs than earlier versions of NI-DAQ.

– Expanded functionality in the NI-DAQmx API for LabVIEW, 
including property nodes for data acquisition and improved 
waveform data type support for analog I/O.

– Similar APIs and functionality for ANSI C, LabWindows/CVI, 
and Measurement Studio, including native .NET and C++ 
interfaces.

Who Can Use NI-DAQmx
Install and use NI-DAQmx if the following situations apply:

• You are using Windows.

• You are using only a PCI or PXI E Series multifunction DAQ device 
and/or a supported SCXI or SCC module. 
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• If you are using NI application software such as LabVIEW, 
LabWindows/CVI, or Measurement Studio, you must have version 7.0 
or later of the application software to use NI-DAQmx.

Note If you use one of the Measurement Studio .NET languages, you must use 
NI-DAQmx.

Who Must Use Traditional NI-DAQ
Install and use Traditional NI-DAQ if one of the following situations apply:

• You have a device that is not supported by NI-DAQmx, such as the AT 
E Series multifunction DAQ devices, digital I/O (DIO) devices, and 
dynamic signal acquisition devices.

• You are using an SCXI-1530, SCXI-1531, or SCXI-1540 device with 
accelerometer, linear-voltage differential transformer (LVDT), or 
rotary variable-differential transformer (RVDT) virtual channels, 
which are not supported by NI-DAQmx. 

• You are using the LabVIEW Real-Time (RT) module.

• You are upgrading from NI-DAQ 6.9.x and have existing applications 
that you do not want to port now. 

• You are using a version of LabVIEW, LabWindows/CVI, or 
Measurement Studio earlier than version 7.0.

• You are using Visual Basic 6.0.

Note The earliest version of NI application software supported by Traditional NI-DAQ is 
version 6.0. LabVIEW, LabWindows/CVI, or Measurement Studio versions 6.x can use 
Traditional NI-DAQ from the NI-DAQ 7.0 distribution.

No Longer Supported in Traditional NI-DAQ
The following items supported by NI-DAQ 6.9.3 are no longer supported 
in Traditional NI-DAQ. 

• NI LabVIEW, LabWindows/CVI, or Measurement Studio application 
software versions earlier than 6.0

• Windows 95

• Some older devices, such as the 1200 Series multifunction DAQ 
devices, VXI DAQ devices, or remote SCXI devices

Refer to the Operating System, Application Software, Programming 
Language, and Device Support in NI-DAQ 7.0 section at the end of this 
guide for the list of supported and unsupported items. 
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How NI-DAQ Fits into Your System
Figure 2 depicts the measurement system overview, showing the path of 
real-world physical phenomena to your measurement application. 

 

Figure 2.  Measurement System Overview
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manipulates the data so it can appear in a graph, chart, or file for a report. 
The software also controls the measurement system, telling the 
measurement device when and from which channels to acquire or generate 
data.

NI measurement devices and application software are packaged with 
NI-DAQ driver software to program all the features of your NI 
measurement device such as configuring, acquiring, and generating data 
from, and sending data to NI measurement devices. Using NI-DAQ saves 
you from having to write these programs yourself. Application software, 
such as LabVIEW, sends the commands to the driver, such as acquire and 
return a thermocouple reading, and then displays and analyzes the data 
acquired.

You can use the NI-DAQ driver from LabVIEW or from any programming 
environment that supports calling dynamic link libraries (DLLs) through 
ANSI C interfaces. Regardless of the programming environment, your 
DAQ application uses NI-DAQ, as illustrated in Figure 2. 

Step 1. Confirm That You Have Installed the Correct 
Application Software Version

If you are using NI application software, including LabVIEW, 
LabWindows/CVI, and Measurement Studio, install it now. You must use 
NI application software version 7.0 or later with NI-DAQmx. You can use 
NI application software version 6.0 or later with Traditional NI-DAQ. 
Refer to the Operating System, Application Software, Programming 
Language, and Device Support in NI-DAQ 7.0 section at the end of this 
guide.

Tip If you have an existing application written with an earlier version of your application 
software or NI-DAQ, make a backup copy of the application. You then can upgrade your 
software and modify the application. If you want to use the original application unchanged 
with the Traditional NI-DAQ API, you can use the backup copy.

Step 2. Uninstall NI-DAQ if You Are Upgrading from a 
Previous Version

If you are upgrading to NI-DAQ 7.0 from a previous version, uninstall 
the earlier version of NI-DAQ before installing the current version. 
Use Control Panels»Add/Remove Programs. Refer to ni.com/
support/install for operating system-specific uninstallation 
instructions. 
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Step 3. Install the NI-DAQ 7.0 Software

Insert the CD

The NI-DAQ 7.0 installer should open automatically. If not, select 
Start»Run. Enter x:\setup.exe, where x is the letter of the CD drive. 
For troubleshooting and operating system-specific instructions, refer to the 
Hardware Installation Wizard at ni.com/support/install.

Caution Do not install NI-DAQ 7.0 if your existing applications include unsupported 
components. Before installing the software, refer to the NI-DAQ 7.0 Readme file on the 
NI-DAQ 7.0 CD or the Operating System, Application Software, Programming Language, 
and Device Support in NI-DAQ 7.0 section at the end of this guide. 

Tip Install your driver software before installing new devices, or Windows may not detect 
your device, and you may see warnings asking you to install the driver.

Choose the API/s to Install

Caution NI-DAQ 7.0 cannot exist on the same system with earlier versions of NI-DAQ. 
When you install NI-DAQ 7.0, Traditional NI-DAQ replaces NI-DAQ 6.9.x and earlier 
versions, as well as any support files installed by that earlier version. Older versions of 
NI-DAQ are removed when you install NI-DAQmx. 

NI-DAQ 7.0 contains several drivers and their APIs—Traditional 
NI-DAQ, NI-DAQmx, and NI-SWITCH. You can install any or all of the 
drivers, depending on the devices you are using. Refer to the NI-DAQ 7.0 
Software section at the beginning of this guide for descriptions of 
Traditional NI-DAQ and NI-DAQmx. 

Install and use NI-SWITCH to program an NI switch module. NI-SWITCH 
is an IVI-compliant switch instrument driver that supports all NI switch 
modules. NI-SWITCH has an interactive soft front panel for testing and 
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troubleshooting switch applications. NI-SWITCH 2.0 requires you to 
install NI-DAQmx and NI-VISA 3.0. 

Install Support Files
The NI-DAQ 7.0 installer detects the NI software installed on the system 
and automatically selects the latest versions of the driver, application 
software, and language support files from the CD. 

 

1. Verify that the installer detected and selected the correct support files 
and the correct version number of the application software and/or 
language. Double-click the plus sign in front of a feature to expand the 
list of feature subcomponents as shown above. You can select 
additional options to install the support files, examples, and 
documentation. Follow the software prompts. 

Note If you install NI-DAQ 7.0 first, then later install NI application software version 7.0, 
you need to run the NI-DAQ 7.0 installer again to install the correct application software 
support.

2. Click Finish. 

3. When the installer completes, a message opens asking if you want to 
restart now. Click No and shut down the computer.

If you need to install an RT Series product, refer to the Hardware 
Installation Wizard at ni.com/support/install for setup 
instructions for RT Series products.

4. Power off and unplug the computer or PXI chassis. 
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Step 4. Unpack the Devices, Accessories, and Cables
Your device is shipped in an antistatic package to prevent electrostatic 
damage (ESD) to the device. ESD can damage several components on the 
device. 

Caution Never touch the exposed pins of connectors.

To avoid such damage, take the following precautions:

• Ground yourself using a grounding strap or by holding a grounded 
object. 

• Touch the antistatic package to a metal part of the computer chassis 
before removing the device from the package. 

Remove the device from the package and inspect the device for loose 
components or any sign of damage. Notify NI if the device appears 
damaged in any way. Do not install a damaged device in the computer, 
PXI chassis, or SCXI chassis. 

Store the device in the antistatic package when the device is not in use.

For safety and compliance information, refer to the device documentation 
as described in Step 10. Browse or Install Device Documentation.

Step 5. Install the Devices, Accessories, and Cables
If you have more than one DAQ device to install, install them all now. For 
more information about the hardware specifics of your device, such as slot 
requirements, refer to the device documentation as described in Step 10. 
Browse or Install Device Documentation.

If your system includes switch or SCXI signal conditioning modules that 
will be connected to DAQ devices, first install the DAQ components using 
this guide. 

Note The following instructions do not apply to RT Series products. Refer to the 
Hardware Installation Wizard at ni.com/support/install for setup instructions for 
RT Series products.
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PCI Devices

Caution Make sure the computer is powered off. Follow proper ESD precautions to ensure 
you are grounded before installing the hardware.

Complete the following steps to install a PCI device.

1. Remove the computer cover and the expansion slot cover. 

2. Touch any metal part of the computer to discharge any static electricity.

3. Insert the device into a PCI system slot. Gently rock the device into 
place. Do not force the device into place.

 

4. Screw the device mounting bracket to the computer back panel rail.

5. Replace the computer cover.

Your PCI device is installed.

1 PCI DAQ Board
2 PCI System Slot

3 PCI Computer

1
2

3



DAQ Quick Start Guide 12 ni.com

PXI Devices

Caution Make sure the PXI chassis is powered off. Follow proper ESD precautions to 
ensure you are grounded before installing the hardware.

Complete the following steps to install a PXI module.

1. Remove the filler panel of an unused PXI slot. For information on slot 
requirements, refer to the device documentation as described in
Step 10. Browse or Install Device Documentation.

2. Touch any metal part of the chassis to discharge any static electricity. 

3. Insert the device into the PXI slot. Use the injector/ejector handle to 
fully insert the device. 

4. Screw the device front panel to the chassis front panel mounting rail.
 

Your PXI device is installed.

1 PXI Chassis
2 PXI Module

3 Injector/Ejector Handle in Down 
Position

8

7

6

5

4

3

2

1

ON

STANDBY

1

2

3
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PCMCIA Devices
You can install an NI PCMCIA device in any available Type II PC Card 
slot. Complete the following steps to install a PCMCIA device.

Caution Make sure the computer is powered off. If your PCMCIA supports hot insertion, 
the computer may be powered on. Follow proper ESD precautions to ensure you are 
grounded before installing the hardware.

1. Remove the PCMCIA slot cover on your computer, if any.

2. Insert the PCMCIA bus connector of the PCMCIA device in the slot 
until the connector is firmly seated. NI PCMCIA devices have 
two connectors, a 68-pin PCMCIA bus connector on one end and 
an I/O connector on the other end. The PCMCIA device is keyed 
so that you can insert it only one way. 

3. Attach the I/O cable. Be careful not to put strain on the I/O cable when 
inserting or removing the cable connector. Always grasp the cable by 
the connector you are inserting or removing. Never pull directly on 
the I/O cable to unplug it from the PCMCIA device.

Your PCMCIA device is installed.

1 PCMCIA Computer
2 PCMCIA Socket
3 I/O Cable

4 Accessory
5 I/O Signals

®

1

2

3

4

5

DAQCard-700



DAQ Quick Start Guide 14 ni.com

USB/IEEE 1394 Devices

Caution Follow proper ESD precautions to ensure you are grounded before installing the 
hardware.

Note If you are using the BP-1 battery pack, follow the installation instructions in your 
BP-1 installation guide and disregard step 1 in this guide. The following instructions are 
correct if you are not using the BP-1 battery pack.

Complete the following steps to install an NI device for USB or 1394.

1. Some NI devices for USB or 1394 require external power.

• If your device has an external power supply, verify that the voltage 
on the external power supply, if any, matches the voltage in your 
area (120 or 230 VAC) and the voltage required by your device. 
Connect one end of the power supply to an electrical outlet and the 
other end to the rear of your device.

• If your device has a power cord, connect one end of the power cord 
to the device and the other end to an electrical outlet.

2. Connect the cable from the computer USB or 1394 port or from any 
other hub or 1394 device to any available USB or 1394 port on the 
device. Tighten the mounting screws, if any, for a firm connection. 
Connect the other end of the USB or 1394 cable to the USB or 
IEEE 1394 port on the device. The following figure shows the USB 
cable and its connectors.

Your USB/IEEE 1394 device is installed. If you have a USB or IEEE 1394 
device with a rear panel power switch, power on the device. 

Accessories
Install accessories, terminal blocks, and/or SCC modules according to 
the instructions in their installation guides. For SCXI, continue with the 
instructions in this guide until Step 12. Attach Sensors and Signals.

1 Connector to the Computer 
or USB Hub

2 Connector to the Device

1 2
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Step 6. Power on Your Computer or PXI Chassis
Windows recognizes any newly installed device the first time the computer 
reboots after hardware is installed. On some Windows systems, the Found 
New Hardware Wizard opens with a dialog box for every NI device 
installed. Install the software automatically (Recommended) is selected 
by default. Click Next or Yes to install the software for each device so 
Windows recognizes the device.

When the computer recognizes a USB or IEEE 1394 device, the power 
LED on the device blinks or lights up, depending on the status of your 
device. NI devices for IEEE 1394 also have a COM LED, which should 
blink when the device is detected. For LED pattern descriptions, refer to the 
device documentation as described in Step 10. Browse or Install Device 
Documentation.

Step 7. Launch Measurement & Automation Explorer (MAX)
Double-click the Measurement & Automation icon on the desktop to 
open MAX.

Step 8. Confirm That Your Device Is Recognized
1. Expand Devices and Interfaces.

2. Check that your device appears under Devices and Interfaces.

When a device is supported by both Traditional NI-DAQ and 
NI-DAQmx and both are installed, the same device is listed with a 
different name under the Traditional NI-DAQ and NI-DAQmx folders 
in Devices and Interfaces. If your device does not appear, press <F5> 
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to refresh the view in MAX. If the device is still not recognized, refer 
to ni.com/support/install for troubleshooting information.

3. Under the folder for the NI-DAQ API you are using to program the 
device, right-click the device you want to test. 

• If the device is under Traditional NI-DAQ, select Properties, 
then click Test Resources in the Properties window.

• If the device is under NI-DAQmx, select Self-Test.
 

4. When the self-test finishes, a message indicates if an error occurred. 
If an error occurs, refer to ni.com/support for troubleshooting 
information. 

Step 9. Configure Your Device Settings
Configure each device you install. To use a device in both Traditional 
NI-DAQ and NI-DAQmx, you must configure its properties in each.

1. Right-click the device name and select Properties. Be sure to click the 
device name under the folder for the NI-DAQ API in which you want 
to use the device.

2. Configure the device properties.

• If you are using an accessory, add the accessory information.

• If you are using a device in Traditional NI-DAQ, you can change 
its default settings for AI, AO, OPC, or Remote Access. Refer to 
your device documentation as described in the next step for more 
information about device default settings.

3. Click OK to accept the changes.
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Tip For devices supported by both Traditional NI-DAQ and NI-DAQmx, you can convert 
Traditional NI-DAQ virtual channel and scale configurations to an NI-DAQmx 
configuration with the Traditional NI-DAQ to NI-DAQmx Configuration Converter 
Wizard. The wizard also converts SCXI and accessory configurations, but not SCC 
configurations. You must configure SCC information separately in each API you want to 
use. Refer to the Converting Traditional NI-DAQ Configurations to NI-DAQmx 
Configurations section of the Measurement & Automation Explorer Help for NI-DAQmx 
for instructions.

Step 10. Browse or Install Device Documentation
The NI-DAQ 7.0 software distribution includes the Device Documentation 
CD, which contains online documentation for supported DAQ, SCXI, and 
switch devices. Device documentation includes help files describing device 
terminals, device features, device operation, and PDF files of the device 
documents. You can use the Device Document Browser to find, view, and 
print the documents for each device. 

You can use the NI-DAQ Device Document Browser at any time by 
inserting the NI-DAQ 7.0 Device Documentation CD. The NI-DAQ 7.0 
document browser has the following options:

• Browse Device Documents opens the document browser and displays 
the device documentation for each device. 

• Install Device Documents copies the document browser and all 
device documents to the hard drive. After installation, the browser is 
accessible from Start»Programs»National Instruments»NI-DAQ» 
Browse Device Documentation.

If the browser does not open automatically, select Start»Run and enter 
x:\autorun.exe, where x is the letter of the CD drive.

Note You must have Internet Explorer version 5.0 or later to use some features of the 
NI-DAQ 7.0 documentation, including the help system and Device Document Browser.

Step 11. Install SCXI or Switch Modules, if Applicable
If your system includes SCXI signal conditioning or switch modules to 
connect to DAQ devices, refer to the SCXI Quick Start Guide and the 
NI Switches Getting Started Guide to install and configure the SCXI and 
switch hardware.

The rest of this guide applies only to DAQ devices with terminal blocks or 
SCC accessories.
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Step 12. Attach Sensors and Signals
Wire sensors and signals to the device or accessory terminals.

Helpful information is in the following documentation: 

• Signal and terminal connections:

– The E Series Help, device user manual PDFs, and accessory PDFs 
are on the Device Document Browser.

– Pin assignments also are located in the Measurement & 
Automation Explorer Help for Traditional NI-DAQ and the 
Measurement & Automation Explorer Help for NI-DAQmx, 
accessible from the MAX Help menu.

• Switch specifications include a topology of the device.

• Using sensors:

– If you are using LabVIEW, refer to the LabVIEW Measurements 
Manual packaged with LabVIEW or available from ni.com/
manuals. 

– If you are using another programming environment and 
NI-DAQmx, refer to the Sensors topic of the NI-DAQmx Help, 
which you can access from Start»Programs»National 
Instruments» NI-DAQ»NI-DAQmx Help. 

– If you are using another programming environment and 
Traditional NI-DAQ, refer to Chapter 5, Transducer Conversion 
Functions, of the Traditional NI-DAQ User Manual, which you 
can access from Start»Programs»National Instruments»
NI-DAQ»Traditional NI-DAQ User Manual. 

Step 13. Run Test Panels
Many devices have a test panel for testing specific device functionality, 
such as the ability to acquire and generate signals.

1. Open the MAX help for operating test panels. 

a. In MAX, select Help»Help Topics»NI-DAQmx or Traditional 
NI-DAQ, whichever you will test. The MAX help opens.

b. In the Contents tab, expand the books Measurement & 
Automation Explorer»MAX for the version of NI-DAQ you 
will test»Getting Started»DAQ Devices»Testing DAQ Devices.

c. Click Testing DAQ Devices to open the help topics for operating 
the test panels.

d. Shrink the Help window and drag it to the right to uncover the 
MAX Configuration pane.
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2. Click MAX to make it the active window. 

3. Under Traditional NI-DAQ Devices or NI-DAQmx Devices, 
right-click the device to test. 

4. Select Test Panels to open a test panel for the selected device. 

An example of a test panel is shown in the following figure. 
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5. Click the tabs to test different functions of the device. Click the MAX 
Help window for instructions on operating the test panels in 
Traditional NI-DAQ and NI-DAQmx.

6. The test panel displays a message indicating if an error occurred. Refer 
to the NI-DAQmx Reference Help or ni.com/support for 
troubleshooting information. 

7. When you finish, click Close or OK to exit the test panel.

Step 14. Configure Any Additional New Devices
If you installed more than one DAQ device, repeat steps 9 through 13 for 
each device. 

Step 15. Configure Channels and Tasks
A physical channel is a terminal or pin at which you can measure or 
generate an analog or digital signal. A virtual channel is a collection of 
settings that can include a name, a physical channel, input terminal 
connections, the type of measurement or generation, and scaling 
information. In Traditional NI-DAQ and earlier versions, configuring 
virtual channels is an optional way to record which channels are being used 
for different measurements. In NI-DAQmx, virtual channels are integral to 
every measurement.

In Traditional NI-DAQ, you configure virtual channels using MAX. In 
NI-DAQmx, you can configure virtual channels with the DAQ Assistant, 
which you can open from MAX or your application software. You also can 
configure virtual channels with the NI-DAQmx API in your application 
program.

A task, an important new concept for NI-DAQmx, is a collection of one 
or more virtual channels with timing, triggering, and other properties. 
Conceptually, a task represents a measurement or generation you want to 
perform. You can set up and save all of the configuration information in a 
task and use the task in an application.

In NI-DAQmx, you can configure virtual channels as part of a task or 
separate from a task. Virtual channels created inside a task are local 
channels. Virtual channels defined outside a task are global channels. 
You can create global channels in MAX or in your application software. 
You can use global channels in any application or add them to a number of 
different tasks. If you modify a global channel, the change affects all tasks 
in which you reference that global channel. In most cases, it is simpler to 
use local channels.
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Configure a Task in NI-DAQmx
Configure tasks with the DAQ Assistant when you use NI-DAQmx. You 
must have version 7.0 of an NI application software package to create tasks 
and channels with the DAQ Assistant.

• In MAX, right-click Data Neighborhood and select Create New. 
In the Create New window, select NI-DAQmx Task and click Next.

• You also can open the DAQ Assistant directly from within 
NI application software.

– In LabVIEW, there are several ways to open the DAQ Assistant:

• Drop the DAQ Assistant Express VI from the Express Input 
palette, as described in Getting Started with LabVIEW. 

• You also can use the DAQmx Task Name control to open the 
DAQ Assistant. Right-click the control and select New Task 
(DAQ Assistant). The Taking an NI-DAQmx Measurement 
in LabVIEW help tutorial has step-by-step instructions on 
how to create a task from the DAQmx Task Name control and 
generate code for the task. In LabVIEW, select Help»Taking 
an NI-DAQmx Measurement to open the tutorial.

– In LabWindows/CVI, select Tools»Create/Edit DAQmx Tasks. 

– In Measurement Studio, open Visual Studio .NET and select 
Project»Add New Item to open the Add New Item dialog box. 
In the Categories pane, select Measurement Studio»Assistants. 
In the Templates pane, select DAQmx Task Class.

The DAQ Assistant opens.
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Follow the online instructions to create a new task. 

1. Select an I/O type, such as analog input.

2. Select the measurement or generation to perform.

3. Choose the sensor to use, if applicable.

4. Select the channels to add to the task. You can add global channels to 
the task or select physical channels from which to create local channels 
in the task.

5. Configure measurement-specific settings, timing, and triggering, 
if necessary. 

6. Save the task.

• If you opened the DAQ Assistant from LabVIEW or 
LabWindows/CVI, click OK. 

• If you opened the DAQ Assistant from Measurement Studio, 
select File»Save. 

• If you opened the DAQ Assistant from MAX, click Save Task. 

You now can use the task in an application. Refer to the DAQ Assistant 
Help or application software documentation for more information about 
using a task or generating code.

Configure Global Channels for NI-DAQmx
Configure global channels with the DAQ Assistant when you use 
NI-DAQmx.

• In MAX, right-click Data Neighborhood and select Create New. 
In the Create New window, select NI-DAQmx Global Channel and 
click Next.

• You also can open the DAQ Assistant directly from within 
LabVIEW 7.0, LabWindows/CVI 7.0, or Measurement Studio 7.0.

– In LabVIEW, use the DAQmx Global Channel control to open the 
DAQ Assistant. Right-click the control and select New Channel 
(DAQ Assistant).

– In LabWindows/CVI or Measurement Studio, you first must 
create a task as previously described. In the DAQ Assistant, click 
Add Existing DAQmx Global Channels to add global channels 
to your task. 

The DAQ Assistant opens. Follow the online instructions to create a new 
global channel.

1. Select an I/O type, such as analog input. 

2. Select the measurement or generation to perform. 

3. Choose the sensor to use, if applicable. 
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4. Select the physical channels to use. 

5. Configure measurement-specific settings. 

6. Save the task.

• If you opened the DAQ Assistant from LabVIEW or 
LabWindows/CVI, click OK. 

• If you opened the DAQ Assistant from Measurement Studio, 
select File»Save. 

• If you opened the DAQ Assistant from MAX, click Save 
Channel. 

You now can use the global channel in an application or add the global 
channel to a task. Refer to the DAQ Assistant Help or application software 
documentation for more information about using a channel or generating 
code.

Configure Virtual Channels for Traditional NI-DAQ
When you use Traditional NI-DAQ, configure virtual channels in MAX. 

1. In MAX, right-click Data Neighborhood and select Create New. 

2. Select Traditional NI-DAQ Virtual Channel in the Create New 
window and click Finish. The Create New Channel Wizard opens. 

3. Follow the instructions in the Create New Channel Wizard to create a 
new channel. For additional information about configuring different 
channel types, refer to the Measurement & Automation Explorer Help 
for Traditional NI-DAQ.
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Getting Started Developing an Application

Examples
Each API includes a collection of programming examples to help you get 
started developing an application. You can modify example code and save 
it in an application. You can use examples to develop a new application or 
add example code to an existing application.

To locate LabVIEW and LabWindows/CVI examples, open the National 
Instruments Example Finder.

• In LabVIEW, select Help»Find Examples.

• In LabWindows/CVI, select Help»NI Example Finder.

Measurement Studio, Visual Basic, and ANSI C examples are in the 
following directories:

• NI-DAQmx examples for Measurement Studio-supported languages 
are in the following directories:

– MeasurementStudio\VCNET\Examples\DAQmx 

– MeasurementStudio\DotNET\Examples\DAQmx

• Traditional NI-DAQ examples for Visual Basic are in the following 
directories:

– The NI-DAQ\Examples\Visual Basic with Measurement 
Studio directory contains a link to the ActiveX control examples 
for use with Measurement Studio 

– The NI-DAQ\Examples\VBasic directory contains the 
examples not associated with Measurement Studio

• NI-DAQmx examples for ANSI C are in the NI-DAQ\Examples\
DAQmx ANSI C directory.

• Traditional NI-DAQ examples for ANSI C are in the NI-DAQ\
Examples\VisualC directory.

For additional examples, refer to ni.com/zone.

Information about Measurement Applications and Devices
Each application software package and driver includes information about 
writing applications for taking measurements and controlling measurement 
devices. The following references to documents assume you have 
NI-DAQ 7.0, and where applicable, version 7.0 of the NI application 
software.
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LabVIEW
If you are a new user, read Getting Started with LabVIEW to get acquainted 
with LabVIEW. Select Start»Programs»National Instruments»
LabVIEW»Search the LabVIEW Bookshelf. 

The LabVIEW Measurements Manual contains API overviews of 
Traditional NI-DAQ and NI-DAQmx, and describes measurement 
concepts. Select Start»Programs»National Instruments»LabVIEW» 
Search the LabVIEW Bookshelf.

The Taking an NI-DAQmx Measurement in LabVIEW help tutorial has 
step-by-step instructions on how to set up a measurement in LabVIEW and 
describes key new NI-DAQmx features and concepts such as the DAQ 
Assistant and tasks. Select Help»Taking an NI-DAQmx Measurement in 
LabVIEW to open the tutorial.

The LabVIEW Traditional NI-DAQ VI Reference Help and the LabVIEW 
NI-DAQmx VI Reference Help describe the LabVIEW VIs and properties. 
In LabVIEW, select Help and the LabVIEW VI reference help for the 
NI-DAQ API you are using. 

LabWindows/CVI
The Data Acquisition Library book of the main LabWindows/CVI Help 
contains API overviews, measurement concepts, and function references 
for Traditional NI-DAQ and NI-DAQmx. In LabWindows/CVI, select 
Help»Contents.

Measurement Studio
The NI Measurement Studio Help contains the NI-DAQmx API overview, 
measurement tasks and concepts, and function reference. This help file is 
integrated into the Visual Studio .NET documentation. In Visual Studio 
.NET, select Help»Contents.

The Measurement Studio Reference contains the Traditional NI-DAQ API 
overview, measurement concepts, and function reference. In Visual Studio 
.NET, select Measurement Studio»Measurement Studio Reference. 

ANSI C without NI Application Software
The Traditional NI-DAQ User Manual and the NI-DAQmx Help contain 
API overviews. The NI-DAQmx Help also contains general information 
about measurement concepts. The Traditional NI-DAQ C Reference Help 
and the NI-DAQmx C Reference Help describe the C functions and 
attributes. Select Start»Programs»National Instruments»NI-DAQ and 
the document title for the NI-DAQ API you are using.
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.NET Languages without NI Application Software
The NI Measurement Studio Help contains the NI-DAQmx API overview, 
measurement tasks and concepts, and function reference. This help file is 
integrated into the Visual Studio .NET documentation. In Visual Studio 
.NET, select Help»Contents.

Note If you use a .NET language without Visual Studio .NET, you might not be able to 
view the NI Measurement Studio Help.

Device Documentation
NI-DAQ 7.0 includes the Device Document Browser, which contains 
online documentation for supported DAQ, SCXI, and switch devices, such 
as help files describing device pinouts, features, and operation, and PDF 
files of the printed device documents. You can find, view, and/or print the 
documents for each device using the Device Document Browser at any 
time by inserting the CD. After installing the Device Document Browser, 
device documents are accessible from Start»Programs»National 
Instruments»NI-DAQ»Browse Device Documentation. 

SCXI and Switch Multi-Chassis Configurations
The SCXI-1346 Shielded Multi-Chassis Cable Adapter Installation Guide 
contains setup instructions for developing SCXI and switch multi-chassis 
applications.

Switch 
The NI Switches Help contains technical and programming support for the 
switch module and the NI-SWITCH instrument driver.

The NI-SWITCH Instrument Driver Quick Reference Guide contains an 
API overview and function/VI overview.

Training Courses
If you need more help getting started developing an application with 
NI products, NI offers training courses. To enroll in a course or obtain 
a detailed course outline, refer to ni.com/training. 

Technical Support
For additional support, refer to ni.com/support or ni.com/zone. 



© National Instruments Corporation 27 DAQ Quick Start Guide

Using Traditional NI-DAQ and NI-DAQmx on the 
Same Computer

Existing applications developed with earlier versions of NI-DAQ will run 
under Traditional NI-DAQ. You can use both the Traditional NI-DAQ API 
and the NI-DAQmx API on the same computer with the following 
restrictions:

• Only one API controls a given device at one time.

– After using a device in NI-DAQmx, you must unreserve all 
NI-DAQmx tasks that are using that device before you can use that 
device through Traditional NI-DAQ. To unreserve NI-DAQmx 
tasks, call the DAQmx Clear Task VIs or functions. 

– After using a device in Traditional NI-DAQ, you must reset the 
device before you can use that device in NI-DAQmx. For SCXI 
devices, you must reset the communicator DAQ device.

• Call the Traditional NI-DAQ Device Reset VI or the 
Init_DA_Brds function. 

• To reset all devices in Traditional NI-DAQ, right-click the 
Traditional NI-DAQ Devices folder in MAX and select 
Reset Driver for Traditional NI-DAQ. 

• You must use the same API to program all devices—connected DAQ 
devices and inserted SCXI modules—in an SCXI data acquisition 
system.

Refer to ni.com/support for details and instructions about the following 
topics:

• How to add NI-DAQmx code to a Traditional NI-DAQ application

• How to run both Traditional NI-DAQ applications and NI-DAQmx 
applications that use the same device
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Operating System, Application Software, Programming 
Language, and Device Support in NI-DAQ 7.0

Version 7.0 of NI-DAQmx does not yet support the full line of NI 
measurement devices. The next few releases of NI-DAQ will add support 
for new and existing devices in NI-DAQmx, and will continue to include 
Traditional NI-DAQ.

Operating System Support
NI-DAQmx, Traditional NI-DAQ, and NI-SWITCH 2.0 support 
Windows 2000/NT/XP/Me/98. NI-DAQ 7.0 on Windows NT requires 
Service Pack 6 or later. Measurement Studio requires Visual Studio 
.NET 2003, which requires Windows 2000/NT 4.0/XP. For operating 
system-specific installation instructions, use the Hardware Installation 
Wizard at ni.com/support/install.

To find and download an earlier version of NI-DAQ that supports other 
operating systems, refer to ni.com/downloads. 

Application Software and Programming Language Support
Table 1 lists the application software versions supported by NI-DAQmx 
and Traditional NI-DAQ. If you are not using NI application software, refer 
to Table 2.

 
Table 1.  NI-DAQ 7.0 Application Software Support

NI Application Software

Versions 
Supported by 
NI-DAQmx

Versions 
Supported by 

Traditional 
NI-DAQ

LabVIEW  7.0 6.0–7.0

LabVIEW RT module — 6.0–7.01 

LabWindows/CVI  7.0 6.0–7.0

Measurement Studio  7.0 6.0–7.02

1 LabVIEW RT users must use Traditional NI-DAQ for their DAQ applications. A future 
version of NI-DAQmx will support LabVIEW RT.
2 Traditional NI-DAQ does not include a Measurement Studio C++ or .NET interface.
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Table 2 lists the programming languages and versions supported by 
NI-DAQmx and Traditional NI-DAQ. 

 

Earlier versions of NI-DAQ support other application software and 
language versions. To find and download an earlier version of a driver, 
refer to ni.com/downloads.

Device Support
For specific device model names, refer to the NI-DAQ 7.0 Readme file on 
the CD. Table 3 lists the families of devices supported by NI-DAQmx, 
Traditional NI-DAQ, and NI-SWITCH 2.0. 

Table 2.  NI-DAQ 7.0 Programming Language Support

Programming Language

Versions 
Supported by 
NI-DAQmx

Versions 
Supported by 

Traditional 
NI-DAQ

ANSI C ✓ ✓

Microsoft Visual C++
Class libraries
C DLL

7.01

6.0–7.0
—

6.0–7.0

Visual Basic 6.0 through ActiveX — 6.0

Microsoft .NET languages 
(C# and Visual Basic .NET)

.NET 1.1 —

1 Requires Measurement Studio version 7.0.

Table 3.  NI-DAQ 7.0 Device Support

Device NI-DAQmx
Traditional 

NI-DAQ NI-SWITCH 2.0

PCI and PXI E Series multifunction DAQ 
devices, such as the NI PCI-6052E

✓ ✓ not applicable

DAQPad devices for USB and FireWire 
(IEEE 1394)

— ✓ not applicable

DAQCard E Series PCMCIA devices — ✓ not applicable

NI PCI-6013/6014 16-bit basic 
multifunction DAQ devices

— ✓ not applicable

S Series multifunction DAQ devices, 
such as the NI PXI-6115

— ✓ not applicable
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Refer to the NI-DAQ 7.0 Readme file on the NI-DAQ 7.0 CD for the list of 
new devices supported by NI-DAQ 7.0.

More Devices in Future Releases of NI-DAQmx
Future releases of NI-DAQ will support additional devices in NI-DAQmx 
that are currently supported only in Traditional NI-DAQ. 

Digital I/O devices, such as the NI 653X 
family of devices

— ✓ not applicable

NI PCI-4551, PCI-4552, and PCI and 
PXI-4472 dynamic signal acquisition 
devices

— ✓ not applicable

NI PCI and PXI 671X/673X analog output 
devices

— ✓ not applicable

NI 660X counter/timer I/O devices — ✓ not applicable

NI SCXI-1530, SCXI-1531, 
and SCXI-1540 signal conditioning 
modules

✓1 ✓ not applicable

All other SCXI signal conditioning 
modules

✓ ✓ not applicable

SCC Series signal conditioning modules ✓ ✓ not applicable

NI SCXI-1166 and SCXI-1193 switch 
modules

✓ — ✓

All other SCXI switch modules ✓ ✓ ✓

NI PXI-2566 and PXI-2593 switch 
modules

✓ — ✓

All other PXI switch modules — — ✓

NI PXI-4204 and PXI-4220 modules ✓ — —

1 These devices are supported in NI-DAQmx without support for accelerometer, linear-voltage differential transformer 
(LVDT), and rotary variable-differential transformer (RVDT) virtual channels.

Table 3.  NI-DAQ 7.0 Device Support (Continued)

Device NI-DAQmx
Traditional 

NI-DAQ NI-SWITCH 2.0
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Devices Restricted to Traditional NI-DAQ
NI-DAQmx does not support the following devices and will not support 
them in future NI-DAQ releases. The following devices are supported 
only in Traditional NI-DAQ.

• AT E Series devices 

• AT-AO-6/10 analog output devices 

• AT-DIO-32F 32-bit parallel DIO devices

• DAQCard-AI-16E-4 and DAQCard-AI-16XE-50 PCMCIA devices

• NI PCI-4451/4452/4454 dynamic signal acquisition and generation 
devices

• NI 4350/4351 data loggers

Devices No Longer Supported in NI-DAQ 7.0
The following products are not supported in NI-DAQ 7.0—in neither 
NI-DAQmx nor Traditional NI-DAQ—and will not be supported in future 
versions of NI-DAQ. You must use NI-DAQ 6.9.x or earlier to program 
these devices.

• AT-MIO-16F-5 multifunction DAQ device

• DAQCard-500, DAQCard-516, DAQCard-700, DAQCard-1200, and 
DAQCard-AO-2DC PCMCIA devices

• DAQPad-1200 and DAQPad-MIO-16XE-50 devices for parallel port

• Lab-PC family of ISA and PC/XT MIO devices

• PC-516 16-bit, 50 kS/s MIO device

• PC-AO-2DC low-cost AO and current loop DAQ device

• PC-LPM-16PnP MIO device for the PC

• PC-OPDIO-16 optically isolated DIO device for the PC

• PC-TIO-10 timing and DIO interface for the PC

• PCI-1200 12-bit, 100 kS/s MIO device

• SCXI-1200 12-bit DAQ and control module

• SCXI-2000 4-slot chassis

• SCXI-2400 serial interface module

• VXI DAQ modules, VXI-SC carriers and modules, and VXI-TB 
terminal blocks for VXI bus
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Guide de démarrage DAQ pour 
NI-DAQ 7.0

Ce guide décrit les étapes à suivre pour installer le driver NI-DAQ 7.0 ainsi 
qu’un périphérique d’acquisition de données (DAQ), et confirmer que ce 
périphérique fonctionne correctement. 

Ces instructions ne s’appliquent pas à la version de NI-DAQ pour 
Macintosh. Reportez-vous à la documentation de NI-DAQ pour Macintosh.
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Conventions
Les conventions suivantes sont utilisées dans ce guide :

» Le symbole » vous dirige vers les éléments de menu emboîtés et les options 
de boîtes de dialogue donnant lieu à une action finale. La séquence 
Fichier»Mise en page»Options vous invite à cliquer sur le menu déroulant 
Fichier, à sélectionner l’élément Mise en page, puis Options dans la 
dernière boîte de dialogue.

Cette icône signale une astuce qui vous donne des recommandations.

Cette icône signale une remarque qui vous donne des informations 
importantes.

Cette icône signale un avertissement qui vous indique les précautions à 
prendre pour éviter des dégradations, des pertes de données ou un blocage 
du système.

gras Le texte en gras signale les éléments que vous devez sélectionner ou sur 
lesquels vous devez cliquer dans le logiciel, par exemple les éléments de 
menus, les options de boîtes de dialogue ou le nom des LED. 

italique Le texte en italique signale une référence croisée ou une introduction à un 
concept clé. Il indique également un texte que vous devez remplacer par un 
mot ou une valeur.
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italique monospace Le texte en italique de cette police signale le texte qui sert d’emplacement 
à un mot ou une valeur que vous devez fournir.

monospace Cette police signale du texte ou des caractères que vous devez saisir à partir 
du clavier, des noms propres de disques durs, des chemins, des 
programmes, des fonctions, des noms de fichiers et des extensions.

Par où commencer ?
La figure 1 montre les étapes pour installer NI-DAQ 7.0 et un périphérique 
DAQ, et indique où trouver les informations appropriées dans la 
documentation.
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Figure 1.  Vue d’ensemble de la méthode d’installation

* Le nom des signaux ainsi que les connexions des terminaux sont disponibles en ligne dans l’Aide de Measurement & Automation 
Explorer pour la version traditionnelle de NI-DAQ et dans Measurement & Automation Explorer Help for NI-DAQmx, documents 
accessibles à partir du menu Aide de Measurement & Automation Explorer (MAX). En outre, ces informations et bien d’autres sont 
dans la documentation du périphérique, disponible dans l’explorateur Device Document Browser. Reportez-vous à l’Étape 10. 
Naviguer dans la documentation du périphérique ou installer celle-ci pour obtenir des instructions sur la façon d’utiliser la 
documentation du périphérique.

Consultez la partie Systèmes d'exploitation, 
environnements de développement, langages et périphériques 

supportés par NI-DAQ 7.0 du document Readme NI-DAQ 7.0 pour 
connaître les éléments de NI-DAQ 7.0 que vous pouvez installer et  

utiliser pour votre application. N'installez pas NI-DAQ 7.0 si 
votre application existante contient des éléments qui 

ne le supportent pas.

NI-DAQmxNI-DAQ 
traditionnel

Utilisez l'assistant DAQ, accessible 
 à partir de MAX ou du logiciel 

d'applications NI, pour configurer 
les voies et les tâches de mesures. 
Reportez-vous à l'aide de l'assistant 

DAQ ou à Measurement & 
Automation Explorer Help 

for NI-DAQmx.

Utilisez MAX pour configurer les 
voies. Reportez-vous à Aide de 

Measurement & Automation 
Explorer pour la version 
traditionnelle de NI-DAQ.

Vous avez installé et configuré vos périphériques.

Installez votre driver et sa documentation en suivant 
les instructions de ce guide.

Installez, configurez et testez votre périphérique DAQ selon la méthode  
 décrite dans ce guide. Des informations pratiques sont disponibles  

 dans les fichiers d'aide de Measurement & Automation Explorer (MAX) 
 et dans la documentation du périphérique.

Lisez les informations dans ce guide au sujet des différentes 
APIs de NI-DAQ 7.0, en particulier celle de NI-DAQmx.

Utilisez Readme 
NI-DAQ 7.0 pour confirmer que 

vous avez installé la version correcte du logiciel 
 d'applications.  Avez-vous besoin 

 d'une mise à jour?

Mettez à jour le logiciel 
d'applications en suivant les 

 instructions fournies par celui-ci.Oui

Non

Oui

Configurez les 
voies en suivant les instructions 

 de ce guide. Quelle API utilisez-vous pour  
 programmer chaque 

périphérique?

Devez-vous installer un 
module de commutation 

ou SCXI?

Non

Installez, configurez et testez les 
modules et/ou les châssis selon la 

méthode décrite dans Guide de 
démarrage SCXI ou 

NI Switches Getting Started Guide.
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Driver NI-DAQ 7.0
Les périphériques de mesures de National Instruments sont livrés avec le 
driver NI-DAQ, une bibliothèque de fonctions et de VIs que vous pouvez 
appeler à partir d’un environnement de développement, tel que LabVIEW 
ou LabWindows™/CVI™, pour programmer toutes les fonctionnalités de 
vos périphériques de mesures NI. Les Périphériques de mesures incluent 
les périphériques DAQ tels que les modules d’E/S multifonctions de la 
série E (MIO), les modules de conditionnement de signaux SCXI et les 
modules de commutation. Le driver est constitué d’une API (Application 
Programming Interface) qui est une bibliothèque de VIs, fonctions, classes, 
attributs et propriétés pour créer des applications pour votre périphérique.

NI-DAQ 7.0 comprend deux drivers NI-DAQ, chacun avec sa propre API 
et sa propre configuration matérielle et logicielle. 

• NI-DAQ traditionnel est une mise à jour de la version antérieure de 
NI-DAQ. Ce driver comprend les mêmes VIs et fonctions que 
NI-DAQ 6.9.3, fonctionne de la même manière, sauf que vous pouvez 
utiliser NI-DAQ traditionnel et NI-DAQmx sur le même ordinateur. 

• NI-DAQmx est le tout dernier driver NI-DAQ. Il comprend de 
nouveaux VIs, de nouvelles fonctions et de nouveaux outils de 
développement pour programmer les périphériques de mesure. 
Il possède des avantages supplémentaires par rapport à NI-DAQ 
traditionnel.

– Assistant DAQ : méthode graphique pour configurer des voies et 
des tâches de mesures pour utiliser votre périphérique avec 
LabVIEW, LabWindows/CVI et Measurement Studio. Vous 
pouvez aussi utiliser l’Assistant DAQ pour générer le code 
NI-DAQmx de la tâche dans un programme développé avec un 
logiciel d’application NI.

– Performances plus élevées, notamment l’E/S d’une valeur 
analogique unique plus rapide et le multithreading pris en charge.

– API plus simple et plus intuitive pour créer des applications DAQ 
grâce à un nombre réduit de fonctions et de VIs comparé aux 
versions antérieures de NI-DAQ.

– Fonctionnalités étendues dans l’API NI-DAQmx pour LabVIEW, 
notamment des nœuds de propriété pour l’acquisition de données 
et un support de type de données waveform amélioré pour les E/S 
analogiques.

– Fonctionnalités et API similaires pour ANSI C, LabWindows/CVI 
et Measurement Studio, y compris les interfaces natives .NET 
et C++.
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Qui peut se servir de NI-DAQmx ?
Installez et utilisez NI-DAQmx si les situations suivantes vous concernent :

• Vous utilisez Windows.

• Vous utilisez un périphérique PCI ou PXI DAQ multifonctions de la 
série E uniquement et/ou un module SCXI ou SCC supporté. 

• Si vous programmez avec LabVIEW, LabWindows/CVI ou 
Measurement Studio, vous devez avoir au moins la version 7.0 de ces 
logiciels d’application pour utiliser NI-DAQmx.

Remarque Si vous utilisez un des langages .NET de Measurement Studio, vous devez 
utiliser NI-DAQmx.

Qui peut se servir de NI-DAQ traditionnel ?
Installez et utilisez NI-DAQ traditionnel si l’une des situations suivantes 
s’appliquent :

• Vous avez un périphérique qui n’est pas supporté par NI-DAQmx, 
comme les périphériques DAQ multifonctions de la série E au format 
AT, les périphériques d’E/S numériques (DIO) et les périphériques 
d’acquisition de signaux dynamiques.

• Vous utilisez des voies virtuelles dédiées à des mesures 
d’accéléromètres, de LVDT et de RVDT avec des modules de 
conditionnement de signaux SCXI-1530, SCXI-1531 et SCXI-1540 
qui ne sont pas prises en charge par NI-DAQmx. 

• Vous utilisez le module LabVIEW Real-Time (RT).

• Vous effectuez la mise à jour de NI-DAQ depuis NI-DAQ 6.9.x et vous 
avez des applications existantes que vous ne voulez pas convertir 
maintenant. 

• Vous utilisez une version de LabVIEW, LabWindows/CVI et 
Measurement Studio antérieure à la version 7.0.

• Vous utilisez Visual Basic 6.0.

Remarque NI-DAQ traditionnel ne prend en charge les logiciels d’application NI qu’à 
partir des versions 6.0. Les versions 6.x de LabVIEW, LabWindows/CVI et Measurement 
Studio peuvent utiliser le NI-DAQ traditionnel de la distribution NI-DAQ 7.0.
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Ce qui n’est plus supporté par NI-DAQ traditionnel
NI-DAQ 6.9.3 est la dernière version de NI-DAQ à supporter les éléments 
suivants : 

• Les versions de LabVIEW, LabWindows/CVI et Measurement Studio 
antérieures à 6.0

• Windows 95

• Certains périphériques anciens, tels que les périphériques DAQ 
multifonctions de la série 1200, les périphériques VXI DAQ ou les 
périphériques SCXI déportés.

Reportez-vous à la section Systèmes d’exploitation, logiciels d’application, 
langages de programmation et périphériques supportés par NI-DAQ 7.0 à 
la fin de ce guide pour obtenir la liste complète des éléments supportés ou 
non. 

Comment NI-DAQ s’ajuste à votre système ?
La figure 2 présente une vue d’ensemble du système de mesures, en 
montrant la chaîne allant du phénomène physique à votre application de 
mesures. 
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Figure 2.  Vue d’ensemble du système de mesures

L’ordinateur reçoit des rangées de données via le périphérique de mesures. 
Le système de conditionnement utilise des capteurs et transducteurs pour 
convertir des phénomènes physiques de manière à ce que le périphérique de 
mesure puisse facilement récupérer les données. Le logiciel prend les 
rangées de données, les présente sous une forme compréhensible et les gère 
pour qu’elles apparaissent dans un graphe, un fichier ou un rapport. 
Le logiciel contrôle aussi le système de mesures, précisant au périphérique 
quand il doit acquérir ou générer les données, et sur quelles voies.
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Les périphériques de mesures et les logiciels d’application NI sont livrés 
avec le driver NI-DAQ qui permet de programmer toutes les fonctionnalités 
de vos périphériques comme la configuration, l’acquisition et la génération 
de données, et l’envoi de données à votre périphérique. NI-DAQ vous 
épargne d’avoir à écrire tous ces programmes vous-même. Le logiciel 
d’application, LabVIEW par exemple, envoie les commandes au driver, 
comme l’acquisition et la lecture d’un thermocouple, puis affiche et analyse 
les données acquises.

Vous pouvez utiliser le driver NI-DAQ à partir de LabVIEW ou de 
n’importe quel environnement de développement qui supporte les appels de 
DLLs via des interfaces ANSI C. Indépendamment de votre environnement 
de développement, votre application d’acquisition de données utilise 
NI-DAQ, comme illustré dans la figure 2. 

Étape 1. S’assurer que vous avez installé la version 
correcte du logiciel d’application

Si vous utilisez un logiciel d’application NI comme LabVIEW, 
LabWindows/CVI et Measurement Studio, installez-le maintenant. Vous 
devez avoir la version 7.0 de votre logiciel ou la version ultérieure pour 
l’utiliser avec NI-DAQmx. Vous pouvez utiliser la version 6.0 ou ultérieure 
du logiciel d’application de National Instruments pour l’utiliser avec 
NI-DAQ traditionnel. Reportez-vous à la section Systèmes d’exploitation, 
logiciels d’application, langages de programmation et périphériques 
supportés par NI-DAQ 7.0 à la fin de ce guide.

Conseil Si vous avez une application développée avec une version antérieure de votre 
logiciel d’application ou de NI-DAQ, faites-en une copie de sauvegarde. Vous pouvez 
ensuite mettre à jour votre logiciel et modifier l’application. Si vous voulez utiliser 
l’application originale non modifiée avec NI-DAQ traditionnel, vous pouvez utiliser la 
copie de sauvegarde.

Étape 2. Désinstaller NI-DAQ avant d’installer la mise à 
jour

Si vous voulez installer la mise à jour NI-DAQ 7.0, désinstallez d’abord la 
version précédente de NI-DAQ. Utilisez Panneau de configuration» 
Ajout/Suppression de programmes. Reportez-vous à ni.com/ 
support/install pour les instructions de désinstallation spécifiques à 
un système d’exploitation. 
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Étape 3. Installer le driver NI-DAQ 7.0

Insérer le CD

L’installeur NI-DAQ 7.0 devrait se lancer automatiquement. Si ce n’est pas 
le cas, sélectionnez Démarrer»Exécuter. Entrez x:\setup.exe, où x 
correspond à la lettre du lecteur CD. Pour connaître les instructions 
d’installation spécifiques à un système d’exploitation, utilisez l’Assistant 
d’installation matériel (Hardware Installation Wizard) que vous trouverez 
à l’adresse ni.com/support/install.

Mise en garde N’installez pas NI-DAQ 7.0 si votre application inclut des éléments qu’il 
ne prend pas en charge ! Avant d’installer le driver, reportez-vous au fichier NI-DAQ 7.0 
Readme du CD NI-DAQ 7.0 ou à la section Systèmes d’exploitation, logiciels 
d’application, langages de programmation et périphériques supportés par NI-DAQ 7.0 à 
la fin de ce guide. 

Conseil Installez votre driver avant d’installer de nouveaux périphériques sinon, Windows 
risque de ne pas les détecter ou vous pouvez recevoir des mises en garde vous invitant à 
installer le driver.

Choisir l’API (ou les API) à installer

Mise en garde NI-DAQ 7.0 ne peut pas co-exister avec une version antérieure de NI-DAQ 
sur le même ordinateur. Quand vous installez NI-DAQ 7.0, NI-DAQ traditionnel remplace 
NI-DAQ 6.9.x ou les versions antérieures, et remplace aussi tous les fichiers support 
installés par la précédente version. Toutes les anciennes versions de NI-DAQ sont 
supprimées quand vous installez NI-DAQmx. 

NI-DAQ 7.0 comprend plusieurs drivers avec leur API : NI-DAQ 
traditionnel, NI-DAQmx et NI-SWITCH. Selon les périphériques que vous 
utilisez, vous pouvez choisir d’installer tous ces drivers, ou aucun. 
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Reportez-vous à la section Driver NI-DAQ 7.0 au début de ce guide pour 
consulter les descriptions de NI-DAQ traditionnel et NI-DAQmx. 

Installez et utilisez NI-SWITCH pour programmer les modules de 
commutation NI. NI-SWITCH est un driver d’instrument de type IVI qui 
supporte tous les modules de commutation NI. NI-SWITCH possède une 
face-avant logicielle interactive pour tester et mettre au point les 
applications de commutation. Pour utiliser NI-SWITCH 2.0 vous devez 
installer NI-DAQmx et NI-VISA 3.0. 

Installer les fichiers support
L’installeur NI-DAQ 7.0 détecte tous les logiciels NI installés sur le 
système et choisit automatiquement sur le CD les fichiers support des 
versions les plus récentes des drivers, logiciels d’application et langages 
qu’il a détectés.

 

1. Vérifiez que l’installeur a détecté et sélectionné les fichiers support 
appropriés et que le numéro de version du logiciel d’application et/ou 
du langage est correct. Double-cliquez sur le signe plus d’une 
fonctionnalité pour faire apparaître la liste des sous-composants de la 
fonctionnalité, comme indiqué ci-dessus. Vous pouvez sélectionner 
des options complémentaires pour installer les fichiers support, les 
exemples et la documentation. Suivez les instructions du logiciel. 

Remarque Si vous installez d’abord NI-DAQ 7.0, puis que vous installez la version 7.0 
d’un logiciel d’application NI, vous devrez relancer l’installeur NI-DAQ 7.0 afin d’installer 
le fichier support pour ce logiciel d’application.
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2. Cliquez sur le bouton Terminer. 

3. Une fois que l’installeur a terminé, un message apparaît pour vous 
demander si vous voulez redémarrer maintenant. Cliquez sur Non, 
puis arrêtez votre ordinateur.

Si vous devez installer un produit de la série RT, reportez-vous à 
l’Assistant d’installation matériel à l’adresse ni.com/support/ 
install pour obtenir des instructions sur l’installation de ces 
produits.

4. Mettez l’ordinateur ou le châssis PXI hors tension, puis débranchez-le. 

Étape 4. Déballer les périphériques, les accessoires et 
les câbles

Votre périphérique est livré dans un sachet antistatique pour éviter les 
dommages dûs aux décharges électrostatiques (ESD). Ces décharges 
peuvent abîmer plusieurs composants du périphérique. 

Mise en garde Ne touchez jamais les broches des connecteurs.

Pour éviter de tels dommages, respectez les précautions suivantes :

• Utilisez un ruban de mise à la terre ou tenez un objet mis à la terre pour 
vous mettre vous-même à la terre. 

• Mettez en contact le sachet antistatique avec la partie métallique du 
châssis de l’ordinateur avant de retirer le périphérique du sachet. 

Retirez le périphérique de son sachet. Examinez les composants pour 
repérer tout signe d’endommagement. Contactez NI si le périphérique 
apparaît endommagé d’une façon quelconque. N’installez jamais un 
périphérique endommagé dans un ordinateur ou dans un châssis PXI 
ou SCXI. 

Conservez le périphérique dans le sachet antistatique quand il n’est pas 
utilisé.

Pour les consulter les informations de conformité et de sécurité, 
reportez-vous à la documentation du périphérique, comme elle est décrite 
dans l’Étape 10. Naviguer dans la documentation du périphérique ou 
installer celle-ci.
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Étape 5. Installer les périphériques, les accessoires et 
les câbles

Si vous avez plusieurs périphériques DAQ à installer, installez-les tous 
maintenant. Pour obtenir des informations complémentaires sur les 
spécifications matérielles de votre périphérique, notamment en ce qui 
concerne les logements dans le châssis, reportez-vous à la documentation 
du périphérique comme expliqué dans l’Étape 10. Naviguer dans la 
documentation du périphérique ou installer celle-ci.

Si votre système comprend des modules de commutation ou de 
conditionnement de signaux SCXI qui doivent être connectés aux 
périphériques DAQ, installez d’abord les composants DAQ à l’aide de 
ce guide. 

Remarque Les instructions suivantes ne s’appliquent pas aux produits de la série RT. 
Reportez-vous à l’Assistant d’installation de matériel (Hardware Installation Wizard) 
à l’adresse ni.com/support/install pour plus de précisions sur l’installation des 
produits de la série RT.

Périphériques PCI

Mise en garde Assurez-vous que l’ordinateur est hors tension. Respectez les instructions 
de précaution contre les dommages électrostatiques pour vous mettre à la terre avant 
d’installer le matériel.

Effectuez les étapes suivantes pour installer un périphérique PCI.

1. Retirez le capot de votre ordinateur et le cache du logement 
d’extension. 

2. Touchez n’importe quelle partie métallique de l’ordinateur pour 
décharger l’électricité statique.

3. Insérez le périphérique dans le logement PCI. Ajustez-le 
soigneusement pour qu’il soit parfaitement inséré. Ne forcez pas 
l’insertion dans le logement.
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4. Vissez le périphérique sur le support de fixation du panneau arrière de 
l’ordinateur.

5. Remettez en place le capot de l’ordinateur.

Votre périphérique PCI est installé.

Périphériques PXI

Mise en garde Assurez-vous que le châssis PXI est hors tension. Respectez les instructions 
de précaution contre les dommages électrostatiques avant d’installer le matériel.

Effectuez les étapes suivantes pour installer un module PXI.

1. Retirez le cache de protection d’un logement PXI vide. Pour savoir 
quels logements utiliser dans le châssis, reportez-vous à la 
documentation du périphérique, comme expliqué à l’Étape 10. 
Naviguer dans la documentation du périphérique ou installer celle-ci.

2. Touchez n’importe quelle partie métallique du châssis pour décharger 
l’électricité statique. 

3. Insérez le périphérique dans le logement PXI. Utilisez la manette 
d’insertion/éjection pour insérer complètement le périphérique. 

4. Vissez le périphérique sur le support de fixation situé à l’avant du 
châssis.

1 Carte PCI DAQ
2 Logement système PCI

3 Ordinateur PCI

1
2

3
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Votre périphérique PXI est installé.

Périphériques PCMCIA
Vous pouvez installer un périphérique NI PCMCIA dans n’importe quel 
logement de carte PC de type II disponible. Effectuez les étapes suivantes 
pour installer un périphérique PCMCIA.

Mise en garde Assurez-vous que l’ordinateur est hors tension. Si votre carte PCMCIA 
supporte l’insertion à chaud, vous pouvez laisser l’ordinateur sous tension. Respectez les 
instructions de précaution contre les dommages électrostatiques avant d’installer le 
matériel.

1. Si nécessaire, retirez le cache de protection du logement PCMCIA.

2. Insérez le connecteur de bus PCMCIA du périphérique PCMCIA dans 
le logement jusqu’à ce qu’il soit solidement installé. Les périphériques 
NI PCMCIA ont deux connecteurs, un de 68 broches pour le bus sur 
une extrémité, et un connecteur d’E/S à l’autre extrémité. Le 
périphérique PCMCIA est muni de détrompeurs de sorte qu’il ne 
puisse être inséré que dans un sens. 

3. Branchez le câble d’E/S. Prenez garde à ne pas appuyer trop fort sur le 
câble d’E/S quand vous insérez ou retirez son connecteur. Saisissez 
toujours le câble par son connecteur quand vous le connectez ou 
l’enlevez. Ne tirez jamais directement sur le câble d’E/S pour le 
débrancher du périphérique PCMCIA.

1 Châssis PXI
2 Module PXI

3 Manette d’insertion/éjection en position 
abaissée
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Votre périphérique PCMCIA est installé.

Périphériques USB/IEEE 1394

Mise en garde Respectez les instructions de précaution contre les dommages 
électrostatiques avant d’installer le matériel.

Remarque Si vous utilisez un pack batterie BP-1, suivez les instructions de votre guide 
d’installation BP-1 et ne tenez pas compte de l’étape 1 de ce guide. Les instructions 
suivantes s’appliquent aussi si vous n’utilisez pas ce type de batterie.

1 Ordinateur PCMCIA
2 Prise PCMCIA
3 Câble d'E/S

4 Accessoire
5 Signaux d’E/S

®

1

2

3

4

5

DAQCard-700
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Exécutez les étapes suivantes pour installer un périphérique NI de type 
USB ou 1394.

1. Certains périphériques NI de type USB ou 1394 nécessitent une 
alimentation externe.

• Dans ce cas, assurez-vous que l’alimentation externe de ces 
périphériques est compatible avec le secteur dans votre région 
(120 ou 230 VAC) et avec la tension supportée par votre 
périphérique. Connectez une extrémité du cordon d’alimentation 
à une prise secteur et branchez l’autre à l’arrière du périphérique.

• Effectuez exactement la même chose si votre périphérique est 
fourni avec un câble d’alimentation.

2. Reliez le câble entre le port USB ou 1394, situé directement sur le PC 
ou sur un périphérique dédié, et le port USB ou 1394 de votre 
périphérique. Resserrez les vis de montage, s’il y’en a, afin que la 
connexion soit bien ferme. Connectez l’autre extrémité du câble USB 
ou 1394 au port USB ou IEEE 1394 du périphérique. La figure 
suivante représente le câble USB et ses connecteurs.

Votre périphérique USB/IEEE 1394 est installé. Si votre périphérique USB 
ou 1394 est équipé d’un bouton d’alimentation à l’arrière, mettez-le sous 
tension. 

Accessoires
Installez les accessoires, les blocs de connexion et/ou les modules SCC 
suivant les instructions fournies dans leurs guides d’installation respectifs. 
Pour le matériel SCXI, continuez à suivre les instructions de ce guide 
jusqu’à l’Étape 12. Connecter vos capteurs et signaux.

1 Connecteur pour l’ordinateur ou 
pour un hub USB

2 Connecteur pour le périphérique

1 2
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Étape 6. Mettre votre ordinateur ou châssis PXI sous 
tension

Windows détecte et reconnaît tous les périphériques nouvellement installés 
dès le premier redémarrage qui suit l’installation. Sur certains systèmes 
Windows, l’Assistant Nouveau matériel détecté s’ouvre avec une boîte de 
dialogue pour chaque périphérique NI installé. Installer le logiciel 
automatiquement (Recommandé) est sélectionné par défaut. Cliquez sur 
Suivant ou Oui pour installer le logiciel pour chaque périphérique et 
permettre ainsi à Windows de le reconnaître.

Quand l’ordinateur reconnaît un périphérique USB ou IEEE 1394, la LED 
d’alimentation du périphérique se met à clignoter ou s’allume, selon l’état 
de votre périphérique. Les périphériques NI au format IEEE 1394 
possèdent aussi une LED COM qui doit clignoter quand le périphérique est 
détecté. Pour connaître la signification des états de la LED, reportez-vous 
à la documentation du périphérique, comme expliqué dans l’Étape 10. 
Naviguer dans la documentation du périphérique ou installer celle-ci.

Étape 7. Lancer Measurement & Automation 
Explorer (MAX)

Double-cliquez sur l’icône Measurement & Automation qui se trouve sur 
le bureau pour ouvrir MAX.

Étape 8. Confirmer que votre périphérique est reconnu

1. Ouvrez la rubrique Périphériques et Interfaces.

2. Vérifiez que votre périphérique apparaît bien dans cette rubrique.
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Quand un périphérique est supporté à la fois par NI-DAQ traditionnel 
et NI-DAQmx et que ces deux drivers sont installés, le même 
périphérique apparaît sous un nom différent dans les dossiers NI-DAQ 
traditionnel et NI-DAQmx de la rubrique Périphériques et Interfaces. 
Si votre périphérique n’apparaît pas, appuyez sur <F5> pour actualiser 
l’affichage dans MAX. Si cela ne suffit pas, reportez-vous à l’adresse 
ni.com/support/install pour obtenir des informations de 
dépannage.

3. Dans la rubrique de l’API NI-DAQ que vous utilisez pour programmer 
votre périphérique, cliquez avec le bouton droit sur le périphérique que 
vous voulez tester.

• Si votre périphérique est sous NI-DAQ traditionnel, sélectionnez 
Propriétés, puis cliquez sur Tester les ressources dans la fenêtre 
de propriétés.

• Si le périphérique est sous NI-DAQmx, sélectionnez Self-Test.
 

4. Quand le test automatique est terminé, un message indique si une 
erreur s’est produite. Si c’est le cas, reportez-vous à l’adresse 
ni.com/support pour obtenir des informations de dépannage. 
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Étape 9. Configurer les paramètres de votre 
périphérique

Configurez chaque périphérique que vous installez. Pour utiliser un 
périphérique à la fois avec NI-DAQ traditionnel et NI-DAQmx, vous devez 
configurer ses propriétés dans les deux rubriques.

1. Effectuez un clic droit sur le nom du périphérique et sélectionnez 
Propriétés. Assurez-vous de cliquer sur le nom du périphérique se 
trouvant dans la rubrique de l’API de NI-DAQ que vous voulez utiliser.

2. Configurez les propriétés du périphérique.

• Si vous utilisez un accessoire, ajoutez les informations relatives à 
celui-ci.

• Si vous utilisez un périphérique avec NI-DAQ traditionnel, vous 
pouvez changer ses paramètres par défaut pour les entrées 
analogiques, les sorties analogiques, l’OPC et l’accès déporté. 
Reportez-vous à la documentation de votre périphérique comme 
expliqué dans l’étape suivante pour obtenir de plus amples 
informations sur les paramètres par défaut du périphérique.

3. Cliquez sur OK pour valider les changements.

Conseil Pour les périphériques supportés à la fois par NI-DAQ traditionnel et NI-DAQmx, 
vous pouvez convertir les configurations d’échelle et les voies virtuelles de NI-DAQ 
traditionnel en une configuration pour NI-DAQmx avec l’Assistant Traditional NI-DAQ to 
NI-DAQmx Converter. Cet assistant convertit aussi les configurations d’accessoires et de 
matériel SCXI, mais pas celles de SCC. Vous devez configurer les informations de SCC 
séparément dans chaque API que vous voulez utiliser. Reportez-vous à la section 
Converting Traditional NI-DAQ Configurations to NI-DAQmx Configurations dans 
Measurement & Automation Explorer Help for NI-DAQmx pour obtenir ces instructions.

Étape 10. Naviguer dans la documentation du 
périphérique ou installer celle-ci

Le logiciel NI-DAQ 7.0 inclut le CD Device Documentation qui contient 
toute la documentation en ligne pour les périphériques DAQ, SCXI et de 
commutation. Ce CD comprend également les fichiers d’aide décrivant les 
terminaux des périphériques, leurs fonctionnalités, les opérations qu’ils 
réalisent et des fichiers de documentation au format PDF. Vous pouvez 
utiliser le Device Document Browser pour trouver, afficher et imprimer les 
documents pour chaque périphérique. 
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Vous pouvez utiliser cet explorateur à n’importe quel moment en insérant 
le CD Device Documentation de NI-DAQ 7.0. L’explorateur de documents 
de NI-DAQ 7.0 possède les options suivantes :

• Browse Device Documents ouvre l’explorateur et affiche la 
documentation pour chaque périphérique. 

• Install Device Documents copie l’explorateur et tous les documents 
pour tous les périphériques sur le disque dur. Après l’installation, on 
accède à l’explorateur à partir de Démarrer»Programmes»National 
Instruments»NI-DAQ»Browse Device Documentation.

Si l’explorateur ne s’ouvre pas automatiquement, sélectionnez Démarrer» 
Exécuter et entrez x:\autorun.exe où x est la lettre du lecteur CD. 

Remarque Vous devez avoir au moins la version 5.0 de Internet Explorer pour utiliser 
certaines fonctionnalités de la documentation de NI-DAQ 7.0, comme par exemple l’aide 
et l’explorateur Device Document Browser.

Étape 11. Installer les modules de commutation ou 
SCXI, le cas échéant

Si votre système inclut des modules de commutation ou de 
conditionnement de signaux SCXI à connecter aux périphériques DAQ, 
reportez-vous aux documents Guide de démarrage SCXI et NI Switches 
Getting Started Guide pour installer et configurer le matériel SCXI et de 
commutation.

La suite de ce guide ne s’applique qu’aux périphériques DAQ équipés de 
blocs de connexion ou d’accessoires SCC.

Étape 12. Connecter vos capteurs et signaux
Câblez les capteurs et les signaux à mesurer aux terminaux du périphérique 
ou des accessoires.

Des informations pratiques se trouvent dans la documentation suivante : 

• Signaux et connexions aux terminaux :

– Le document E Series Help, le manuel de l’utilisateur du 
périphérique au format PDF et le PDF de l’accessoire sont dans 
l’explorateur Device Document Browser.

– Les affectations de broches sont décrites dans l’Aide de 
Measurement & Automation Explorer pour la version 
traditionnelle de NI-DAQ et dans Measurement & Automation 
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Explorer Help for NI-DAQmx, documents accessibles à partir du 
menu Aide de MAX.

• Les spécifications d’un module de commutation comprennent une 
topologie de ce périphérique.

• Utilisation de capteurs :

– Si vous utilisez LabVIEW, reportez-vous manuel LabVIEW 
Measurements Manual livré avec LabVIEW ou disponible à 
l’adresse ni.com/manuals. 

– Si vous utilisez un autre environnement de développement et 
NI-DAQmx, reportez-vous à la rubrique Sensors de NI-DAQmx 
Help, accessible à partir de Démarrer»Programmes»National 
Instruments»NI-DAQ»NI-DAQmx Help. 

– Si vous utilisez un autre environnement de développement avec 
NI-DAQ traditionnel, reportez-vous au chapitre 5, Transducer 
Conversion Functions, du manuel Traditional NI-DAQ User 
Manual, accessible à partir de Démarrer»Programmes»
National Instruments»NI-DAQ»Traditional NI-DAQ User 
Manual. 

Étape 13. Exécuter les panneaux de test
De nombreux périphériques comportent un panneau de test pour tester des 
fonctionnalités spécifiques à ce périphérique, par exemple sa capacité à 
acquérir ou à générer des signaux.

1. Ouvrez l’aide de MAX pour obtenir des informations sur les panneaux 
de test. 

a. Dans MAX, sélectionnez Aide»Sujets de l’aide»NI-DAQmx ou 
NI-DAQ traditionnel, quelle que soit l’API DAQ que vous 
utilisiez. L’aide de MAX s’ouvre.

b. Dans l’onglet Sommaire, cliquez sur l’icône en forme de livre 
Measurement & Automation Explorer»MAX pour la version 
de NI-DAQ que vous voulez tester»Getting Started»DAQ 
Devices»Testing DAQ Devices.

c. Cliquez sur Testing DAQ Devices afin d’ouvrir la rubrique d’aide 
sur l’utilisation des panneaux de test.

d. Réduisez la fenêtre d’aide et faites-la glisser sur la droite afin 
qu’elle ne recouvre pas le panneau de configuration de MAX.

2. Cliquez sur MAX pour rendre sa fenêtre active. 

3. Dans la rubrique NI-DAQmx Devices ou Périphériques NI-DAQ 
traditionnel, cliquez avec le bouton droit sur le périphérique à tester. 
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4. Sélectionnez Panneaux de test ou Test Panels pour ouvrir le panneau 
de test correspondant au périphérique. 

Un exemple de panneau de test est représenté dans la figure suivante. 
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5. Cliquez sur les onglets pour tester différentes fonctions du 
périphérique. Cliquez sur la fenêtre d’aide de MAX pour obtenir des 
instructions sur les panneaux de test pour NI-DAQ traditionnel et 
NI-DAQmx.

6. Le panneau de test affiche un message indiquant si une erreur s’est 
produite. Reportez-vous à NI-DAQmx Reference Help ou ni.com/ 
support pour obtenir des informations de dépannage. 

7. Une fois que vous avez fini, cliquez sur Fermer ou OK pour fermer le 
panneau de test.

Étape 14. Configurer tous les nouveaux périphériques
Si vous avez installé plus d’un périphérique DAQ, répétez les étapes 9 à 13 
pour chacun d’entre eux. 

Étape 15. Configurer les voies et les tâches
Une voie physique est un terminal ou une broche sur laquelle vous pouvez 
mesurer ou générer un signal analogique ou numérique. Une voie virtuelle 
est un ensemble de propriétés pouvant inclure un nom, une voie physique, 
un type de connexion au terminal, le type de mesures (acquisition ou 
génération) et des informations de mise à l’échelle. Dans NI-DAQ 
traditionnel et les versions précédentes, la configuration des voies virtuelles 
est une manière possible d’enregistrer les voies utilisées pour différentes 
mesures. Dans NI-DAQmx, les voies virtuelles sont intégrées à chaque 
mesure.

Dans NI-DAQ traditionnel, vous configurez les voies virtuelles avec MAX. 
Dans NI-DAQmx, vous pouvez configurer les voies virtuelles avec 
l’Assistant DAQ, que vous pouvez ouvrir avec MAX ou avec votre logiciel 
d’application. Vous pouvez aussi configurer les voies virtuelles dans votre 
programme avec l’API de NI-DAQmx.

Une tâche est un ensemble d’une ou plusieurs voies virtuelles qui inclut 
l’horloge, le déclenchement et d’autres propriétés. C’est un concept 
nouveau et important dans NI-DAQmx. Fondamentalement, une tâche 
représente la mesure ou la génération que vous voulez réaliser. Vous pouvez 
définir et enregistrer toutes les informations de configuration dans une 
tâche et l’utiliser dans une application.

Dans NI-DAQmx, les voies virtuelles peuvent être définies comme faisant 
partie d’une tâche. Elles peuvent aussi être configurées séparément de 
celle-ci. Les voies virtuelles créées à l’intérieur d’une tâche sont des voies 
locales. Les voies virtuelles créées à l’extérieur d’une tâche sont des voies 
globales. Vous pouvez créer des voies globales dans MAX ou dans votre 
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programme. Vous pouvez aussi utiliser les voies globales dans n’importe 
quelle application ou les ajouter dans d’autres tâches. Si vous modifiez une 
voie globale, les changements affectent toutes les tâches dans lesquelles 
cette voie est utilisée. Dans la plupart des cas, il est plus simple d’utiliser 
les voies locales.

Configurer une tâche dans NI-DAQmx
Lorsque vous utilisez NI-DAQmx, configurez les tâches avec l’Assistant 
DAQ. Vous devez avoir la version 7.0 du logiciel d’application NI pour 
créer des voies et des tâches avec l’Assistant DAQ.

• Dans MAX, cliquez avec le bouton droit sur Voisinage de données et 
sélectionnez Créer un nouvel objet. Dans la fenêtre Créer un nouvel 
objet, sélectionnez NI-DAQmx Task, puis cliquez sur Suivant.

• Vous pouvez aussi ouvrir directement l’Assistant DAQ à partir de votre 
logiciel d’application NI.

– Dans LabVIEW, il existe plusieurs façons d’ouvrir l’Assistant 
DAQ :

• Faites glisser le VI Express Assistant DAQ à partir de la 
palette Entrée des VIs Express, comme expliqué dans le 
manuel Initiation à LabVIEW. 

• Vous pouvez aussi utiliser la commande Nom de tâche 
DAQmx pour ouvrir l’Assistant DAQ. Cliquez avec le bouton 
droit sur la commande et sélectionnez Nouvelle tâche 
(Assistant DAQ). Le tutorial d’aide Taking an NI-DAQmx 
Measurement in LabVIEW contient les instructions pas-à-pas 
pour créer une tâche à partir de la commande Nom de tâche 
DAQmx et générer le code associé à la tâche. Dans 
LabVIEW, sélectionnez Aide»Taking an NI-DAQmx 
Measurement pour ouvrir le tutorial.

– Dans LabWindows/CVI, sélectionnez Tools»Create/Edit 
DAQmx Tasks. 

– Dans Measurement Studio, ouvrez Visual Studio .NET et 
sélectionnez Project»Add New Item pour ouvrir la boîte de 
dialogue Add New Item. Dans la sous-fenêtre Categories, 
sélectionnez Measurement Studio»Assistants. Dans le volet 
Templates, sélectionnez DAQmx Task Class.
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L’Assistant DAQ s’ouvre.

Suivez les instructions en ligne pour créer une nouvelle tâche.

1. Choisissez un type d’E/S, par exemple une entrée analogique (Analog 
Input).

2. Sélectionnez la mesure ou la génération à réaliser.

3. Choisissez, si nécessaire, le capteur à utiliser.

4. Sélectionnez les voies à ajouter dans la tâche. Vous pouvez ajouter des 
voies globales dans la tâche ou sélectionner des voies physiques à 
partir desquelles vous créez des voies locales dans la tâche.

5. Si nécessaire, configurez des paramètres de mesures spécifiques, 
l’horloge et le déclenchement. 

6. Enregistrez la tâche.

• Si vous avez ouvert l’Assistant DAQ à partir de LabVIEW ou de 
LabWindows/CVI, cliquez sur OK. 

• Si vous l’avez ouvert à partir de Measurement Studio, 
sélectionnez File»Save. 

• Si vous l’avez ouvert à partir de MAX, cliquez sur Save Task. 
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Vous pouvez maintenant utiliser la tâche dans une application. 
Reportez-vous à DAQ Assistant Help ou à la documentation du logiciel 
d’application pour obtenir des informations complémentaires sur la 
manière d’utiliser une tâche ou de générer du code.

Configurer des voies globales pour NI-DAQmx
Lorsque vous utilisez NI-DAQmx, configurez les voies globales avec 
l’Assistant DAQ.

• Dans MAX, cliquez avec le bouton droit sur Voisinage de données et 
sélectionnez Créer un nouvel objet. Dans la fenêtre Créer un nouvel 
objet, sélectionnez NI-DAQmx Global Channel, puis cliquez sur 
Suivant.

• Vous pouvez aussi ouvrir directement l’Assistant DAQ à partir de 
LabVIEW 7.0, LabWindows/CVI 7.0 ou Measurement Studio 7.0.

– Dans LabVIEW, utilisez la commande DAQmx Global Channel 
pour ouvrir l’Assistant DAQ. Cliquez avec le bouton droit sur la 
commande et sélectionnez Nouvelle voie (Assistant DAQ).

– Dans LabWindows/CVI ou Measurement Studio, vous devez au 
préalable créer une tâche comme expliqué précédemment. Dans 
l’Assistant DAQ, cliquez sur Add Existing DAQmx Global 
Channels pour ajouter des voies globales à votre tâche. 

L’Assistant DAQ s’ouvre. Suivez les instructions en ligne pour créer une 
nouvelle voie globale.

1. Choisissez un type d’E/S, par exemple une entrée analogique (Analog 
Input). 

2. Sélectionnez la mesure ou la génération à réaliser. 

3. Choisissez, si nécessaire, le capteur à utiliser. 

4. Sélectionnez les voies physiques à utiliser. 

5. Configurez les paramètres de mesure spécifiques. 

6. Enregistrez la tâche.

• Si vous avez ouvert l’Assistant DAQ à partir de LabVIEW ou de 
LabWindows/CVI, cliquez sur OK. 

• Si vous l’avez ouvert à partir de Measurement Studio, 
sélectionnez File»Save. 

• Si vous l’avez ouvert à partir de MAX, cliquez sur Save Channel. 

Vous pouvez maintenant utiliser la voie globale dans une application ou 
l’ajouter dans une tâche. Reportez-vous à DAQ Assistant Help ou à la 
documentation du logiciel d’application pour obtenir des informations 
complémentaires sur la manière d’utiliser une tâche ou de générer du code.
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Configurer des voies virtuelles pour NI-DAQ traditionnel
Quand vous utilisez NI-DAQ traditionnel, configurez les voies virtuelles 
dans MAX.

1. Dans MAX, cliquez avec le bouton droit sur Voisinage de données et 
sélectionnez Créer un nouvel objet. 

2. Sélectionnez Voie Virtuelle NI-DAQ traditionnel dans la fenêtre 
Créer un nouvel objet et cliquez sur Terminer. L’Assistant de création 
d’une nouvelle voie s’ouvre. 

3. Suivez les instructions de cet Assistant pour créer une nouvelle voie. 
Pour des informations complémentaires sur la manière de configurer 
les différents types de voies, reportez-vous à l’Aide de Measurement & 
Automation Explorer pour la version traditionnelle de NI-DAQ.
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Démarrer le développement d’une application

Exemples
Chaque API inclut un ensemble d’exemples de programmation vous 
permettant de démarrer le développement d’une application. Vous pouvez 
modifier le code d’un exemple et l’enregistrer en tant que nouvelle 
application. Vous pouvez utiliser les exemples pour développer une 
nouvelle application ou ajouter le code des exemples dans une application 
existante.

Pour trouver des exemples en LabVIEW ou en LabWindows/CVI, ouvrez 
l’Outil de recherche d’exemples National Instruments.

• Dans LabVIEW, sélectionnez Aide»Recherche d’exemples.

• Dans LabWindows/CVI, sélectionnez Help»NI Example Finder.

Les exemples Measurement Studio, Visual Basic et ANSI C sont dans les 
répertoires suivants :

• Les exemples de NI-DAQmx pour les différents langages supportés par 
Measurement Studio sont dans :

– MeasurementStudio\VCNET\Examples\DAQmx 

– MeasurementStudio\DotNET\Examples\DAQmx

• Les exemples de NI-DAQ traditionnel pour Visual Basic sont dans les 
répertoires suivants :

– Le répertoire NI-DAQ\Examples\Visual Basic with 
Measurement Studio contient un lien vers les exemples de 
commandes ActiveX à utiliser avec Measurement Studio.

– Le répertoire NI-DAQ\Examples\VBasic contient des exemples 
non associés à Measurement Studio.

• Les exemples de NI-DAQmx en ANSI C sont dans le répertoire 
NI-DAQ\Examples\DAQmx ANSI C.

• Les exemples de NI-DAQ traditionnel en ANSI C se trouvent dans le 
répertoire NI-DAQ\Examples\VisualC.

Pour consulter d’autres exemples, visitez le site ni.com/zone.
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Informations sur les périphériques et les applications de mesures
Tous les logiciels d’application et drivers comprennent des informations 
sur la manière d’écrire des applications de mesures et de contrôle de 
périphériques. Les références aux documents suivantes supposent que vous 
avez NI-DAQ 7.0 et la version 7.0 du logiciel d’application NI.

LabVIEW
Si vous êtes un nouvel utilisateur, lisez le document Initiation à LabVIEW 
pour vous familiariser avec LabVIEW. Sélectionnez Démarrer» 
Programmes»National Instruments»LabVIEW 7.0»Recherche dans 
les manuels PDF. 

Le manuel LabVIEW Measurements Manual contient une vue d’ensemble 
des API de NI-DAQ traditionnel et NI-DAQmx, ainsi qu’une description 
des concepts de mesures. Sélectionnez Démarrer»Programmes» 
National Instruments»LabVIEW»Recherche dans les manuels PDF.

Le tutorial de l’aide Taking an NI-DAQmx Measurement in LabVIEW 
contient des instructions pas-à-pas pour établir une mesure avec LabVIEW. 
Il décrit aussi les nouvelles fonctionnalités clés de NI-DAQmx et les 
nouveaux concepts, comme l’Assistant DAQ et les tâches. Dans LabVIEW, 
sélectionnez Aide»Taking an NI-DAQmx Measurement pour ouvrir le 
tutorial.

Les fichiers d’aide VIs d’acquisition de données de NI-DAQ traditionnel et 
LabVIEW NI-DAQmx VI Reference Help décrivent l’ensemble des VIs 
DAQ pour LabVIEW. Dans LabVIEW, sélectionnez Aide pour ouvrir 
l’Aide LabVIEW puis choisissez le fichier d’aide pour l’API de NI-DAQ 
que vous utilisez. 

LabWindows/CVI
Le document Data Acquisition Library de LabWindows/CVI Help contient 
une vue d’ensemble des API, des concepts de mesures et des références des 
fonctions pour NI-DAQ traditionnel et NI-DAQmx. Dans 
LabWindows/CVI, sélectionnez Help»Contents.

Measurement Studio
Le document NI Measurement Studio Help contient une vue d’ensemble de 
l’API de NI-DAQmx, des tâches de mesures, des concepts et des références 
de fonctions. Le fichier d’aide est intégré à la documentation de Visual 
Studio .NET. Dans Visual Studio .NET, sélectionnez Help»Contents.
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Le document Measurement Studio Reference contient une vue d’ensemble 
de l’API de NI-DAQ, des concepts de mesures et des références de 
fonctions. Dans Visual Studio .NET, sélectionnez Measurement Studio» 
Measurement Studio Reference. 

ANSI C sans logiciel d’application NI
Les documents Traditional NI-DAQ User Manual et NI-DAQmx Help 
contiennent une vue d’ensemble de l’API. NI-DAQmx Help contient aussi 
des informations d’ordre général sur les concepts de mesures. Les 
documents Traditional NI-DAQ Function Reference Help et NI-DAQmx 
C Reference Help décrivent l’ensemble des fonctions C et des attributs. 
Sélectionnez Démarrer»Programmes»National Instruments»NI-DAQ 
et choisissez le titre du document pour l’API de NI-DAQ que vous utilisez.

Langages .NET sans logiciel d’application NI
Le document NI Measurement Studio Help contient une vue d’ensemble de 
l’API de NI-DAQmx, des tâches et des concepts de mesures, ainsi que des 
références de fonctions. Ce fichier d’aide est intégré à la documentation de 
Visual Studio .NET. Dans Visual Studio .NET, sélectionnez Help» 
Contents.

Remarque Si vous utilisez un langage .NET sans Visual Studio .NET, il se peut que vous 
ne puissiez pas ouvrir NI Measurement Studio Help.

Documentation de périphérique
NI-DAQ 7.0 inclut l’explorateur Device Document Browser, qui contient 
la documentation en ligne pour les périphériques DAQ, SCXI et 
commutation qui sont supportés. Il contient aussi des fichiers d’aide 
décrivant le périphérique, ses broches, ses fonctionnalités, les opérations 
qu’il peut réaliser, et des fichiers PDF des documents imprimés du 
périphérique. Vous pouvez trouver, visualiser et/ou imprimer les 
documents pour chaque périphérique et à n’importe quel moment en 
insérant le CD. Après que vous avez installé l’explorateur Device 
Document Browser, les documents du périphérique sont accessibles en 
allant dans Démarrer»Programmes»National Instruments»NI-DAQ» 
Browse Device Documentation. 

Configurations de châssis SCXI multiples
Le document SCXI-1346 Shielded Multi-Chassis Cable Adapter 
Installation Guide contient des instructions pour installer des systèmes 
mettant en œuvre plusieurs châssis SCXI.
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Commutation
Le document NI Switches Help contient des informations techniques pour 
la programmation et le support des modules de commutation, ainsi que sur 
le driver d’instrument NI-SWITCH.

Le document NI-SWITCH Instrument Driver Quick Reference Guide 
contient un aperçu de l’API, des fonctions et des VIs.

Cours de formation
Si vous avez besoin d’une assistance supplémentaire pour commencer à 
développer une application avec les produits NI, National Instruments offre 
des cours de formation. Pour vous inscrire à un cours ou pour en connaître 
le contenu, visitez ni.com/training. 

Support Technique
Pour obtenir un complément de support, visitez le site ni.com/support 
ou ni.com/zone. 

Utiliser NI-DAQ traditionnel et NI-DAQmx sur le même 
ordinateur

Les applications existantes développées avec une version antérieure de 
NI-DAQ s’exécuteront avec NI-DAQ traditionnel. Vous pouvez utiliser 
simultanément les API de NI-DAQ traditionnel et NI-DAQmx sur le même 
ordinateur à condition de respecter les restrictions suivantes :

• Une seule API contrôle un périphérique donné à un moment donné.

– Après avoir utilisé un périphérique avec NI-DAQmx, vous devez 
réinitialiser toutes les tâches NI-DAQmx qui l’ont utilisé avant de 
vous en servir avec NI-DAQ traditionnel. Pour réinitialiser les 
tâches NI-DAQmx, appelez les VIs ou fonctions DAQmx Clear 
Task. 

– Après avoir utilisé un périphérique avec NI-DAQ traditionnel, 
vous devez le réinitialiser avant de vous en servir avec 
NI-DAQmx. Pour les modules SCXI, vous devez réinitialiser le 
périphérique DAQ qui communique avec le châssis.

• Appelez le VI Réinitialiser un périphérique (Device Reset.vi) 
de NI-DAQ traditionnel ou la fonction Init_DA_Brds.

• Pour réinitialiser tous les périphériques de NI-DAQ 
traditionnel, cliquez avec le bouton droit sur la rubrique 
Périphériques NI-DAQ traditionnel dans MAX, puis 
sélectionnez Réinitialiser le driver pour NI-DAQ 
traditionnel. 
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• Dans un système d’acquisition de données SCXI, vous devez utiliser 
la même API pour programmer tous les périphériques : périphériques 
DAQ de communication et modules SCXI.

Reportez-vous à l’adresse ni.com/support pour obtenir des détails et des 
instructions sur les sujets suivants :

• Comment ajouter du code NI-DAQmx dans une application NI-DAQ 
traditionnel.

• Comment exécuter deux applications développées avec NI-DAQmx et 
NI-DAQ traditionnel et qui utilisent le même périphérique.

Systèmes d’exploitation, logiciels d’application, 
langages de programmation et périphériques supportés 
par NI-DAQ 7.0

La version 7.0 de NI-DAQmx ne prend pas encore en charge la totalité de 
la gamme NI des périphériques de mesure. Les prochaines versions de 
NI-DAQ supporteront dans NI-DAQmx non seulement les nouveaux 
périphériques, mais aussi davantage de périphériques existants, et 
continueront à inclure NI-DAQ traditionnel.

Support du système d’exploitation
NI-DAQmx, NI-DAQ traditionnel et NI-SWITCH 2.0 sont supportés sous 
Windows 2000/NT/XP/Me/98. NI-DAQ 7.0 sous Windows NT nécessite 
au moins le Service Pack 6. Measurement Studio nécessite Visual Studio 
.NET 2003, qui nécessite lui-même Windows 2000/NT 4.0/XP. Pour 
connaître les instructions d’installation spécifiques à un système 
d’exploitation, utilisez l’Assistant d’installation matériel que vous 
trouverez à l’adresse ni.com/support/install.

Pour trouver et télécharger une version antérieure de NI-DAQ qui supporte 
les autres systèmes d’exploitation, reportez-vous à la page 
ni.com/downloads. 
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Logiciels d’application et langages de programmation supportés
Le tableau 1 liste les versions des logiciels d’application supportés par 
NI-DAQmx et NI-DAQ traditionnel. Si vous n’utilisez pas un logiciel 
d’application NI, reportez-vous au tableau 2.

 

Le tableau 2 liste les langages de programmation et les versions supportés 
par NI-DAQmx et NI-DAQ traditionnel. 

 

Les versions antérieures de NI-DAQ supportent d’autres versions de ces 
langages et logiciels d’application. Pour trouver et télécharger une version 
antérieure du driver, reportez-vous à la page ni.com/downloads.

Tableau 1.  Logiciels d’application supportés par NI-DAQ 7.0

Logiciels d’application NI

Versions 
supportées par 

NI-DAQmx

Versions 
supportées par 

NI-DAQ 
traditionnel

LabVIEW  7.0 6.0–7.0

Module LabVIEW RT — 6.0–7.01 

LabWindows/CVI  7.0 6.0–7.0

Measurement Studio  7.0 6.0–7.02

1 Les utilisateurs de LabVIEW RT doivent utiliser NI-DAQ traditionnel pour leurs 
applications DAQ. Une version future de NI-DAQmx supportera LabVIEW RT.

2 NI-DAQ traditionnel n’inclut pas d’interfaces Measurement Studio C++ ou .NET.

Tableau 2.  Langages de programmation supportés par NI-DAQ 7.0

Langage de programmation

Versions 
supportées 

par 
NI-DAQmx

Versions 
supportées 

par NI-DAQ 
traditionnel

ANSI C ✓ ✓

Microsoft Visual C++
Bibliothèques de classes
DLL C

7.01

6.0–7.0
—

6.0–7.0

Visual Basic 6.0 via ActiveX — 6.0

Langages Microsoft .NET 
(C# et Visual Basic .NET)

.NET 1.1 —

1 Nécessite la version 7.0 de Measurement Studio.
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Périphériques supportés
Pour obtenir les noms spécifiques des périphériques, consultez le fichier 
NI-DAQ 7.0 Readme du CD. Le tableau 3 recense les familles de 
périphériques supportées par NI-DAQmx, NI-DAQ traditionnel et 
NI-SWITCH 2.0. 

Tableau 3.  Périphériques supportés par NI-DAQ 7.0

Périphérique NI-DAQmx
NI-DAQ 

traditionnel NI-SWITCH 2.0

Périphériques DAQ multifonctions de la 
Série E, aux formats PCI et PXI, comme le 
NI PCI-6052E

✓ ✓ N/A

Périphériques DAQPad pour liaison USB 
et FireWire (IEEE 1394)

— ✓ N/A

Périphériques DAQCard de la série E au 
format PCMCIA

— ✓ N/A

Périphériques classiques multifonctions 
NI PCI-6013/6014, 16 bits

— ✓ N/A

Périphériques DAQ multifonctions de la 
Série S, comme le NI PXI-6115

— ✓ N/A

Périphériques d’E/S numériques, comme 
ceux de la famille NI 653X

— ✓ N/A

Périphériques d’acquisition de signaux 
dynamiques PCI-4551, PCI-4552 et PCI et 
PXI-4472

— ✓ N/A

Périphériques de sorties analogiques 
NI PCI et PXI 671X/673X

— ✓ N/A

Périphériques d’E/S compteurs NI 660X — ✓ N/A

Modules de conditionnement de signaux 
SCXI-1530, SCXI-1531 et SCXI-1540

✓1 ✓ N/A

Tous les autres modules de 
conditionnement de signaux SCXI

✓ ✓ N/A

Modules de conditionnement de signaux de 
la série SCC

✓ ✓ N/A

Modules de commutation SCXI-1166 et 
SCXI-1193

✓ — ✓
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Consultez le fichier NI-DAQ 7.0 Readme du CD NI-DAQ 7.0 pour obtenir 
la liste des nouveaux périphériques supportés par NI-DAQ 7.0.

Davantage de périphériques dans les futures 
versions de NI-DAQmx
Dans les futures versions de NI-DAQ, NI-DAQmx supportera des 
périphériques qui ne sont actuellement supportés que par NI-DAQ 
traditionnel. 

Périphériques supportés uniquement par NI-DAQ 
traditionnel
NI-DAQmx ne supporte actuellement pas les périphériques suivants, et ne 
les supportera pas non plus dans les versions à venir. Les périphériques 
suivants sont supportés uniquement par NI-DAQ traditionnel.

• Périphériques AT de la Série E

• Périphériques de sorties analogiques AT-AO-6/10

• Périphériques d’E/S numériques AT-DIO-32F

• Périphériques DAQCard-AI-16E-4 et DAQCard-AI-16XE-50 au 
format PCMCIA

• Périphériques NI PCI-4451/4452/4454 d’acquisition et de génération 
de signaux dynamiques

• Enregistreurs de données NI 4350/4351

Tous les autres modules de 
commutation SCXI

✓ ✓ ✓

Modules de commutation PXI-2566 et 
PXI-2593

✓ — ✓

Tous les autres modules de 
commutation PXI

— — ✓

Modules PXI-4204 et PXI-4220 ✓ — —

1 Ces périphériques sont supportés dans NI-DAQmx, mais les voies virtuelles pour les accéléromètres, les LVDT et les RVDT 
ne sont pas supportées.

Tableau 3.  Périphériques supportés par NI-DAQ 7.0 (Suite)

Périphérique NI-DAQmx
NI-DAQ 

traditionnel NI-SWITCH 2.0
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Périphériques qui ne sont plus pris en charge par 
NI-DAQ 7.0
Les produits suivants ne sont pas supportés par NI-DAQ 7.0 – ni par 
NI-DAQmx, ni par NI-DAQ traditionnel – et ne le seront pas par les 
versions futures de NI-DAQ. Vous devez utiliser la version 6.9.x de 
NI-DAQ ou une version antérieure pour programmer ces périphériques.

• Périphérique DAQ multifonctions AT-MIO-16F-5

• Périphériques DAQCard-500, DAQCard-516, DAQCard-700, 
DAQCard-1200 et DAQCard-AO-2DC au format PCMCIA

• Périphériques DAQPad-1200 et DAQPad-MIO-16XE-50 pour le port 
parallèle

• Périphériques MIO de la famille Lab-PC au format ISA et PC/XT

• Périphérique MIO PC-516 16 bits, 50 Kéch./s

• Périphérique PC-AO-2DC

• Périphérique MIO PC-LPM-16PnP

• Périphérique PC-OPDIO-16 avec E/S “opto-isolées”

• Périphérique compteur PC-TIO-10 et DIO

• Périphérique MIO PCI-1200, 12 bits, 100 Kéch./s

• Module DAQ 12 bits et module de commande SCXI-1200

• Châssis SCXI-2000 à 4 logements

• Module d’interface série SCXI-2400

• Modules VXI-DAQ, supports et modules VXI-SC, et blocs de 
connexion VXI-TB pour le bus VXI
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Schnellstart-Anleitung für NI-DAQ  7.0
Im vorliegenden Handbuch finden Sie eine Anleitung zur Installation Ihrer 
Datenerfassungsgeräte und der Treiber-Software für NI-DAQ 7.0 und Sie 
erfahren, wie die Geräte auf Funktionstüchtigkeit überprüft werden 
können.

Wenn Sie unter Mac OS arbeiten, lesen Sie bitte die NI-DAQ-Informatio-
nen für Macintosh.
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Symbole und Darstellungen
In dieser Anleitung werden folgende Symbole und Darstellungen 
verwendet:

» Das Symbol » führt durch geschachtelte Menüpunkte und Dialogfelder 
zu einer Zieloption. So wird zum Beispiel mit der Abfolge Datei»
Seiteneinstellungen»Optionen angezeigt, dass zunächst das Menü Datei 
auszuwählen ist, anschließend die Option Seiteneinstellungen und dann 
der Befehl Optionen.

Mit diesem Symbol sind Tipps mit wertvollen Hinweisen gekennzeichnet.

Dieses Symbol steht für einen Hinweis und soll auf wichtige Informationen 
aufmerksam machen.

Mit diesem Symbol ist eine Warnung vor möglichen Verletzungen, 
Datenverlust oder Systemabsturz gekennzeichnet.

fett In fett gedruckter Schrift sind Elemente dargestellt, die ausgewählt oder 
angeklickt werden müssen, wie beispielsweise Menüelemente, Optionen in 
Dialogfeldern oder Bezeichnungen von LEDs.

kursiv Kursiv gedruckt sind Querverweise oder wichtige Begriffe, die erstmals 
erwähnt werden. Sonstige kursiv gedruckte Ausdrücke sind Platzhalter, die 
durch Wörter bzw. Werte zu ersetzen sind.
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gesperrt  Im Sperrdruck sind Textstellen oder Zeichen dargestellt, die über die 
Tastatur einzugeben sind, wie Bezeichnungen für Laufwerke, Pfade, 
Verzeichnisse, Programme, Funktionen, Dateinamen und Erweiterungen.

gesperrt kursiv An Textstellen, die im kursiven Sperrdruck dargestellt sind, sind Eingaben 
des Anwenders erforderlich.

Einstieg
In Abbildung 1 finden Sie einen Überblick über die Vorgehensweise 
zur Installation eines DAQ-Gerätes und des Treibers NI-DAQ 7.0 sowie 
entsprechende Literaturhinweise.
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Abbildung 1.  Installationsvorgang

* Gerätesignale und Anschlussbelegungen sind in der Hilfe zum Measurement & Automation Explorer für den 
herkömmlichen NI-DAQ-Treiber und in der Hilfe zum Measurement & Automation Explorer für den NI-DAQmx-
Treiber online verfügbar, auf die über das Hilfemenü des Measurement & Automation Explorer (MAX) zugegriffen 
werden kann. Mit dem Gerätedokumente-Browser können aus der Gerätedokumentation Informationen über 
Gerätesignal-Belegungen sowie zusätzliche Signalinformationen abgerufen werden. In Schritt 10: Installieren Sie 
die Gerätedokumentation wird die Verwendung der Gerätedokumentation beschrieben.

In der Readme-Datei für NI-DAQ 7.0 erhalten Sie 
die Informationen über Betriebssystem, Applikations-Software, 

Programmiersprache und Geräteunterstützung, über die Sie ermitteln können, welche Teile von NI-
DAQ 7.0 zu installieren und in Ihrer Applikation zu verwenden sind. Wenn Ihre Applikationen nicht 

unterstützte Komponenten enthält, sollten Sie NI-DAQ 7.0 nicht installieren.

NI-DAQmx
Traditioneller 

NI-DAQ-Treiber

Sie haben Ihre Geräte installiert und konfiguriert.

Ermitteln Sie über 
die Readme-Datei von NI-DAQ 7.0, ob 

Sie die korrekte Version der Applikations-Software 
installiert haben.  Ist ein Upgrade 

notwendig? 

Müssen Sie 
ein SCXI- oder Switch-Modul 

installieren?

Ja

Ja

Nein

Nein

Konfigurieren Sie 
die Kanäle, wie im Handbuch 

beschrieben. Welche API verwenden Sie für die 
Programmierung der Geräte? Ja

Upgrade mit Hilfe der 
Instruktionen in der 

Applikations-Software 
durchführen

Installieren, 
konfigurieren und 

testen Sie das Modul 
und/oder Chassis, wie 
im Handbuch SCXI für 

Schnellstarter bzw. 
NI Switches für 
Schnellstarter 
beschrieben.

Mit dem DAQ-
Assistenten, der über 

den MAX oder die 
NI-Applikations-

Software verfügbar ist, 
können Sie Kanäle 
und Messaufgaben 

konfigurieren. Weitere 
Informationen erhalten 

Sie in der Hilfe des 
DAQ-Assistenten und 

in der Hilfe zum 
Measurement & 

Automation Explorer 
für NI-DAQmx.

MAX zur Konfiguration 
der Kanäle verwenden.  
Weitere Informationen 
erhalten Sie in der Hilfe 
zum Measurement & 

Automation Explorer für 
den herkömmlichen

NI-DAQ-Treiber.

Lesen Sie in dieser Dokumentation die Abschnitte über das 
neue NI-DAQmx Applikations-Programmier-Interface (API) und 

die anderen in NI-DAQ 7.0 zur Auswahl stehenden APIs.

Installieren Sie die Treibersoftware und die Dokumentation 
mit Hilfe der Anweisungen in dieser Dokumentation.

Installieren, konfigurieren und testen Sie Ihre DAQ-Geräte, wie in 
dieser Dokumentation beschrieben. Hilfreiche Informationen über 
NI-DAQ und NI-DAQmx finden Sie auch in den Hilfedateien des 

Measurement & Automation Explorers (MAX) und der Hilfe zu den 
Geräteterminals*.
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Software NI-DAQ 7.0
Die Messgeräte von National Instruments sind mit NI-DAQ Treiber-
Software versehen, einer umfassenden Sammlung von Funktionen und VIs, 
die Sie von Ihrer Anwendung (z. B. LabVIEW oder LabWindows™/CVI™) 
aus aufrufen können, um die Geräte nach Ihren Vorstellungen zu program-
mieren. Zu den Messgeräten zählen Datenerfassungsgeräte wie z. B. 
Multifunktions-I/O-Geräte (MIO-Geräte der E-Serie), SCXI-Signalkondi-
tionierungsmodule und Switchmodule. Die Treiber-Software verfügt über 
eine API-Schnittstelle (Application Programming Interface), also eine 
Zusammenstellung von VIs, Funktionen, Klassen, Attributen und Eigen-
schaften, mit denen Sie Anwendungen für Ihre Messgeräte erstellen 
können.

In NI-DAQ 7.0 sind zwei NI-DAQ-Treiber mit jeweils eigener API, 
Hardware- und Software-Konfiguration integriert. 

• Traditioneller NI-DAQ ist eine aktualisierte Version der früheren 
NI-DAQ-Version. Er umfasst dieselben VIs und Funktionen und 
arbeitet auf dieselbe Weise wie NI-DAQ 6.9.3, mit der Ausnahme, 
dass der traditionelle NI-DAQ-Treiber und der NI-DAQmx-Treiber 
zusammen auf demselben Computer verwendet werden können. 

• Bei NI-DAQmx handelt es sich um den neuesten NI-DAQ-Treiber mit 
neuen VIs, Funktionen und Werkzeugen zur Programmierung von 
Messgeräten. NI-DAQmx zeichnet sich durch folgende Merkmale 
gegenüber dem traditionellen NI-DAQ-Treiber aus:

– DAQ-Assistent: Ermöglicht die grafische Konfiguration von 
Kanälen und Messvorgängen für Ihr Gerät zur Anwendung in 
LabVIEW, LabWindows/CVI und Measurement Studio. Darüber 
hinaus kann mit dem DAQ-Assistenten NI-DAQmx-Code für den 
Einsatz in NI-Anwendungssoftware erzeugt werden.

– Verbesserte Leistung sowie I/O einzelner analoger Werte und 
Multithreading.

– Einfachere, intuitiver gestaltete APIs zur Erstellung von 
DAQ-Applikationen, die weniger Funktionen und VIs verwenden 
als frühere Versionen.

– Größere Funktionenvielfalt in der NI-DAQmx-API für LabVIEW, 
wie beispielsweise Eigenschaftsknoten zur Datenerfassung oder 
verbesserte Unterstützung von Signalverlaufsdatentypen für die 
Analog-I/O.

– Ähnliche APIs und Funktionen für ANSI C, LabWindows/CVI 
und Measurement Studio, einschließlich systemeigener .NET und 
C++-Schnittstellen.
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Anwendungsbereiche von NI-DAQmx
NI-DAQmx sollte in folgenden Situationen installiert und ausgeführt 
werden:

• Bei der Verwendung von Windows.

• Bei der ausschließlichen Verwendung eines PCI- oder PXI-Multifunk-
tions-DAQ-Gerätes der E-Serie und/oder eines unterstützten SCXI- 
oder SCC-Moduls. 

• Wird die NI-Anwendungssoftware, wie z.B. LabVIEW, LabWin-
dows/CVI oder Measurement Studio verwendet, muss mindestens 
Version 7.0 installiert sein, um mit NI-DAQmx arbeiten zu können.

Hinweis Für Measurement-Studio-.NET-Sprachen kann nur NI-DAQmx eingesetzt 
werden.

Anwendungsbereiche des herkömmlichen NI-DAQ-Treibers
In folgenden Fällen sollte der traditionelle NI-DAQ-Treiber genutzt 
werden:

• Bei Verwendung von Geräten, die nicht durch NI-DAQmx unterstützt 
werden, wie z. B. Multifunktions-DAQ-Geräten der AT E Serie, Gerä-
ten zur digitalen Ein- und Ausgabe (DIO) oder zur dynamischen 
Signalerfassung.

• Bei Verwendung von Geräten des Typs SCXI-1530, -1531 bzw. -1540 
mit Beschleunigungsmessung, LVDTs oder RVDTs, die nicht von 
NI-DAQmx unterstützt werden. 

• Beim Gebrauch des LabVIEW-Echtzeit-Moduls (RT Module).

• Während der Aktualisierung von NI-DAQ 6.9.x bei bestehenden 
Applikationen, die vorläufig noch nicht portiert werden sollen. 

• Beim Gebrauch einer LabVIEW-, LabWindows/CVI- oder 
Measurement Studio-Version älter als 7.0.

• Bei der Verwendung von Visual Basic 6.0.

Hinweis Die erste NI-Anwendungssoftware, die durch den traditionellen NI-DAQ-Treiber 
unterstützt wurde, ist Version 6.0. Für die Version 6.x von LabVIEW, LabWindows/CVI 
oder Measurement Studio kann jedoch auch der traditionelle NI-DAQ-Treiber von 
NI-DAQ 7.0 genutzt werden.
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Komponenten, die nicht mehr vom herkömmlichen DAQ-Treiber unter-
stützt werden

Folgende Komponenten werden nur noch durch NI-DAQ 6.9.3 unterstützt: 

• Versionen NI-LabVIEW, LabWindows/CVI oder Measurement Studio 
älter als 6.0.

• Windows 95.

• Einige ältere Geräte wie die Multifunktions-DAQ-Geräte der 
Serie 1200, VXI-DAQ-Geräte oder SCXI-Netzwerkgeräte.

Eine Liste der unterstützten bzw. nicht unterstützten Software und Geräte 
finden Sie im Abschnitt Unterstütze Betriebssysteme, Anwendungssoft-
ware, Programmiersprachen und Geräte des NI-DAQ 7.0 am Ende dieser 
Anleitung. 

Systemintegration von NI-DAQ
In Abbildung 2 erhalten Sie einen Überblick über die verschiedenen 
Messsysteme, und Sie sehen, wie reelle physikalische Werte einer Messan-
wendung zugeführt werden.



Schnellstart-Anleitung für NI-DAQ 78 ni.com

 

Abbildung 2.  Messsysteme

Der Computer empfängt über das Messgerät nicht aufbereitete Daten. 
Signalkonditionierungskomponenten arbeiten mit Sensoren und Messwert-
wandlern, um physikalische Größen so aufzubereiten, dass Messwerte gut 
verarbeitet werden können. Die Software nimmt diese Daten auf, stellt sie 
in verständlicher Art und Weise zum Beispiel als Graph oder Diagramm 
dar oder speichert sie als Protokoll ab. Auch das Messgerät wird von der 
Software gesteuert. Dabei erhält es Anweisungen, wann und mit welchen 
Kanälen Daten empfangen bzw. erzeugt werden sollen.
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Messgeräte und Anwendungssoftware von National Instruments sind mit 
der NI-DAQ-Treibersoftware versehen, die sicherstellt, dass Leistungs-
merkmale wie Konfiguration, Datenerfassung, -erzeugung und -austausch 
zwischen den Datenerfassungsgeräten ausgeführt werden können. Die Ver-
wendung von NI-DAQ erspart Ihnen die eigenständige Programmierung. 
Über Anwendungssoftware wie LabVIEW werden Befehle an den Treiber 
übermittelt, z. B. solche zum Erfassen von Thermoelement-Messwerten 
oder zur Analyse und Anzeige der Daten.

Es kann der NI-DAQ-Treiber von LabVIEW oder der einer beliebigen Pro-
grammierumgebung verwendet werden, sofern damit der Aufruf von DLLs 
über ANSI-C-Schnittstellen möglich ist. Die Zusammenarbeit zwischen 
Ihrer DAQ-Anwendung dem NI-DAQ-Treiber erfolgt jedoch unabhängig 
von der Programmierumgebung wie in Abbildung 2 dargestellt. 

Schritt 1: Stellen Sie sicher, dass die richtige Version 
der Anwendungssoftware installiert ist

Wenn Sie Anwendungssoftware von National Instruments wie LabVIEW, 
LabWindows/CVI oder Measurement Studio verwenden möchten, ist diese 
nun zu installieren. Für NI-DAQmx ist dazu eine Version ab 7.0 erforder-
lich. In Verbindung mit dem traditionellen NI-DAQ-Treiber kann 
NI-Anwendungssoftware ab der Version 6.0 verwendet werden. Weitere 
Informationen finden Sie in Abschnitt Unterstütze Betriebssysteme, 
Anwendungssoftware, Programmiersprachen und Geräte des NI-DAQ 7.0 
am Ende dieser Anleitung.

Tipp Wenn eine bestehende Anwendung mit einer früheren Version Ihrer Anwendungs-
software oder NI-DAQ erstellt wurde, sollten Sie davon eine Sicherheitskopie erstellen. 
Anschließend kann die Software aktualisiert und die Anwendung modifiziert werden. Um 
die Originalversion der Anwendung wieder mit der herkömmlichen NI-DAQ-API zu ver-
wenden, nutzen Sie die Sicherheitskopie.

Schritt 2: Deinstallieren Sie NI-DAQ, wenn Sie eine 
Aktualisierung einer früheren Version vornehmen 
möchten

Soll von einer früheren Version auf NI-DAQ 7.0 aktualisiert werden, 
muss dazu die bisherige NI-DAQ-Version deinstalliert werden. Klicken 
Sie dazu im Start-Menü von Windows auf Systemsteuerung»Software. 
Systemspezifische Deinstallationshinweise finden Sie unter 
ni.com/support/install. 
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Schritt 3: Installieren Sie die NI-DAQ-7.0-Software

Legen Sie die CD ein

Der NI-DAQ 7.0-Installationsassistent sollte sich automatisch öffnen. Falls 
nicht, wählen Sie Start»Ausführen und geben Sie x:\setup.exe ein 
(x steht dabei für den CD-Laufwerksbuchstaben). Zur Problembehandlung 
und betriebssystemspezifische Anweisungen steht Ihnen der Hardware 
Installation Wizard unter ni.com/support/install zur Verfügung.

Vorsicht! Wenn die vorhandene Anwendung nicht unterstützte Komponenten enthält, darf 
NI-DAQ 7.0 nicht installiert werden. Vor Installation der Software sollten Sie die Datei 
NI-DAQ 7.0 Readme lesen. Diese befindet sich auf der NI-DAQ-CD oder in Abschnitt 
Unterstütze Betriebssysteme, Anwendungssoftware, Programmiersprachen und Geräte 
des NI-DAQ 7.0 am Ende dieser Anleitung. 

Tipp Installieren Sie Ihre Treiber-Software bevor Sie neue Geräte anschließen, da sonst 
unter Umständen das Gerät von Windows nicht erkannt wird und eine entsprechende 
Warnmeldung mit Hinweis zur Treiberinstallation erscheint.

Wählen Sie die zu installierenden APIs aus

Vorsicht! NI-DAQ 7.0 darf nicht zusammen mit Vorgängerversionen installiert sein. Bei 
der Installation von NI-DAQ 7.0 wird jegliche Vorgängerversion einschließlich aller durch 
die Version unterstützten Dateien ersetzt. Bei der Installation von NI-DAQmx werden alle 
älteren NI-DAQ-Versionen gelöscht. 

NI-DAQ 7.0 enthält mehrere Treiber mit dazugehörigen APIs (den traditio-
nellen NI-DAQ-Treiber, NI-DAQmx und NI-SWITCH). Diese können je 
nach Art der verwendeten Geräte einzeln oder komplett installiert werden. 
Beschreibungen zum traditionellen NI-DAQ-Treiber und zu NI-DAQmx 
finden Sie im Abschnitt Software NI-DAQ 7.0 am Anfang dieser Anleitung. 
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Zur Programmierung eines NI-SWITCH-Moduls installieren und verwen-
den Sie NI-SWITCH. Dabei handelt es sich um einen IVI-fähigen 
Instrumententreiber für Switch, der für sämtliche Schaltmodule der Firma 
National Instruments verwendet werden kann. NI-SWITCH verfügt über 
ein interaktives Soft-Frontpanel, das der Überprüfung von Schaltanwen-
dungen und der Fehlersuche dient. Für NI-SWITCH 2.0 ist die Installation 
von NI-DAQmx und NI-VISA 3.0 erforderlich. 

Installation von Support-Dateien
Der NI-DAQ-7.0-Installer findet die auf dem Computer vorhandene 
NI-Software und wählt automatisch die aktuelle Treiberversion, Anwen-
dungssoftware sowie die Dateien der unterstützten Programmiersprachen 
von CD aus.

 

1. Überprüfen Sie, ob das Installationsprogramm die richtigen 
Support-Dateien bzw. die korrekte Versionsnummer der Anwendungs-
software bzw. Sprache ausgewählt hat. Mit einem Doppelklick auf das 
Pluszeichen vor jedem Element kann die Liste, wie in der Abbildung 
dargestellt, um die jeweiligen Unterkomponenten erweitert werden. 
Zur Installation der Support-Dateien, Beispiele und der Dokumenta-
tion stehen Ihnen zusätzliche Optionen zur Verfügung. Folgen Sie 
dazu den Eingabeaufforderungen.

Hinweis Wenn NI-DAQ 7.0 vor der NI-Anwendungssoftware der Version 7.0 installiert 
wurde, muss der NI-DAQ-7.0-Installationsassistent erneut ausgeführt werden, um die ent-
sprechende Unterstützung für die Anwendungssoftware zu aktivieren.
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2. Klicken Sie auf Beenden.

3. Sobald der Installationsvorgang abgeschlossen ist, erscheint eine Mel-
dung, die zum Neustart auffordert. Klicken Sie auf Nein und fahren Sie 
den Computer herunter.

Installationshinweise zu Produkten der RT-Serie finden Sie unter 
ni.com/support/install.

4. Schalten Sie das Gerät aus und ziehen Sie den Stecker vom Computer 
oder PXI-Chassis.

Schritt 4: Packen Sie das Gerät, das Zubehör und die 
Kabel aus

Um zu verhindern, dass das Gerät durch elektrostatische Entladung Scha-
den nimmt, wird es in einer antistatischen Verpackung ausgeliefert. Durch 
elektrostatische Entladung können verschiedene Komponenten des Gerätes 
beschädigt werden.

Vorsicht! Freiliegende Enden von Anschlusspins nicht mit den Fingern berühren!

Um Beschädigungen zu vermeiden, sollten folgende Vorsichtsmaßnahmen 
ergriffen werden:

• Erden Sie sich über ein Erdungskabel oder Berühren eines mit Masse 
verbundenen Objekts selbst.

• Bringen Sie die Verpackung vor dem Auspacken mit einem blanken 
Metallteil des Computergehäuses in Kontakt.

Packen Sie das Gerät aus und überprüfen Sie, sich eventuell Teile 
davon gelöst haben oder das Gerät anderweitig beschädigt ist. Wenn das 
Gerät beschädigt erscheinen sollte, verständigen Sie die Firma 
National Instruments. Schließen Sie auf keinen Fall eine beschädigte Kom-
ponente an den Computer oder das PXI- bzw. SCXI-Chassis an.

Wenn Sie das Gerät nicht nutzen, bewahren Sie es in der antistatischen 
Originalverpackung auf.

Sicherheitsinformationen und entsprechende Vorschriften finden Sie in 
den unter Schritt 10: Installieren Sie die Gerätedokumentation beschriebe-
nen Begleitmaterialien zu Ihrem Gerät.
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Schritt 5: Schließen Sie das Gerät, das Zubehör und die 
Kabel an

Installieren Sie jetzt alle vorhandenen DAQ-Geräte. Weitere Informatio-
nen zur Hardwarespezifikationen, wie beispielsweise Steckplatz-
anforderungen befinden sich in der Gerätedokumentation in Schritt 10: 
Installieren Sie die Gerätedokumentation.

Sollte Ihr System über Switch- oder SCXI-Module zur Signalkonditionie-
rung verfügen, die an DAQ-Geräte angeschlossen werden sollen, 
installieren Sie zunächst anhand der vorliegenden Anleitung die 
DAQ-Komponenten.

Hinweis Die folgenden Anweisungen gelten nicht für Produkte der RT-Serie. Eine Anlei-
tung zur Konfiguration von Produkten der RT-Serie finden Sie im “Hardware Installation 
Wizard” unter ni.com/support/install.

PCI-Geräte

Vorsicht! Der Computer muss ausgeschaltet sein. Vor der Installation der Hardware ist 
unbedingt eine Erdung erforderlich, um das Gerät vor Schäden durch elektrostatische 
Entladung zu schützen.

Folgende Schritte sind zur Installation einer PCI-Karte durchzuführen:

1. Entfernen Sie das Computergehäuse und die Abdeckung für den 
Erweiterungssteckplatz.

2. Berühren Sie zur elektrostatischen Entladung ein beliebiges Metallteil 
des Computers.

3. Führen Sie die Karte in den PCI-Steckplatz ein. Drücken Sie die Karte 
vollständig in den Steckplatz. Wenden Sie beim Einstecken der Karte 
auf keinen Fall Gewalt an.



Schnellstart-Anleitung für NI-DAQ 84 ni.com

 

4. Sichern Sie die Karte vor dem Herausziehen.

5. Montieren Sie das Computergehäuse.

Die PCI-Karte ist nun installiert.

PXI-Geräte

Vorsicht! Das PXI-Chassis muss ausgeschaltet sein. Vor der Installation der Hardware ist 
unbedingt eine Erdung erforderlich, um das Gerät vor Schäden durch elektrostatische Ent-
ladung zu schützen.

Folgende Schritte sind zur Installation eines PXI-Moduls durchzuführen:

1. Entfernen Sie die Blende eines freien PXI-Steckplatzes. Informationen 
zu Steckplatzanforderungen finden Sie in der Gerätedokumentation 
unter Schritt 10: Installieren Sie die Gerätedokumentation.

2. Berühren Sie zur elektrostatischen Entladung beliebiges Metallteil des 
Chassis.

3. Stecken Sie das PXI-Modul in den Steckplatz ein. Verriegeln Sie den 
Arretierhebel, um das Gerät zu befestigen.

4. Schrauben Sie die Frontplatte auf der Montageschiene des Chassis 
fest.

1 PCI-DAQ-Karte
2 PCI-Steckplatz

3 PCI-Computer

1
2

3
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Die PXI-Karte ist nun installiert.

PCMCIA-Karten
PCMCIA-Karten lassen sich auf jeden beliebigen PC-Kartensteckplatz des 
Typs II montieren. Folgende Schritte sind zur Installation einer 
PCMCIA-Karte durchzuführen:

Vorsicht! Der Computer muss ausgeschaltet sein. Sollte der PCMCIA-Adapter einen 
Wechsel auch im laufenden Betrieb zulassen, kann der Computer eingeschaltet bleiben. 
Vor der Installation der Hardware ist unbedingt eine Erdung erforderlich, um das Gerät vor 
Schäden durch elektrostatische Entladung zu schützen.

1. Entfernen Sie bei Bedarf die Abdeckung des PCMCIA-Steckplatzes.

2. Führen Sie den Busanschluss des Gerätes in den Steckplatz ein, bis 
dieser fest sitzt. NI-PCMCIA verfügen über zwei Anschlüsse: einen 
PCMCIA-Bus-Anschluss mit 68 Pins auf der einen Seite und einen 
I/O-Anschluss auf der anderen. Die PCMCIA-Karte ist so konstruiert, 
dass sie nur in eine Richtung eingebaut werden kann.

3. Schließen Sie das I/O-Kabel an. Gehen Sie beim Einstecken bzw. Ent-
fernen des Kabels vorsichtig vor und üben Sie keinen Zug aus. Fassen 
Sie das Kabel beim Einstecken und Entfernen immer am Anschluss an. 
Ziehen Sie niemals direkt am Kabel.

1 PXI-Chassis
2 PXI-Modul

3 Arretierhebel nach unten geklappt

8

7

6

5

4

3

2

1

ON

STANDBY

1

2

3
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Die PCMCIA-Karte ist nun installiert.

USB/IEEE-1394-Geräte

Vorsicht! Vor Installation der Hardware ist eine Erdung erforderlich, um diese vor Schä-
den durch elektrostatische Aufladung zu schützen.

Hinweis Bei Verwendung des BP-1 Batteriepaketes sind die Anweisungen der entspre-
chenden Installationsanleitung zu befolgen. Schritt 1 dieser Anleitung gilt in diesem Fall 
nicht. Die nachfolgenden Anweisungen gelten, wenn das BP-1-Batteriepaket nicht ver-
wendet wird.

Wenn ein NI-Gerät mit USB oder 1394-Port angeschlossen werden soll, 
sind folgende Schritte auszuführen:

1. Einige NI-Geräte mit USB- oder 1394-Schnittstelle benötigen externe 
Stromzufuhr.

• Vergewissern Sie sich bei Geräten mit einem externen Netzteil, 
dass die auf dem Netzteil angegebene Spannung mit der lokalen 
Netzspannung (120 oder 230 V~) und der des Gerätes überein-
stimmt. Schließen Sie das Netzteil an die Spannungsquelle an und 

1 PCMCIA-Computer
2 PCMCIA-Steckplatz
3 I/O-Kabel

4 Zubehör
5 I/O-Signale

®

1

2

3

4

5

DAQCard-700
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verbinden Sie das andere Ende des Kabels mit der Rückseite Ihres 
Gerätes.

• Wenn für das Gerät über ein Spannungsversorgungskabel vorhan-
den ist, schließen Sie das Gerät damit an die Spannungsquelle an.

2. Verbinden Sie das Kabel entweder mit der USB- bzw. 1394-Schnitt-
stelle des Rechners, einem HUB oder einem anderen 1394-Gerät. 
Ziehen Sie für eine feste Verbindung ggf. die Befestigungsschrauben 
an. Verbinden Sie das freie Kabelende mit dem USB- oder 
IEEE-1394-Anschluss des Gerätes. Das USB-Kabel ist in der folgen-
den Abbildung dargestellt.

Das USB- oder IEEE-1394-Gerät ist nun installiert. Bei Geräten mit USB- 
oder 1394-Interface, die einen Netzschalter auf der Rückseite haben, ist das 
Gerät einzuschalten.

Zubehör
Zubehör, Anschlussblöcke und/oder SCC-Module sind gemäß entspre-
chender Begleitdokumentation zu installieren. Für SCXI ist mit den 
Anweisungen in dieser Anleitung bis Schritt 12: Schließen Sie Sensoren 
und Signale an fortzufahren.

Schritt 6: Schalten Sie den Computer bzw. das 
PXI-Chassis ein

Nach einem Neustart des Computers wird neu installierte Hardware von 
Windows automatisch erkannt. In manchen Windows-Versionen wird nach 
Erkennung der Hardware der Assistent “Neue Hardware gefunden” mit 
einem Dialogfeld für jedes neu installierte Gerät von National Instruments 
geöffnet. Die Voreinstellung lautet: Automatische Installation der Soft-
ware (empfohlen). Klicken Sie auf Weiter bzw. Ja, um die Software für 
jedes Gerät zu installieren, so dass dieses von Windows beim nächsten 
Start erkannt wird.

1 Anschluss an den Computer bzw. 
USB-Hub

2 Geräteseitiger Anschluss

1 2
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Sobald ein USB oder IEEE 1394-Gerät von Windows erkannt wurde, 
blinkt die LED dieses Gerätes bzw. leuchtet auf und zeigt damit den Status 
an. NI-Geräte mit IEEE-1394-Schnittstelle haben darüber hinaus eine 
COM-LED, die zu blinken beginnt, wenn das Gerät gefunden wurde. 
Beschreibungen zu den Zuständen, die durch LEDs dargestellt werden, 
finden Sie in der im Abschnitt Schritt 10: Installieren Sie die Gerätedoku-
mentation beschriebenen Gerätedokumentation.

Schritt 7: Starten Sie den Measurement & Automation 
Explorer (MAX)

Klicken Sie das Symbol des Measurement & Automation auf dem 
Desktop doppelt an, um diesen zu öffnen.

Schritt 8: Überprüfen Sie, ob das Gerät erkannt wurde

1. Erweitern Sie in der Verzeichnisstruktur die Kategorie Geräte und 
Schnittstellen.

2. Überprüfen Sie, ob das neue Gerät aufgeführt ist.

Falls ein Gerät sowohl durch den traditionellen NI-DAQ-Treiber als 
auch durch NI-DAQmx unterstützt wird, und beide Treiber installiert 
sind, wird das Gerät unter “Geräte und Schnittstellen” mit unterschied-
lichen Namen in beiden Treiberordnern angezeigt. Sollte das Gerät 
nicht automatisch angezeigt werden, drücken Sie <F5>, um die 
Anzeige des MAX zu aktualisieren. Falls das Gerät dann immer noch 
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nicht erscheint, können Informationen zur Fehlerbehebung unter 
ni.com/support/install eingeholt werden.

3. Im Ordner der NI-DAQ-API, die zur Programmierung des Gerätes ver-
wendet wird, ist das zu testende Gerät mit der rechten Maustaste 
anzuklicken.

• Wenn sich das Gerät unter dem traditionellen NI-DAQ-Treiber 
befindet, wählen Sie Eigenschaften und klicken dann auf die 
Schaltfläche Ressourcen testen.

• Wenn sich das Gerät unter NI-DAQmx befindet, wählen Sie 
Selbsttest.

 

4. Nach Beendigung des Selbsttests erscheint eine Meldung, die angibt, 
ob ein Fehler vorliegt. Informationen zur Fehlerbehandlung finden Sie 
unter ni.com/support.

Schritt 9: Nehmen Sie Einstellungen zu Ihrem Gerät vor
Jedes neu installierte Gerät muss konfiguriert werden. Um ein Gerät 
sowohl mit dem traditionellen NI-DAQ-Treiber als auch mit NI-DAQmx 
verwenden zu können, müssen die Eigenschaften des Gerätes für beide 
Treiber konfiguriert werden.

1. Klicken Sie mit der rechten Maustaste auf den Gerätenamen und 
wählen Sie Eigenschaften. Der Gerätenamen muss im Ordner der 
NI-DAQ-API angeklickt werden, in dem Sie das Gerät verwenden 
wollen.

2. Konfigurieren Sie die Geräteeigenschaften.

• Geben Sie bei der Verwendung von Zubehör die entsprechenden 
Daten ein.
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• Wenn Sie ein Gerät mit dem traditionellen NI-DAQ-Treiber 
ansteuern möchten, können die Gerätevoreinstellungen für AI, 
AO, OPC oder Netzwerkzugriff verändert werden. Weitere Infor-
mationen über Gerätevoreinstellungen finden Sie in den im 
nächsten Schritt beschriebenen Unterlagen zu Ihrem Gerät.

3. Klicken Sie auf OK, um die vorgenommenen Änderungen zu 
speichern.

Tipp Bei Geräten, die sowohl durch den traditionellen NI-DAQ-Treiber als auch durch 
NI-DAQmx unterstützt werden, kann die Konfiguration virtueller Kanäle und Skalierun-
gen für den traditionellen NI-DAQ in eine NI-DAQmx-Konfiguration umgewandelt 
werden. Verwenden Sie dazu den Assistenten zur Umwandlung des herkömmlichen 
NI-DAQ-Treibers in den NI-DAQmx. SCXI- und Zubehör-Konfigurationen werden eben-
falls durch den Konverter umgewandelt, jedoch nicht SCC-Konfigurationen. Diese müssen 
für jede zu verwendende API einzeln konfiguriert werden. Weitere Informationen finden 
Sie im Abschnitt Converting Traditional NI-DAQ Configurations to NI-DAQmx
Configurations in der Measurement & Automation Explorer Help for NI-DAQmx.

Schritt 10: Installieren Sie die Gerätedokumentation
Mit der NI-DAQ-7.0-Software wird auch eine CD mit Begleitmaterial zu 
den unterstützten DAQ-, SCXI- und Switchgeräten mitgeliefert. Darunter 
befinden sich Hilfedateien, in denen die Anschlüsse, Komponenten und der 
Betrieb der Geräte beschrieben sind, sowie PDF-Dateien der Gerätedoku-
mente. Um nach Informationsquellen zu jedem Gerät zu suchen, diese zu 
öffnen und auszudrucken, verwenden Sie den Gerätedokumente-Browser. 

Durch die CD mit der Gerätedokumentation des NI-DAQ 7.0 steht Ihnen 
diese Suchmaschine jederzeit zur Verfügung. Der Gerätedoku-
mente-Browser bietet folgende Optionen:

• Geräte-Dokumente finden öffnet die Suchmaschine und zeigt die 
Begleitmaterialien zu jedem Gerät an.

• Geräte-Dokumente installieren kopiert den Dokumente-Browser und 
sämtliche darin befindlichen Dokumente auf die Festplatte. Nach der 
Installation kann über Start»Programme»National Instruments»
NI-DAQ»Geräte-Dokumentation suchen auf die Suchmaschine 
zugegriffen werden.

Sollte sich der Browser nicht automatisch öffnen, kann er über Start»
Ausführen und die Eingabe von x:\autorun.exe manuell gestartet 
werden (anstelle von x ist der CD-Laufwerksbuchstabe einzugeben).

Hinweis Um die Hilfe und den Gerätedokumente-Browser sowie bestimmte andere Kom-
ponenten der NI-DAQ-7.0-Dokumentation nutzen zu können, muss eine Version des 
Internet Explorers ab 5.0 installiert sein.
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Schritt 11: Installieren Sie SCXI- oder Switchmodule 
(wenn vorhanden)

Wenn zu Ihrem System SCXI-Module zur Signalkonditionierung oder 
Switchmodule für die Verbindung von DAQ-Geräten gehören, verwenden 
Sie zur Installation und Konfiguration der entsprechenden Geräte die 
SCXI-Schnellstart-Anleitung und den NI Switches Getting Started Guide.

Der Rest dieser Anleitung bezieht sich nur auf DAQ-Geräte mit Anschluss-
blöcken oder SCC-Zubehör.

Schritt 12: Schließen Sie Sensoren und Signale an
Verbinden Sie mit den Geräte- bzw. Zubehöranschlüssen Sensoren und 
Signale.

Von großer Hilfe sind dazu die Informationen in folgenden 
Begleitdokumenten:

• Signal- und Anschlussverbindungen:

– Über den Gerätedokumente-Browser können Sie auf die Hilfe zur 
E-Serie, Gerätehandbücher im PDF-Format und auf PDF-Dateien 
zum Zubehör zugreifen.

– Informationen über die Pinbelegung finden Sie in der Hilfe zum 
Measurement & Automation Explorer für den traditionellen 
NI-DAQ-Treiber und in der Hilfe zum Measurement & Automa-
tion Explorer für NI-DAQmx, auf die über das MAX-Hilfemenü 
zugegriffen werden kann.

• In den Switch-Spezifikationen ist auch die Gerätearchitektur 
enthalten.

• Verwendung der Sensoren:

– Das Handbuch LabVIEW Measurements Manual wird mit 
LabVIEW mitgeliefert. Es ist aber auch auf der Internetseite 
ni.com/manuals verfügbar. 

– Bei Verwendung einer anderen Programmierumgebung und 
NI-DAQmx finden Sie Unterstützung im Kapitel Sensoren der 
NI-DAQmx-Hilfe, auf das über Start»Programme»National 
Instruments»NI-DAQ»NI-DAQmx Help zugegriffen werden 
kann.

– Bei Verwendung einer anderen Programmierumgebung und 
dem traditionellen NI-DAQ-Treiber finden Sie Informationen im 
Kapitel 5 der Transducer Conversion Functions des Benutzer-
handbuchs Traditional NI-DAQ User Manual, auf die Sie über 
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Start»Programme»National Instruments»NI-DAQ»
Traditional NI-DAQ User Manual zugegriffen können.

Schritt 13: Starten Sie die Test-Panels
Zu vielen Geräten sind Testroutinen zur Überprüfung bestimmter Geräte-
funktionen verfügbar, wie beispielsweise der Ein- und Ausgabe von 
Signalen.

1. Öffnen Sie die MAX-Hilfe, um die Testpanel zu starten.

a. Wählen Sie je nach zu überprüfendem Treiber nach 
Hilfe»Hilfe-Themen entweder»NI-DAQmx oder traditioneller 
NI-DAQ-Treiber. Die MAX-Hilfe wird gestartet.

b. Erweitern Sie auf der Registerkarte “Inhalt” Measurement & 
Automation Explorer»MAX für die zu überprüfende 
NI-DAQ-Version»Erste Schritte»DAQ-Geräte»DAQ-Geräte 
überprüfen.

c. Klicken Sie auf DAQ-Geräte überprüfen, um die Hilfethemen 
zum Ausführen der Testpanels aufzurufen.

d. Um das MAX-Konfigurationsfenster anzuzeigen, muss das Hilfe-
fenster verkleinert werden.

2. Klicken Sie auf den MAX, um ihn in den Vordergrund zu bringen.

3. Klicken Sie dann unter “traditionelle NI-DAQ-Geräte” oder 
“NI-DAQmx-Geräte” das zu überprüfende Gerät mit der rechten Mau-
staste an.

4. Wählen Sie anschließend für das ausgewählte Gerät die Option 
Test-Panel aus.
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In der nachstehenden Abbildung sehen Sie ein Beispiel für ein 
Testpanel.

5. Klicken Sie auf die Registerkarten, um die verschiedenen Gerätefunk-
tionen zu testen. Um Informationen zum Ausführen der Testpanels mit 
dem traditionellen NI-DAQ-Treiber bzw. NI-DAQmx zu erhalten, 
muss das MAX-Hilfefenster angeklickt werden.

6. Das Testpanel zeigt eine Meldung, die angibt, ob ein Fehler vorliegt. 
Informationen zur Fehlerbehandlung sind unter NI-DAQmx Reference 
Help bzw. ni.com/support zu finden.

7. Verlassen Sie nach Beendigung das Testpanel durch einen Klick auf 
die Schaltfläche OK oder Schließen.

Schritt 14: Konfigurieren Sie alle neu angeschlossenen 
Geräte

Wenn Sie mehrere DAQ-Geräte installiert haben, müssen die Schritte 9 bis 
13 für jedes einzelne Gerät wiederholt werden.
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Schritt 15: Konfigurieren Sie Kanäle und Tasks
Ein physikalischer Kanal ist ein Anschluss bzw. Pin, an dem ein analoges 
oder digitales Signal gemessen oder erzeugt wird. Ein virtueller Kanal ist 
eine Sammlung von Einstellungen zu einem physikalischen Kanal (z. B. 
Bezeichnung, Anschlussverbindung, Art der Messung oder Signalerzeu-
gung, Skalierung). Beim traditionellen NI-DAQ-Treiber und in früheren 
Versionen kann über die Konfiguration virtueller Kanäle festgestellt wer-
den, welche Kanäle für verschiedene Messungen verwendet werden. Bei 
NI-DAQmx sind virtuelle Kanäle Bestandteil einer jeden Messung.

Beim traditionellen NI-DAQ-Treiber werden virtuelle Kanäle mit Hilfe des 
MAX konfiguriert. In NI-DAQmx können virtuelle Kanäle mit Hilfe des 
DAQ-Assistenten konfiguriert werden, der sich vom MAX oder von der 
Applikationssoftware aus öffnen lässt. Ein Konfigurieren virtueller Kanäle 
ist aber auch mit der NI-DAQmx-API Ihres Anwendungsprogramms 
möglich.

Ein Task ist ein wichtiger neuer Bestandteil von NI-DAQmx, der mehrere 
virtuelle Kanäle umfasst sowie Einstellungen zum Timing, zur Triggerung 
und zu weiteren Eigenschaften ermöglicht. Ein Task ist eine Messung oder 
Signalerzeugung, die durchgeführt werden soll. Sämtliche Konfigurations-
informationen eines Tasks können nach dem Einrichten gespeichert 
werden und der Task kann danach als Applikation verwendet werden.

In NI-DAQmx können virtuelle Kanäle als Teil eines Tasks konfiguriert 
oder von diesem getrennt werden. Virtuelle Kanäle, die innerhalb eines 
Tasks erstellt wurden, werden als lokale Kanäle bezeichnet. Dagegen 
werden virtuelle Kanäle, die außerhalb eines Tasks erstellt wurden, als 
globale Kanäle bezeichnet. Globale Kanäle können Sie entweder den 
MAX oder Ihre Applikations-Software verwenden. Globale Kanäle 
können in jeder beliebigen Applikation verwendet oder verschiedenen 
Tasks hinzugefügt werden. Bei der Modifizierung eines globalen Kanals 
betrifft die Änderung aller darauf bezogener Tasks. In den meisten Fällen 
ist es jedoch einfacher, lokale Kanäle zu verwenden.

Konfiguration eines Tasks in NI-DAQmx
Bei der Verwendung von NI-DAQmx müssen Tasks mit Hilfe des 
DAQ-Assistenten konfiguriert werden. Zum Erstellen von Tasks und Kanä-
len mit dem DAQ-Assistenten muss das Anwendungssoftwarepaket von 
National Instruments der Version 7.0 installiert sein.

• Klicken Sie im MAX mit der rechten Maustaste auf Datenumgebung 
und wählen Sie Neu. Klicken Sie auf die Schaltfläche 
NI-DAQmx-Task und anschließend auf Weiter.
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• Der DAQ-Assistent lässt sich auch direkt aus der Anwendungssoft-
ware heraus öffnen.

– In LabVIEW gibt es zum Öffnen des DAQ-Assistenten folgende 
Möglichkeiten:

• Fügen Sie das Express-VI “DAQ-Assistent” der 
Express-Palette entsprechend der Beschreibung unter Erste 
Schritte mit LabVIEW ein.

• Alternativ kann auch das Bedienelement “DAQmx-Task-
name” verwendet werden. Klicken Sie mit der rechten 
Maustaste auf das Bedienelement und wählen Sie Neuer 
Task (DAQ-Assistent). Das Hilfe-Tutorium Taking an 
NI-DAQmx Measurement in LabVIEW enthält 
Schritt-für-Schritt-Anweisungen dazu, wie mit dem 
Bedienelement DAQmx-Task-Name ein Task erstellt und 
Code erzeugt werden kann. Um es zu öffnen, wählen Sie 
Hilfe»NI-DAQmx-Messung vornehmen.

– In LabWindows/CVI ist Werkzeuge»DAQmx-Tasks 
erstellen/bearbeiten auszuwählen.

– Nach dem Öffnen von Visual Studio .NET in Measurement Studio 
wählen Sie Project»Add New Item, um das Dialogfeld “Add 
New Item” anzuzeigen. Danach ist Measurement Studio»
Assistants aus dem Kategorie-Fenster auszuwählen. Wählen Sie 
anschließend DAQmx Task Klasse aus dem Vorlagen-Fenster 
aus.

Der DAQ-Assistent wird geöffnet.
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Um einen neuen Task zu erstellen, ist den Online-Anweisungen zu folgen. 

1. Wählen Sie einen I/O-Typ aus (z. B. analoger Eingang).

2. Bestimmen Sie anschließend die Art der auszuführenden Messung 
bzw. Signalerzeugung.

3. Wenn vorhanden, wählen Sie den zu verwendenden Sensor aus.

4. Als nächstes ist zu entscheiden, welche Kanäle dem Task hinzugefügt 
werden sollen. Es können globale Kanäle hinzugefügt werden oder 
physikalische Kanäle gewählt werden, aus denen dann innerhalb des 
Tasks lokale Kanäle erzeugt werden.

5. Bei Bedarf können nun messungsspezifische Einstellungen sowie 
Timing und Triggerung vorgenommen werden.

6. Speichern Sie den Task.

• Sofern der DAQ-Assistent von LabVIEW oder von 
LabWindows/CVI aus geöffnet wurde, klicken Sie auf OK.

• Wurde der DAQ-Assistent von Measurement Studio aus geöffnet, 
klicken Sie auf Datei»Speichern.

• Wenn der DAQ-Assistent von MAX aus geöffnet wurde, wählen 
Sie Task speichern.

Nun kann der Task in einer Applikation verwendet werden. Weitere Infor-
mationen über die Verwendung eines Tasks oder die Erstellung von Code 
finden Sie in der Hilfe zum DAQ-Assistenten bzw. in den Unterlagen zur 
Anwendungssoftware.

Konfiguration globaler Kanäle in NI-DAQmx
Bei der Verwendung von NI-DAQmx müssen globale Kanäle mit Hilfe des 
DAQ-Assistenten konfiguriert werden.

• Klicken Sie im MAX mit der rechten Maustaste auf Datenumgebung 
und wählen Sie Neu. Wählen Sie im Fenster Hinzufügen die Schalt-
fläche NI-DAQmx - Globaler Kanal aus und klicken Sie auf Weiter.

• Der DAQ-Assistent lässt sich auch direkt von LabVIEW 7.0, 
LabWindows/CVI 7.0 oder Measurement Studio 7.0 aus öffnen.

– Verwenden Sie in LabVIEW das Bedienelement “DAQmx - 
Globaler Kanal”. Klicken Sie mit der rechten Maustaste auf das 
Bedienelement und wählen Sie Neuer Kanal (DAQ-Assistent).

– In LabWindows/CVI oder Measurement Studio muss zunächst, 
wie zuvor beschrieben, ein Task erstellt werden. Um dem Task 
globale Kanäle hinzuzufügen, klicken Sie im DAQ-Assistenten 
auf Vorhandene DAQmx-Känale hinzufügen.
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Der DAQ-Assistent wird geöffnet. Um einen neuen globalen Kanal zu 
erstellen, folgen Sie den Online-Anweisungen.

1. Wählen Sie einen I/O-Typ aus (z. B. analoger Eingang).

2. Bestimmen Sie anschließend die Art der auszuführenden Messung 
bzw. Signalerzeugung.

3. Wenn vorhanden, wählen Sie den zu verwendenden Sensor aus.

4. Bestimmen Sie dann den zu verwendenden physikalischen Kanal.

5. Nehmen Sie nun alle messungsspezifischen Einstellungen vor.

6. Speichern Sie den Task.

• Sofern der DAQ-Assistent von LabVIEW oder von 
LabWindows/CVI aus geöffnet wurde, klicken Sie auf OK.

• Wurde der DAQ-Assistent von Measurement Studio aus geöffnet, 
klicken Sie auf Datei»Speichern.

• Wenn der DAQ-Assistent von MAX aus geöffnet wurde, klicken 
Sie auf Kanal speichern.

Der globale Kanal kann nun in jeder beliebigen Applikation verwendet 
oder einem Task hinzugefügt werden. Weitere Informationen über die Ver-
wendung eines Kanals oder das Erstellen von Code erhalten Sie in der Hilfe 
zum DAQ-Assistenten bzw. in der Dokumentation zur 
Anwendungssoftware.

Konfiguration virtueller Kanäle für den traditionellen NI-DAQ-Treiber
Bei Verwendung des traditionellen NI-DAQ-Treibers sind virtuelle Kanäle 
im MAX zu konfigurieren.

1. Klicken Sie im MAX mit der rechten Maustaste auf Datenumgebung 
und wählen Sie Neu.

2. Wählen Sie anschließend Virtueller Kanal für traditionellen 
NI-DAQ und klicken Sie auf Beenden. Daraufhin öffnet sich der 
Assistent “Neuen Kanal erstellen”.
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3. Folgen Sie den Anweisungen zum Erstellen eines neuen Kanals. 
Zusätzliche Informationen über die Konfiguration verschiedene 
Kanaltypen befindet sich in der Hilfe zum Measurement & Automation 
Explorer für den traditionellen NI-DAQ-Treiber.

Erste Schritte zum Erstellen einer Applikation

Beispiele
Jede API enthält Programmierbeispiele, die das Erstellen einer Applikation 
vereinfachen sollen. Diese können bearbeitet oder in einer anderen Appli-
kation verwendet werden. Sie können die Beispiele zum Erstellen einer 
neuen Applikation verwenden oder zu einer bestehenden Applikation 
hinzufügen.

Zum Auffinden von LabVIEW- und LabWindows/CVI-Beispielen öffnen 
Sie die Suchmaschine für Beispiele von National Instruments.

• In LabVIEW wählen Sie Hilfe»Beispiele suchen.

• In LabWindows/CVI wählen Sie Help»NI Example Finder.

Beispiele für Measurement Studio, Visual Basic und ANSI C sind in fol-
genden Verzeichnissen verfügbar:

• NI-DAQmx-Beispiele für von Measurement Studio unterstützte Pro-
grammiersprachen befinden sich in folgenden Verzeichnissen:

– MeasurementStudio\VCNET\Examples\DAQmx 

– MeasurementStudio\DotNET\Examples\DAQmx
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• Beispiele für den traditionellen NI-DAQ-Treiber zur Verwendung in 
Visual Basic finden Sie in folgenden Verzeichnissen:

– Das Verzeichnis NI-DAQ\Examples\Visual Basic with 
Measurement Studio enthält einen Link zu den 
Anwendungsbeispielen für ActiveX-Elemente in Measurement 
Studio.

– Das Verzeichnis NI-DAQ\Examples\VBasic enthält von 
Measurement Studio unabhängige Beispiele.

• Im Verzeichnis NI-DAQ\Examples\DAQmx ANSI C befinden sich 
NI-DAQmx-Beispiele für ANSI C.

• Im Verzeichnis NI-DAQ\Examples\VisualC sind Beispiele für den 
traditionellen NI-DAQ-Treiber für ANSI C verfügbar.

Zusätzliche Beispiele sind unter ni.com/zone zu finden.

Informationen über Messapplikationen und Messgeräte
Jedes Anwendungssoftwarepaket mit Treiber enthält Informationen zum 
Erstellen von Applikationen für Messungen sowie zur Steuerung von 
Messgeräten. Die im Folgenden genannten Dokument-Referenzen haben 
Gültigkeit unter der Voraussetzung, dass NI-DAQ 7.0 und, wo notwendig, 
die NI-Anwendungssoftware der Version 7.0 installiert sind.

LabVIEW
Neuanwender sollten sich zunächst mit dem Handbuch Erste Schritte mit 
LabVIEW befassen, um mit LabVIEW vertraut zu werden. Wählen Sie 
dazu Start»Programme»National Instruments»LabVIEW»Im 
LabVIEW-Bücherregal suchen.

Im LabVIEW Measurements Manual finden Sie API-Übersichten zum tra-
ditionellen NI-DAQ- und zum NI-DAQmx-Treiber sowie Beschreibungen 
zu Messvorgängen. Klicken Sie dazu Start»Programme»National
Instruments»LabVIEW»LabVIEW-Bibliothek durchsuchen an.

Das Hilfe-Tutorium Taking an NI-DAQmx Measurement in LabVIEW 
enthält Schritt-für-Schritt-Anweisungen dazu, wie ein Messvorgang in 
LabVIEW einzurichten ist und beschreibt neue NI-DAQmx-Funktionen 
sowie spezielle Konzepte, wie beispielsweise den DAQ-Assistenten und 
Tasks. Nach Auswahl von Hilfe»NI-DAQmx-Messung vornehmen in 
LabVIEW wird das Tutorium geöffnet.

In der LabVIEW Traditional NI-DAQ VI Reference Help und der LabVIEW 
NI-DAQmx VI Reference Help sind LabVIEW-VIs und deren Eigenschaf-
ten beschrieben. Wählen Sie dazu in LabVIEW Hilfe und dann die 
LabVIEW-VI Referenz-Hilfe für die verwendete NI-DAQ-API aus. 



Schnellstart-Anleitung für NI-DAQ 100 ni.com

LabWindows/CVI
In der Datenerfassungsbibliothek der LabWindows/CVI Help sind 
API-Übersichten, Konzepte zu Messvorgängen und Informationen zu 
Funktionen zum traditionellen NI-DAQ- und dem NI-DAQmx-Treiber 
enthalten. Um sie zu öffnen, wählen Sie in LabWindows/CVI 
Help»Contents.

Measurement Studio
Die Hilfe zu NI Measurement Studio enthält eine Übersicht über 
NI-DAQmx-APIs, Messvorgänge, Konzepte und Informationen zu 
Funktionen. Diese Hilfedatei ist Bestandteil der Visual-Studio-.NET-
Dokumentation. Um sie zu öffnen, klicken Sie in Visual Studio .NET die 
Option Help»Contents an.

Die Measurement Studio Reference enthält die API-Übersicht des traditio-
nellen NI-DAQ-Treibers, Konzepte zu Messvorgängen und Informationen 
zu Funktionen. Um sie zu öffnen, klicken Sie in Visual Studio .NET 
Measurement Studio»Measurement Studio Reference an.

ANSI C ohne NI-Anwendungssoftware
Übersichten über APIs finden Sie im Traditional NI-DAQ User Manual 
und der NI-DAQmx Help. Die NI-DAQmx Help enthält zusätzlich allge-
meine Informationen zu Messvorgängen. In der Traditional NI-DAQ C 
Reference Help und der NI-DAQmx C Reference Help finden Sie eine 
Übersicht über die Funktionen und Attribute von C. Wählen Sie 
Start»Programme»National Instruments»NI-DAQ und den Titel des 
Dokuments der verwendeten NI-DAQ-API aus.

.NET-Sprachen ohne NI-Anwendungssoftware
Die NI Measurement Studio Help enthält eine Übersicht über 
NI-DAQmx-APIs, Messvorgänge, Konzepte und Informationen zu 
Funktionen. Diese Hilfedatei ist Bestandteil der Visual-Studio-.NET-
Dokumentation. Um sie zu öffnen, klicken Sie in Visual Studio .NET die 
Option Help»Contents an.

Hinweis Bei Verwendung einer .NET-Sprache ohne Visual Studio .NET kann es vorkom-
men, dass die NI Measurement Studio Help nicht eingesehen werden kann.

Gerätedokumentation
Zu NI-DAQ 7.0 gibt es eine Online-Dokumentation für unterstützte DAQ-, 
SCXI- und Switchgeräte, die über den Gerätedokumente-Browser einseh-
bar ist. Dabei handelt es sich um Hilfedateien zu Geräteanschlüssen, 
Eigenschaften und Operationen sowie um Gerätedokumente im PDF-For-
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mat. Diese Suchmaschine steht Ihnen jederzeit zur Verfügung, da sie sich 
auf der CD mit der Gerätedokumentation befindet. Nach der Installation 
des Gerätedokumente-Browsers kann über Start»Programme»National 
Instruments»NI-DAQ»Geräte-Dokumentation finden auf die Doku-
mente zugegriffen werden.

Konfiguration von SCXI- und Switch-Multi-Chassis
Im SCXI-1346 Shielded Multi-Chassis Cable Installation Guide finden Sie 
Setup-Anweisungen zur Erstellung von SCXI- und 
Switch-Multi-Chassis-Applikationen.

Switch
In der NI Switches Help sind technischer Support und Programmierunter-
stützung für das Schaltmodul und den NI-SWITCH-Instrumententreiber 
verfügbar.

Der SWITCH Instrument Driver Quick Reference Guide enthält eine API- 
sowie eine Funktion/VI-Übersicht.

Kurse
Für weiterführende Anleitung bei der Entwicklung von Applikationen mit 
NI-Produkten bietet die Firma National Instruments Trainingskurse an. 
Anmeldeinformationen und Kursinhalte können der Internetseite 
ni.com/training entnommen werden.

Technische Unterstützung
Weitere Unterstützung finden Sie unter ni.com/support oder 
ni.com/zone.

Verwendung des traditionellen NI-DAQ- und des 
NI-DAQmx-Treibers auf demselben Computer

Bestehende Applikationen, die mit früheren Versionen von NI-DAQ 
erstellt wurden, können mit dem traditionellen NI-DAQ-Treiber ausgeführt 
werden. Wenn sowohl die traditionelle NI-DAQ-API als auch die 
NI-DAQmx-API auf demselben Computer verwendet werden, gelten 
jedoch folgende Einschränkungen:

• Ein Gerät kann nur von jeweils einer API gesteuert werden.

– Nach der Verwendung eines Gerätes mit NI-DAQmx müssen alle 
NI-DAQmx-Tasks, die auf dieses Gerät zugreifen, zurückgesetzt 
werden, bevor das Gerät mit dem traditionellen NI-DAQ-Treiber 
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verwendet werden kann. Um NI-DAQmx-Tasks aufzuheben, 
muss das VI “DAQmx - Task zurücksetzen” aufgerufen werden. 

– Nach Verwendung eines Gerätes mit dem traditionellen 
NI-DAQ-Treiber muss das Gerät erst zurückgesetzt werden, bevor 
es mit NI-DAQmx arbeiten kann. Bei SCXI-Geräten muss das 
DAQ-Gerät zurückgesetzt werden, das der SCXI-Kommunikator 
ist.

• Rufen Sie dazu das VI “Gerät zurücksetzen” des traditionel-
len NI-DAQ oder die Funktion Init_DA_Brds auf. 

• Um alle Geräte mit dem traditionellen NI-DAQ-Treiber 
zurückzusetzen, klicken Sie mit der rechten Maustaste auf 
den Ordner “Geräte mit herkömmlichem NI-DAQ-Treiber” 
in MAX und wählen Treiber für den traditionellen 
NI-DAQ zurücksetzen. 

• Zur Programmierung aller Geräte innerhalb eines SCXI-Datenerfas-
sungssystems, wie z. B. angeschlossener DAQ-Geräte oder 
SCXI-Module, muss dieselbe API verwendet werden.

Auf der Internetseite ni.com/support finden Sie Einzelheiten und 
Anweisungen zu folgenden Themen: 

• Einfügen von NI-DAQmx-Code in Applikationen für den traditionel-
len NI-DAQ-Treiber

• Ausführen von Applikationen mit traditionellen NI-DAQ- und 
NI-DAQmx-Treiber, die dasselbe Gerät verwenden

Unterstütze Betriebssysteme, Anwendungssoftware, 
Programmiersprachen und Geräte des NI-DAQ 7.0

NI-DAQmx-Version 7.0 ist noch nicht in der Lage, die gesamte Palette von 
NI-Messgeräten zu unterstützen. Die kommenden Ausgaben von NI-DAQ 
werden sowohl neue/bestehende Geräte für NI-DAQmx unterstützen, als 
auch die Geräte für den traditionellen NI-DAQ-Treiber.

Betriebssystem-Unterstützung
NI-DAQmx, der traditionelle NI-DAQ und NI-SWITCH 2.0 können unter 
Windows 2000/NT/XP/Me/98 verwendet werden. Für NI-DAQ 7.0 ist 
unter Windows NT das Service-Pack 6 ab Version 6 erforderlich. Für 
Measurement Studio wird Visual Studio .NET 2003 benötigt, was wie-
derum Windows 2000/NT 4.0/XP voraussetzt. Für systemspezifische 
Installationsanweisungen verwenden Sie den Hardware-Installationsassi-
stenten unter ni.com/support/install.
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Unter ni.com/downloads können frühere Versionen von NI-DAQ, die 
auch andere Betriebssysteme unterstützen, heruntergeladen werden.

Unterstützung für Anwendungssoftware und Programmiersprachen
Tabelle 1 enthält eine Auflistung der Anwendungssoftwareversionen, 
die durch NI-DAQmx und den traditionellen NI-DAQ-Treiber unterstützt 
werden. Wenn Sie keine Anwendungssoftware von National Instruments 
verwenden, gilt Tabelle 2.

 

In Tabelle 2 sehen Sie eine Auflistung der Programmiersprachen und Ver-
sionen, die durch NI-DAQmx und den traditionellen NI-DAQ-Treiber 
unterstützt werden.

 

Tabelle 1.  Von NI-DAQ 7.0 unterstützte Anwendungssoftware

NI-Anwendungssoftware NI-DAQmx
Traditioneller 

NI-DAQ-Treiber

LabVIEW  7.0 6.0–7.0

LabVIEW-RT-Modul — 6.0–7.01 

LabWindows/CVI  7.0 6.0–7.0

Measurement Studio  7.0 6.0–7.02

1 Bei Benutzung von LabVIEW-RT muss für die Applikationen der traditionelle 
NI-DAQ-Treiber verwendet werden. In zukünftigen Versionen von NI-DAQmx wird auch 
LabVIEW-RT unterstützt.

2 Der traditionelle NI-DAQ-Treiber hat keine Measurement-Studio-C++- oder 
.NET-Schnittstelle.

Tabelle 2.  Von NI-DAQ 7.0 unterstützte Programmiersprachen

Programmiersprache NI-DAQmx
Traditioneller 

NI-DAQ-Treiber

ANSI C ✓ 3

Microsoft Visual C++
Klassen-Bibliotheken
C-DLL

7.01

6.0–7.0
—

6.0–7.0

Visual Basic 6.0 durch ActiveX — 6.0

Microsoft-.NET-Sprachen
(C# und Visual Basic .NET)

.NET 1.1 —

1 Erfordert Measurement Studio 7.0.
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Frühere Versionen von NI-DAQ unterstützen andere Anwendungssoft-
ware- und Sprachversionen. Ältere Treiberversionen können unter 
ni.com/downloads heruntergeladen werden.

Geräteunterstützung
Die spezifischen Geräte-Modellnamen befinden sich auf der NI-DAQ 7.0 
Readme-Datei der CD. In der Tabelle 3 finden Sie eine Auflistung der 
Gerätefamilien, die durch NI-DAQmx, den traditionellen NI-DAQ-Treiber 
und NI-SWITCH 2.0 unterstützt werden. 

Tabelle 3.  Von NI-DAQ 7.0 unterstützte Geräte

Gerät NI-DAQmx
Traditioneller 

NI-DAQ NI-SWITCH 2.0

PCI- und PXI-Multifunktions-DAQ-Karten 
der E-Serie wie NI PCI-6052E

✓ ✓ nicht verfügbar

DAQPad-Geräte für USB und FireWire 
(IEEE 1394)

— ✓ nicht verfügbar

E-Serien DAQCard, PCMCIA-Karten — ✓ nicht verfügbar

NI PCI-6013/6014 16-Bit 
Basis-Multifunktions-DAQ-Geräte

— ✓ nicht verfügbar

Multifunktions-DAQ-Karten der S-Serie 
wie die NI PXI-6115

— ✓ nicht verfügbar

Digitale I/O-Geräte wie die NI 
653X-Gerätefamilie

— ✓ nicht verfügbar

NI PCI-4551, PCI-4552, PCI und 
PXI-4472 Messkarten für dynamische 
Signale

— ✓ nicht verfügbar

NI PCI und PXI 671X/673X 
Analogausgabegeräte

— ✓ nicht verfügbar

NI-660X Counter/Timer-I/O-Geräte — ✓ nicht verfügbar

NI-SCXI-1530, -1531 und 
-1540-Signalkonditionierungsmodule

✓1 ✓ nicht verfügbar

Alle anderen 
SCXI-Signalkonditionierungsmodule

✓ ✓ nicht verfügbar

Signalkonditionierung der SCC-Serie ✓ ✓ nicht verfügbar

NI-SCXI-1166 und -1193-Switchmodule ✓ — ✓

Alle anderen SCXI-Switchmodule ✓ ✓ ✓
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Eine Liste neuer, durch NI-DAQ 7.0 unterstützte Geräte finden Sie in der 
Datei NI-DAQ 7.0 Readme auf der Treiber-CD.

Weitere Geräte in künftigen Versionen von 
NI-DAQmx
In künftigen Versionen von NI-DAQ werden auch solche zusätzliche 
Geräte in NI-DAQmx unterstützt, die derzeit nur durch den traditionellen 
NI-DAQ-Treiber angesteuert werden können.

Auf den traditionellen NI-DAQ-Treiber beschränkte 
Geräte
Folgende Geräte werden weder von der momentanen noch einer zukünfti-
gen Version des NI-DAQmx unterstützt, sondern ausschließlich durch den 
traditionellen NI-DAQ-Treiber:

• Geräte der AT E-Serie

• AT-AO-6/10 Analogausgabe-Geräte

• AT-DIO-32F 32-Bit Parallel-DIO-Geräte

• DAQCard-AI-16E-4 und -16XE-50-PCMCIA-Karten

• NI PCI-4451/4452/4454 Geräte zur Erfassung und Ausgabe von dyna-
mischen Signalen

• NI 4350/4351 Datenprotokollgeräte

Geräte, die von NI-DAQ 7.0 nicht mehr unterstützt 
werden
Die nachfolgend aufgeführten Produkte werden nicht durch NI-DAQ 7.0 
unterstützt – also weder durch NI-DAQmx noch durch den herkömmlichen 
NI-DAQ-Treiber – und werden auch in zukünftigen Versionen von 
NI-DAQ nicht mehr enthalten sein. Zur Programmierung dieser Geräte ist 
NI-DAQ 6.9.x oder eine frühere Version erforderlich.

NI PXI-2566 und -2593-Switchmodule ✓ — ✓

Alle anderen PXI-Switchmodule — — ✓

NI PXI-4204 und -4220-Module ✓ — —

1 Diese Geräte werden durch NI-DAQmx unterstützt. Ausgenommen sind virtuelle Kanäle für Beschleunigungsmesser sowie 
virtuelle Kanäle für LCDTs und RVDTs.

Tabelle 3.  Von NI-DAQ 7.0 unterstützte Geräte (Fortsetzung)

Gerät NI-DAQmx
Traditioneller 

NI-DAQ NI-SWITCH 2.0
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• AT-MIO-16F-5 - Multifunktions-DAQ-Karten

• DAQCard-500, -516, -700, -1200 und -AO-2DC PCMCIA-Karten

• DAQPad-1200 und -MIO-16XE-50-Geräte für parallele Ports

• Lab-PC Familie der ISA und PC/XT MIO-Karten

• PC-516 16-Bit, 50 kS/s MIO-Karten

• PC-AO-2DC Low-Cost-AO- und Stromschleifen-DAQ-Geräte

• PC-LPM-16PnP MIO-Karten für den PC

• PC-OPDIO-16 optisch isolierte DIO-Karten für den PC

• PC-TIO-10 Timing- und DIO- Schnittstellen für den PC

• PCI-1200 12-Bit, 100 kS/s MIO-Karten

• SCXI-1200-12-Bit-DAQ- und Steuerungsmodule

• SCXI-2000 Chassis mit 4 Steckplätzen

• SCXI-2400 Module für serielle Schnittstelle

• VXI-DAQ-Module, VXI-SC-Carrier und -Module sowie VXI-TB 
Anschlussblöcke für den VXI-Bus
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ガイド
この文書では、NI-DAQ 7.0 ドライバソフトウェアおよびデータ集録

（DAQ）デバイスのインストール方法およびデバイスが適切に動作してい

るかを確認する方法について説明します。

この文書は、Macintosh オペレーティングシステム、Mac OS 用 NI-DAQ
には該当しません。 Macintosh 用の NI-DAQ を参照してください。
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表記規則

この文書では、以下の表記規則を採用しています。

→ →記号に沿って、入れ子のメニュー項目やダイアログボックスをたどって

いくと、最終的に必要な操作を実行することができます。ファイル→ペー

ジ設定→オプションという順になっている場合、まずファイルメニューを

プルダウンし、次にページ設定項目を選択して、最後のダイアログボック

スからオプションを選択します。

このアイコンは、ユーザへのアドバイスを表しています。

このアイコンは、注意すべき重要な情報があることを示しています。

このアイコンは、人体への損傷、データの損失、システムのクラッシュな

どを防止するための注意事項があることを示しています。

太字 太字のテキストは、メニュー項目やダイアログボックスなど、ソフトウェ

アでユーザが選択（クリック）する必要のある項目を表します。また、フ

ロントパネル上のパラメータ名、制御器やボタン、ダイアログボックスま

たはその一部、メニュー名、パレット名も表します。

下線 下線つきのテキストは、重要な事項を示します。

斜体 このフォントスタイルは変数を示します。または、ユーザが入力する必要

がある語または値のプレースホルダを示します。

monospace このフォントのテキストは、キーボードから入力する必要のあるテキスト

や文字、 コードの一部、プログラムサンプル、構文例を表します。また、

ディスクドライブ名、パス名、ディレクトリ名、プログラム名、サブプロ

グラム名、サブルーチン名、デバイス名、関数名、演算名、変数名、ファ
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イル名と拡張子、引用するコードにも使います。ただし、日本語の文字の

入力や表示は、前後の文と区別するため、「」で囲んでいる場合もあります。

monospace の斜体 このフォントの斜体のテキストは、ユーザが提供する必要のある言葉や値

のためのプレースホルダ（テキスト）を表します。

概要

図 1 は、NI-DAQ 7.0 および DAQ デバイスをインストールする手順と、

文書内の関連情報の掲載箇所を示します。
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図 1 インストールの概要

* デバイス信号と端子接続についての情報は、Measurement & Automation Explorer（MAX）のヘルプメニューの『従来型 NI-DAQ
用 Measurement & Automation Explorer ヘルプ』および『Measurement & Automation Explorer Help for NI-DAQmx』からオン
ラインで表示することができます。 さらに、デバイス信号接続およびその他の信号に関する情報については、Device Document 
Browser のデバイスのドキュメントから入手できます。 デバイスの文書の使い方については、「手順 10. デバイス文書を参照またはインス
トールする」を参照してください。
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NI-DAQ 7.0 ソフトウェア

ナショナルインスツルメンツの計測デバイスには、LabVIEW または

LabWindows™/CVI™などのアプリケーションソフトウェアから呼び出す

ことができる VI や関数の拡張ライブラリ、NI-DAQ ドライバソフトウェ

アが同梱されており、NI の計測デバイスの機能をすべてプログラムする

ことができます。 計測デバイスには、E- シリーズマルチファンクション

I/O（MIO）デバイス、SCXI 信号調節モジュール、およびスイッチモ

ジュールなどの DAQ デバイスが含まれます。 また、ドライバソフトウェ

アには、デバイスのアプリケーションを作成するための、VI、関数、クラ

ス、属性、およびプロパティのライブラリであるアプリケーションプログ

ラミングインタフェース（API）が含まれています。

NI-DAQ 7.0 には、NI-DAQ ドライバが 2 つ含まれており、それぞれのド

ライバには独自の API、ハードウェア構成、およびソフトウェア構成があ

ります。

• 従来型 NI-DAQ は、NI-DAQ の以前のバージョンがアップグレード

されたものです。 従来型 NI-DAQ には、NI-DAQmx と同じコン

ピュータで使用できるという点を除き、NI-DAQ 6.9.3 と同様に機能

する VI および関数が含まれています。

• NI-DAQmx は、計測デバイスのプログラムを作成するための新しい

VI、関数、および開発ツールを備えた最新の NI-DAQ ドライバです。 
NI-DAQmx は従来型 NI-DAQ と比べて有利な点があります。

– DAQ アシスタント有 LabVIEW、LabWindows/CVI、および

Measurement Studio でデバイスを制御する場合に使用する、

チャネルおよび計測タスクを構成するグラフィカルツールです。 
DAQ アシスタントを使用して、NI アプリケーションソフトウェ

アプログラムで使用するタスクの NI-DAQmx コードを生成する

こともできます。

– 高速化シングルポイントアナログ I/O およびマルチスレッドな

ど、パフォーマンス向上。

– NI-DAQ の以前のバージョンと比べて、わずかな関数と VI で
DAQ アプリケーションを作成できる、シンプルで直感的な

API。

– データ集録用プロパティノードや優れたアナログ I/O 用波形

データタイプサポートなど、機能拡張された LabVIEW 
NI-DAQmx API。

– ANSI C、LabWindows/CVI、Measurement Studio、および

ネイティブ .NET と C++ インターフェースに対して、同様の API
と機能性を提供。

NI-DAQmx 使用条件
NI-DAQmx は、以下の条件を満たす場合に使用できます。

• Windows を使用していること。
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• PCI または PXI E シリーズマルチファンクション DAQ デバイスとサ

ポートされている SCXI または SCC モジュールの両方または片方を

使用していること。

• NI-DAQmx の使用には、LabVIEW、LabWindows/CVI、または

Measurement Studio などの NI アプリケーションソフトウェアを

使用する場合、それらのソフトウェアの 7.0 またはそれ以降のバー

ジョンが必要です。

メモ Measurement Studio .NET 言語のいずれかを使用する場合は、NI-DAQmx を

使用する必要があります。

従来型 NI-DAQ の使用が必要な場合
以下の状況のうち、1 つでも該当する場合は、従来型 NI-DAQ をインス

トールして使用する必要があります。

• AT E シリーズマルチファンクション DAQ デバイス、デジタル I/O
（DIO）デバイス、およびダイナミック信号集録デバイスなど、

NI-DAQmx でサポートされていないデバイスを使用している。

• SCXI-1530、SCXI-1531、または SCXI-1540 デバイスを、加速度計、

線形電圧差動変圧器（LVDT）、または可変差動変圧器（RVDT）仮想

チャネルなど、NI-DAQmx でサポートされていない機器と一緒に使

用している。

• LabVIEW Real-Time（RT）モジュールを使用している。

• NI-DAQ 6.9.x からアップグレードして、今すぐに既存アプリケー

ションを NI-DAQmx に移植しない。

• 7.0 より前のバージョンの LabVIEW、LabWindows/CVI、または

Measurement Studio を使用している。

• Visual Basic 6.0 を使用している。

メモ NI-DAQ 7.0 の従来型 NI-DAQ でサポートされている NI アプリケーションソフ

トウェアで最も古いバージョンは 6.0 です。 LabVIEW、LabWindows/CVI、ま

たは Measurement Studio 6.x は NI-DAQ 7.0 から従来型 NI-DAQ を使用でき

ます。

従来型 NI-DAQ でサポートが廃止されたもの
下記の項目は、NI-DAQ 6.9.3 でサポートされ、従来型 NI-DAQ でサポー

トが廃止されたものです。

• NI LabVIEW、LabWindows/CVI、または Measurement Studio
アプリケーションソフトウェアでバージョンが 6.0 より前のもの

• Windows 95

• 1200 シリーズマルチファンクション DAQ デバイス、VXI DAQ デバ

イス、またはリモート SCXI デバイスなどの以前のデバイス
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サポートの有無を示す項目リストについては、この文書の最後にある 
「オペレーティングシステム、アプリケーションソフトウェア、プログラ

ミング言語、および NI-DAQ 7.0 デバイスサポート」セクションを参照し

てください。

NI-DAQ のシステムの適合性
図 2 はこの計測システムの概要で、実際の物理現象がどのような流れで

計測アプリケーションに取り入れられるかを示しています。
 

図 2 計測システムの概要
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コンピュータは計測デバイスから生データを受け取ります。 信号調節デバ

イスは、センサーとトランスデューサを使用して、物理現象を計測デバイ

スがデータを扱えるような電気信号に調節します。 ソフトウェアは生デー

タを取得し、人間が理解できる形式で表してデータを処理するため、レ

ポートをグラフ、チャート、ファイルの形式で表示することができます。 
また、ソフトウェアは計測システムを制御し、いつ、どのチャネルから

データを集録または出力するかを計測デバイスに伝えます。

NI の計測デバイスおよびアプリケーションソフトウェアには、データの

構成、集録、出力、NI の計測デバイスへのデータの送信といった NI の計

測デバイスの機能をすべてプログラムするための NI-DAQ ドライバソフ

トウェアが梱包されています。 NI-DAQ を使用すると、それらのプログラ

ムを作成する必要はありません。 LabVIEW のようなアプリケーションソ

フトウェアは、たとえば熱電対値を読み取って返すようなコマンドをドラ

イバへ送信し、集録されたデータの表示や解析をします。

NI-DAQ ドライバは、LabVIEW または ANSI C インタフェースを介した

ダイナミックリンクライブラリ（DLL）の呼び出しをサポートするプログ

ラミング環境から使用できます。 図 2 のように、プログラミング環境に関

係なく、DAQ アプリケーションは NI-DAQ を使用します。

手順 1. アプリケーションソフトウェアの正しいバー
ジョンがインストールされたことを確認する

LabVIEW、LabWindows/CVI、および Measurement Studio を含む

NI アプリケーションソフトウェアを使用する場合は、それらをインス

トールします。 NI-DAQmx を使用する場合は、NI アプリケーションソフ

トウェアの 7.0 またはそれ以降のバージョンを使用する必要があります。 
従来型 NI-DAQ を使用する場合は、NI アプリケーションソフトウェアの

6.0 またはそれ以降のバージョンを使用する必要があります。 この文書の

最後にある「オペレーティングシステム、アプリケーションソフトウェ

ア、プログラミング言語、および NI-DAQ 7.0 デバイスサポート」セク

ションを参照してください。

ヒント アプリケーションソフトウェアまたは NI-DAQ の旧バージョンで作成されたア

プリケーションが存在する場合、そのアプリケーションのバックアップコピー

を作成します。 このようにすれば、ソフトウェアをアップグレードして、そのア

プリケーションを修正することができます。 従来型 NI-DAQ API により変更され

ていない元のアプリケーションを使用する場合には、そのバックアップコピー

を使用することができます。
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手順 2. NI-DAQ をアンインストールする（旧バージョ
ンからアップグレードする場合）

旧バージョンから NI-DAQ 7.0 をアップグレードする場合、現在のバー

ジョンをインストールする前に NI-DAQ の旧バージョンをアンインス

トールします。 コントロールパネル→プログラムの追加と削除を使用しま

す。 各オペレーティングシステムのアンインストールについての説明は、

ni.com/support/installを参照してください。

手順 3. NI-DAQ 7.0 ソフトウェアをインストールする

CD を挿入する

NI-DAQ 7.0 のインストーラが自動的に起動します。 起動しない場合は、

スタート→ファイル名を指定して実行を選択します。 x:¥setup.exeを入

力します。ここで、xは CD ドライブの文字を示します。 トラブルシュー

ティングと各オペレーティングシステムの説明については、

ni.com/support/installから Hardware Installation Wizard を参照

してください。

注意 既存のアプリケーションがサポートされていないコンポーネントを含む場合、

NI-DAQ 7.0 をインストールしないでください。 ソフトウェアをインストールす

る前に、NI-DAQ 7.0 の CD に含まれている『NI-DAQ 7.0 Readme』ファイル

またはこの文書の最後にある「オペレーティングシステム、アプリケーション

ソフトウェア、プログラミング言語、および NI-DAQ 7.0 デバイスサポート」

セクションを参照してください。

ヒント 新しいデバイスをインストールする前にドライバソフトウェアをインストール

してください。これをインストールしないと、Windows はデバイスを検出しな

い可能性があり、ドライバのインストールを促す警告が表示されることがあり

ます。
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インストールする API を選択する

注意 NI-DAQ 7.0 は、NI-DAQ の旧バージョンと同じシステムに共存させることがで

きません。 NI-DAQ 7.0 のインストール時に、NI-DAQ 6.9.x およびその旧バー

ジョンとそれによってインストールされたサポートファイルは、従来型

NI-DAQ によって置き換えられます。 NI-DAQmx のインストール時に、旧バー

ジョンの NI-DAQ は削除されます。

NI-DAQ 7.0 は、複数のドライバおよびその API（従来型 NI-DAQ、

NI-DAQmx、および NI-SWITCH）を含みます。 使用するデバイスによっ

て、ドライバのいずれかまたはすべてをインストールすることができま

す。 従来型 NI-DAQ および NI-DAQmx の説明については、この文書の最

初にある「NI-DAQ 7.0 ソフトウェア」のセクションを参照してください。 

NI スイッチモジュールをプログラムするには、NI-SWITCH をインストー

ルして使用します。 NI-SWITCH は、NI のスイッチモジュールのすべてを

サポートする IVI 準拠のスイッチ計測器ドライバです。 NI-SWITCH には、

スイッチアプリケーションのテストとトラブルシューティング用の対話式

ソフトフロントパネルがあります。 NI-SWITCH 2.0 には NI-DAQmx およ

び NI-VISA 3.0 のインストールが必要です。

サポートファイルをインストールする
NI-DAQ 7.0 インストーラはシステムにインストールされている NI ソフ

トウェアを検出し、CD から自動的に最新のドライバ、アプリケーション

ソフトウェア、および言語サポートファイルをインストールします。
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1. インストーラが正しいサポートファイル、アプリケーションソフト

ウェアや言語の正しいバージョンを検出して選択したかどうかを確認

します。 上の図のように、機能サブコンポーネントのリストを表示す

るには、機能のリストの頭に表示されている＋記号をダブルクリック

します。 サポートファイル、サンプル、および文書をインストールす

るための追加オプションを選択できます。 ソフトウェアの指示に従い

ます。

メモ NI-DAQ 7.0 をインストールしてから NI アプリケーションソフトウェアのバー

ジョン 7.0 をインストールする場合には、NI-DAQ 7.0 インストーラをもう一度

実行して正しいアプリケーションソフトウェアサポートをインストールする必

要があります。

2. 終了をクリックします。

3. インストールが完了したら、今再起動するかどうかを尋ねるメッセー

ジが表示されます。 いいえをクリックして、コンピュータをシャット

ダウンします。

RT シリーズ製品をインストールする必要がある場合、RT シリーズ製

品のセットアップ手順について、ni.com/support/installから

Hardware Intallation Wizard を参照してください。

4. コンピュータまたは PXI シャーシの電源を切り、コードを抜きます。

手順 4. デバイス、アクセサリ、およびケーブルの梱包
を解く

ご使用のデバイスは、静電気による損傷（ESD、静電破壊）を防ぐため、

静電防止の梱包で出荷されます。 これは、静電破壊によってデバイスの部

品が損傷を受けるおそれがあるためです。

注意 露出しているコネクタピンには絶対に触れないでください。

このような損傷を回避するには、以下の予防措置を講じてください。

• 接地ストラップを使用したり、接地された物体に触れたりして、身体

を接地する。

• 静電防止の梱包をシャーシの金属部分に接触させてから、デバイスを

梱包箱から取り出す。

デバイスを箱から取り出し、部品がゆるんでいないかどうか、また、損傷

箇所がないかどうか調べてください。 デバイスが損傷している場合は、ナ

ショナルインスツルメンツまでご連絡ください。 コンピュータ、PXI
シャーシ、または SCXI シャーシに損傷したデバイスをインストールしな

いでください。
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デバイスを使用しないときは、静電防止の梱包に保管してください。

保安と準拠については、デバイスのマニュアルの「手順 10. デバイス文書

を参照またはインストールする」を参照してください。

手順 5. デバイス、アクセサリ、およびケーブルの梱包
をインストールする

複数の DAQ デバイスをインストールする場合には、それらのデバイスを

すべてここでインストールしてください。 スロットの必要条件など、デバ

イスのハードウェアの詳細については、「手順 10. デバイス文書を参照ま

たはインストールする」に記述されているデバイスの文書を参照してくだ

さい。

DAQ デバイスに接続されるスイッチまたは SCXI 信号調節モジュールが

システムに含まれる場合はまず、この文書を参照して DAQ コンポーネン

トをインストールします。

メモ 以下の説明は、RT シリーズの製品には該当しません。 RT シリーズの製品のセッ

トアップ手順については、ni.com/support/installから Hardware 
Installation Wizard を参照してください。

PCI デバイス

注意 コンピュータの電源がオフであることを確認してください。 適切な静電破壊防止

対策により身体が接地されていることを必ず確認してから、ハードウェアを取

り付けてください。

 PCI デバイスをインストールするには、以下の手順に従ってください。

1. コンピュータと拡張スロットのカバーを外します。

2. 静電気を放電するため、コンピュータの金属部分に接触します。

3. PCI システムスロットにデバイスを挿入します。 やさしくゆするよう

にしてデバイスをスロットに差し込みます。 デバイスをスロットへ無

理に押し込まないでください。
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4. デバイスの取り付け金具をコンピュータのバックパネルレールに取り

付けます。

5. コンピュータのカバーを元の位置に戻します。

これで、PCI デバイスがインストールされました。

PXI デバイス

注意 PXI シャーシの電源がオフであることを確認してください。 適切な静電破壊防止

対策により身体が接地されていることを必ず確認してから、ハードウェアを取

り付けてください。

PXI モジュールをインストールするには、以下の手順に従ってください。

1. 未使用の PXI スロットのカバーパネルを外します。 スロットの必要条

件については、下記のデバイスのマニュアルを参照してください。

「手順 10. デバイス文書を参照またはインストールする」。

2. 静電気を放電するため、シャーシの金属部分に触れます。

3. PXI システムスロットにデバイスを挿入します。 デバイスを完全に挿

入するには、脱着ハンドルを使用します。

4. シャーシのフロントパネル取り付けレールに、デバイスのフロントパ

ネルをネジで取り付けます。

1 PCI DAQ ボード

2 PCI システムスロット

3 PCI コンピュータ
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これで、PXI デバイスがインストールされました。

PCMCIA デバイス
NI PCMCIA デバイスは、Type II の PC カードの空きスロット（任意）に

インストールすることができます。 PCMCIA デバイスをインストールす

るには、以下の手順に従ってください。

注意 コンピュータの電源がオフであることを確認してください。 PCMCIA スロット

がホットスワップをサポートしている場合、コンピュータの電源はオンでもか

まいません。 適切な静電破壊防止対策により身体が接地されていることを必ず確

認してから、ハードウェアを取り付けてください。

1. コンピュータの PCMCIA スロットカバーを外します（該当する場

合）。

2. コネクタがしっかりと接続されるまで、PCMCIA デバイスの

PCMCIA バスコネクタをスロットに挿入します。 NI PCMCIA デバイ

スには、一端には 68 ピンの PCMCIA バスコネクタ、もう一端には

I/O コネクタの 2 つのコネクタがあります。 PCMCIA デバイスは、

一方向にしか挿入できないよう保護されています。

3. I/O ケーブルを取り付けます。 ケーブルコネクタの挿入や取り外しで

は、I/O ケーブルに負担をかけないように注意してください。 常に、

挿入するまたは外すケーブルのコネクタの部分をしっかりとつかんで

ください。 PCMCIA デバイスから I/O ケーブルを絶対に直接引き抜

かないでください。

1 PXI シャーシ

2 PXI モジュール

3 脱着ハンドルが下を向いた状態
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これで、PCMCIA デバイスがインストールされました。

USB/IEEE 1394 デバイス

注意 適切な静電破壊防止対策により身体が接地されていることを必ず確認してから、

ハードウェアを取り付けてください。

メモ BP-1 バッテリーパックを使用している場合は、この文書の手順 1 ではなく、

BP-1 のインストールガイドにあるインストール手順に従ってください。 BP-1
バッテリーパックを使用していない場合の手順を以下に記します。

USB または 1394 用の NI デバイスをインストールするには、以下の手順

に従ってください。

1. USB または 1394 用の NI デバイスの中には外部電源が必要なデバイ

スもあります。

• デバイスに外部電源がある場合、外部電源の電圧（該当する場

合）がユーザがデバイスを使用する場所の電圧（120/230 VAC）

とデバイスに必要な電圧に一致するかどうかを確認してくださ

い。 電源の片方をコンセントに接続し、もう片方をデバイスの後

部に取り付けます。

1 PCMCIA コンピュータ

2 PCMCIA ソケット

3 I/O ケーブル

4 アクセサリ

5 I/O 信号
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• デバイスに電源コードがある場合は、電源コードの片方をデバイ

スに接続し、もう片方をコンセントに接続します。

2. コンピュータの USB または 1394 ポート、その他のハブ、または

1394 デバイスから、デバイス上の使用可能な USB または 1394 ポー

トにケーブルを接続します。 取り付けネジを締めて接続を固定します

（該当する場合）。 デバイスの USB/IEEE 1394 ポートに USB/1394 ケー

ブルのもう片方を接続します。 USB ケーブルとそのコネクタを以下に

示します。

これで、USB/IEEE 1394 デバイスがインストールされました。 USB または

IEEE 1394 デバイスの後部パネルに電源スイッチがある場合、デバイスの

電源を入れます。

アクセサリ
インストールガイドの手順に従って、アクセサリ、ターミナルブロック、

および / または SCC モジュールを取り付けます。 SCXI については、「手

順 12. センサーと信号を取り付ける」の前までは、この文書の手順に従っ

てください。

手順 6. コンピュータまたは PXI シャーシに電源を入れる

Windows は、ハードウェアのインストール後に初めてコンピュータが再

起動されたときに、新しくインストールされたデバイスを認識します。 一
部の Windows システムでは、インストールされたすべての NI デバイス

に対して、新しいハードウェアの検索ウィザードが起動します。 デフォル

トにより、デバイスに最適なドライバを検索する（推奨）が選択されま

す。 Windows がデバイスを認識するように、次へまたははいをクリック

して各デバイスのソフトウェアをインストールします。

コンピュータが USB/IEEE 1394 デバイスを認識すると、デバイスの状態

に応じて電源 LED が点滅または点灯します。 また、IEEE 1394 用 NI デバ

イスには、デバイスが検出されると点滅する COM LED があります。 LED
の点灯点滅パターンの説明については、デバイスの文書の「手順 10. デバ

イス文書を参照またはインストールする」を参照してください。

1 コンピュータ /USB ハブのコネクタ 2 デバイスのコネクタ
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手順 7. Measurement & Automation Explorer
（MAX）を起動する

デスクトップにある Measurement & Automation アイコンをダブルク

リックして、MAX を開きます。

手順 8. デバイスが認識されたことを確認する

1. デバイスとインタフェースを展開します。

2. デバイスとインタフェースの下に表示されるデバイスを確認します。

従来型 NI-DAQ および NI-DAQmx の両方でデバイスがサポートされ

ていて、両方ともインストールされている場合は、同じデバイスは

「デバイスとインタフェース」の従来型 NI-DAQ デバイスフォルダお

よび NI-DAQmx フォルダの下で別々に表示されます。 デバイスが表

示されない場合には、<F5> を押して MAX の表示を更新します。そ

れでもデバイスが認識されないときは、ni.com/support/install
のトラブルシューティングを参照してください。

3. デバイスをプログラムするために使用する NI-DAQ API のフォルダの

下で、テストするデバイスを右クリックします。

• デバイスが従来型 NI-DAQ デバイスに表示される場合、

Properties を選択して、プロパティウィンドウに表示される

Test Resources をクリックします。

• デバイスが NI-DAQmx に表示される場合は、Self-Test を選択し

ます。
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4. セルフテストが終了すると、エラーが発生したかどうかを示すメッ

セージが表示されます。 エラーが発生した場合、トラブルシューティ

ングに関する情報については、ni.com/support/jaを参照してくだ

さい。

手順 9. デバイス設定を構成する

インストールする各デバイスを構成します。 従来型 NI-DAQ と

NI-DAQmx の両方でデバイスを使用するには、それぞれの API でデバイ

スのプロパティを構成する必要があります。

1. デバイス名を右クリックして Properties を選択します。 デバイスを

使用する NI-DAQ API フォルダの下のデバイス名を必ずクリックして

ください。

2. デバイスプロパティを構成します。

• アクセサリを使用している場合、アクセサリについての情報を追

加します。

• 従来型 NI-DAQ でデバイスを使用している場合、AI、AO、

OPC、またはリモートアクセスのデフォルト設定を変更できま

す。 デバイスのデフォルト設定についての詳細は、デバイス文書

を参照してください。

3. OK をクリックして変更を承諾します。

ヒント 従来型 NI-DAQ と NI-DAQmx の両方でサポートされているデバイスについて

は、Traditional NI-DAQ to NI-DAQmx Configuration Converter Wizard で従

来型 NI-DAQ の仮想チャネルおよびスケール構成を変換することができます。 ま
た、ウィザードは SCXI とアクセサリの構成を変換しますが、SCC 構成は変換

しません。 SCC を使用する場合、各 API で別々に SCC の情報を構成する必要
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があります。 使用方法については、『Measurement & Automation Explorer 
Help for NI-DAQmx』にある「Converting Traditional NI-DAQ 
Configurations to NI-DAQmx Configurations」のセクションを参照してくだ

さい。

手順 10. デバイス文書を参照またはインストールする

NI-DAQ 7.0 ソフトウェアには、サポートされる DAQ、SCXI、およびス

イッチデバイスのオンライン文書を含む Device Documentation CD が

含まれています。 デバイス文書には、デバイスの端子、機能、および操作

を説明するヘルプファイル、およびデバイス文書の PDF ファイルが含ま

れています。 また、Device Document Browser を使用して、各デバイ

スの文書を検索、表示、印刷することができます。

NI-DAQ 7.0 Device Documentation CDを挿入するとNI-DAQ Device 
Document Browser を自由に使用することができます。 NI-DAQ 7.0 
document browser には以下のオプションがあります。

• Browse Device Documents によりドキュメントブラウザが開か

れ、各デバイスのデバイス文書が表示されます。

• Install Device Documents によりドキュメントブラウザとすべての

デバイス文書がハードドライブにコピーされます。 ドキュメントブラ

ウザをインストールすると、デバイスの文書はスタート→プログラ

ム→ National Instruments → NI-DAQ → Browse Device 
Documentation から表示できます。

ブラウザが自動的に開かない場合には、スタート→ファイル名を指定して

実行を選択して、x:¥autorun.exeを選択します。ここで、xは CD ド

ライブの文字を表します。

メモ ヘルプシステムおよび Device Document Browser を含む NI-DAQ 7.0 の文書

の機能には、Internet Explorer 5.0 またはそれ以降のバージョンのインストール

が必要なものもあります。

手順 11. SCXI またはスイッチモジュールをインストー
ルする（該当する場合）

DAQ デバイスに接続する SCXI 信号調節モジュールまたはスイッチモ

ジュールがシステムに含まれる場合、SCXI とスイッチハードウェアのイ

ンストールおよび構成には、『SCXI クイックスタートガイド』および

『NI Switches Getting Started Guide』を参照してください。

この文書の手順 12 以降は、DAQ デバイスをターミナルブロックまたは

SCC アクセサリと一緒に使用する場合のみに該当します。
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手順 12. センサーと信号を取り付ける

センサーと信号をデバイスまたはアクセサリ端子に配線します。

以下の文書には、役に立つ情報が記載されています。

• 信号および端子の接続：

– 『E Series Help』、デバイスのユーザマニュアル、およびアクセ

サリの文書（PDF）は Device Document Browser から参照す

ることができます。

– ピンの並び順については、MAX のヘルプメニューから表示でき

る『従来型 NI-DAQ 7.0 用 Measurement & Automation 
Explorer ヘルプ』および『Measurement & Automation 
Explorer Help for NI-DAQmx』に記載されています。

• スイッチの仕様にはデバイスのトポロジーが含まれています。

• センサの使用：

– LabVIEW を使用する場合は、LabVIEW に同梱されている

『LabVIEW Measurements Manual』または ni.com/jp/
manualsを参照してください。

– 他のプログラミング環境と NI-DAQmx を使用する場合には、

スタート→プログラム→ National Instruments →

NI-DAQ → NI-DAQmx Help から表示できる『NI-DAQmx 
Help』の「Sensors」のトピックを参照してください。

– 他のプログラミング環境と従来型 NI-DAQ を使用する場合には、

スタート→プログラム→ National Instruments → NI-DAQ →

Traditional NI-DAQ User Manual から表示できる

『Traditional NI-DAQ User Manual』の第 5 章、「Transducer 
Conversion Functions」を参照してください。

手順 13. テストパネルを実行する

多くのデバイスには、信号の集録や生成などの特定のデバイス機能をテス

トするためのテストパネルがあります。

1. テストパネルの操作については、MAX ヘルプを参照してください。

a. MAX で、ヘルプ→ヘルプトピックを選択し、NI-DAQmx と従

来型 NI-DAQ のうち、テストを行う方を選択します。 MAX ヘル

プが起動します。

b. 目次タブで、Measurement & Automation Explorer → MAX
（テストを行う NI-DAQ のバージョン）のブックアイコンを展開

して、Getting Started → DAQ Devices → Testing DAQ 
Devices を選択します。

c. テストパネルを操作するために参照するヘルプトピックを開くに

は、 Testing DAQ Devices をクリックします。
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d. ヘルプウィンドウを縮小して右にドラッグすると、MAX 構成

ウィンドウが表示されます。

2. アクティブウィンドウにするには、MAX をクリックします。

3. 従来型 NI-DAQ デバイスまたは NI-DAQmx デバイスの下で、テスト

するデバイスを右クリックします。

4. 選択されたデバイスのテストパネルを開くには、 テストパネル

（NI-DAQmx では Test Panels）を選択します。

テストパネルの例を以下の図に示します。
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5. デバイスのさまざまな機能をテストするには、タブをクリックしま

す。 従来型 NI-DAQ および NI-DAQmx でのテストパネルの操作方法

については、MAX ヘルプウィンドウをクリックしてください。

6. テストパネルはエラーが発生したかどうかを示すメッセージを表示し

ます。 トラブルシューティングの情報については、 『NI-DAQmx 
Reference Help』または ni.com/support/jaを参照してくださ

い。

7. テストが終了したら、Close または OK をクリックして、テストパ

ネルを終了します。

手順 14. 追加の新しいデバイスを構成する

複数の DAQ デバイスをインストールする場合、各デバイスごとに手順

9 ～ 13 を繰り返します。

手順 15. チャネルの構成とタスクの設定

物理チャネルとは、アナログ / デジタル信号を計測または生成できる端子

またはピンのことです。 これに対して、仮想チャネルとは、名前、物理

チャネル、入力端子接続、計測または生成のタイプ、およびスケール情報

を含む設定を集めたものです。 従来型 NI-DAQ とそれ以前のバージョンで

は、仮想チャネルの構成は、どのチャネルがどの計測に使用されているか

を登録するオプション機能です。 NI-DAQmx では、仮想チャネルはすべ

ての計測に不可欠です。

従来型 NI-DAQ では、MAX を使用して仮想チャネルを構成しますが、

NI-DAQmx では、DAQ アシスタントで仮想チャネルを構成することが

できます。この DAQ アシスタントは、MAX やアプリケーションソフト

ウェアから開くことができます。 また、アプリケーションプログラムで、

NI-DAQmx API を使用して仮想チャネルを構成することもできます。

タスクとは、NI-DAQmx の新しい重要な概念で、タイミング、トリガ、

その他のプロパティを備えた単一または複数の仮想チャネルを集めたもの

です。 概念としては、タスクは実行する計測または生成を意味していま

す。 タスク内の構成情報はすべて設定または保存して、アプリケーション

で使用することができます。

NI-DAQmx では、仮想チャネルをタスクの一部として、またはタスクか

ら切り離して構成できます。 タスク内に作成した仮想チャネルは、ローカ

ルチャネルです。 タスク外に定義した仮想チャネルは、グローバルチャネ

ルです。 グローバルチャネルを MAX 内あるいはアプリケーションソフト

ウェア内に作成することができます。 グローバルチャネルは、どのアプリ

ケーションでも使用することができます。あるいは、さまざまなタスクに

それらを追加することもできます。 グローバルチャネルを変更した場合
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は、その変更がそのグローバルチャネルに関連するすべてのタスクに影響

を及ぼします。 通常、ローカルチャネルを使用するほうが簡単です。

NI-DAQmx でタスクを設定する
NI-DAQmx を使用する場合は、DAQ アシスタントでタスクを構成しま

す。 DAQ アシスタントでタスクおよびチャネルを作成するには、NI アプ

リケーションソフトウェアパッケージのバージョン 7.0 を必ず使用してく

ださい。

• MAX でデータ設定を右クリックして、新規作成を選択します。 新規

作成ウィンドウで NI-DAQmx Task を選択して、次へをクリックし

ます。

• また、NI アプリケーションソフトウェア内から直接 DAQ アシスタ

ントを開くこともできます。

– LabVIEW では、さまざまな方法で DAQ アシスタントを開くこ

とができます。

• 『LabVIEW 入門』の説明に従って、DAQ アシスタント 
Express VI を Express 入力パレットから取り出します。

• DAQmx タスク名制御器を使用して DAQ アシスタントを開

くこともできます。 制御器を右クリックして、新規タスク

（DAQ アシスタント ) を選択します。 「Taking an 
NI-DAQmx Measurement in LabVIEW」ヘルプチュート

リアルには、DAQmx タスク名制御器でタスクを作成する

方法およびタスクのためのコードを生成する方法について段

階的に説明してあります。 LabVIEW では、ヘルプ→ Taking 
an NI-DAQmx Measurement を選択してチュートリアル

を開きます。

– LabWindows/CVI では、Tools → Create/Edit DAQmx Tasks
を選択します。

– Measurement Studio では、Visual Studio.NET を開き、

Project → Add New Item を選択して Add New Item ダイアロ

グボックスを開きます。 Categories ぺーンで、Measurement 
Studio → Assistants を選択します。 Templates ぺーンでは、

DAQmx Task Class を選択します。
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DAQ アシスタントが開きます。

新しいタスクを作成するには、オンラインの説明に従ってください。

1. アナログ入力などの I/O タイプを選択します。

2. 実行する計測または生成を選択します。

3. 使用するセンサーを選択します（該当する場合）。

4. チャネルを選択して、タスクを追加します。 グローバルチャネルをタ

スクに追加するか、タスク内のローカルチャネルを作成する物理チャ

ネルを選択します。

5. 必要に応じて、その計測に適した設定、タイミング、およびトリガを

設定します。

6. タスクを保存します。

• LabVIEW または LabWindows/CVI から DAQ アシスタントを

開き、OK をクリックします。

• Measurement Studio から DAQ アシスタントを開いた場合は、

File → Save を選択します。

• MAX から DAQ アシスタントを開く場合、Save Task をクリッ

クします。

これで、アプリケーションでタスクを使用することができます。 タスクや

コード生成についての詳細は、『DAQ Assistant Help』 を参照するか、ア

プリケーションソフトウェアのマニュアルを参照してください。
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NI-DAQmx のグローバルチャネルを構成する
NI-DAQmx を使用する場合は、DAQ アシスタントでグローバルチャネ

ルを構成します。

• MAX でデータ設定を右クリックして、新規作成を選択します。 新規

作成ウィンドウで、NI-DAQmx Global Channel を選択して、次へ

をクリックします。

• DAQ アシスタントは、LabVIEW 7.0、LabWindows/CVI 7.0、また

は Measurement Studio 7.0 内から直接開くこともできます。

– LabVIEW では、DAQmx Global Channel 制御器を使用して

DAQ アシスタントを開いてください。 制御器を右クリックして、

新規チャネル（DAQ アシスタント）を選択します。

– 前記のように、LabWindows/CVI または Measurement 
Studio では、最初にタスクを必ず作成してください。 DAQ アシ

スタントでは、Add Existing DAQmx Global Channels をク

リックして、タスクにグローバルチャネルを追加します。

DAQ アシスタントが開きます。 新しいグローバルチャネルを作成するに

は、オンラインの説明に従ってください。

1. アナログ入力などの I/O タイプを選択します。

2. 実行する計測または生成を選択します。

3. 使用するセンサーを選択します（該当する場合）。

4. 使用する物理チャネルを選択します。

5. その計測に適した設定を構成します。

6. タスクを保存します。

• LabVIEW または LabWindows/CVI から DAQ アシスタントを

開いて、OK をクリックします。

• Measurement Studio から DAQ アシスタントを開いた場合は、

File → Save を選択します。

• MAX から DAQ アシスタントを開いた場合には、Save 
Channel をクリックします。

これで、アプリケーションでのグローバルチャネルの使用およびグローバ

ルチャネルのタスクへの追加が可能になりました。 チャネルやコード生成

についての詳細は、『DAQ アシスタント ヘルプ』を参照するか、アプリ

ケーションソフトウェアのマニュアルを参照してください。

従来型 NI-DAQ の仮想チャネルを構成する
従来型 NI-DAQ を使用するときは、MAX で仮想チャネルを構成します。

1. MAX でデータ設定を右クリックして、新規作成を選択します。

2. 新規作成ウィンドウで従来型 NI-DAQ の仮想チャネルを選択し、

終了をクリックします。 新規作成ウィザードが開きます。
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3. 新規作成ウィザードの説明に従って、新しいチャネルを作成します。 
さまざまなチャネルタイプの構成についての詳細は、『従来型

NI-DAQ Measurement & Automation Explorer ヘルプ』を参照し

てください。

アプリケーション開発を開始する

サンプル
各 API にはプログラミングサンプルを集めたものが含まれており、アプ

リケーション開発を手がける際に役立ちます。 サンプルのコードは、変更

したり、アプリケーションに保存したりすることができます。 サンプルを

使用すると、新しいアプリケーションを開発したり、サンプルのコードを

既存のアプリケーションに加えたりすることができます。

LabVIEW および LabWindows/CVI のサンプルを見つけるには、NI サ
ンプルファインダを開いてください。

• LabVIEW では、ヘルプ→サンプルの検索を選択します。

• LabWindows/CVI では、Help → NI Example Finder を選択します。

Measurement Studio、Visual Basic および ANSI C のサンプルは、以

下のディレクトリにあります。

• Measurement Studio でサポートされる言語の NI-DAQmx のサン

プルは、以下のディレクトリにあります。

– MeasurementStudio¥VCNET¥Examples¥DAQmx

– MeasurementStudio¥DotNET¥Examples¥DAQmx



© National Instruments Corporation 133 DAQ クイックスタートガイド

• Visual Basic 用の従来型 NI-DAQ サンプルは、以下のディレクトリ

にあります。

– NI-DAQ¥Examples¥Visual Basic with Measurement　
Studioディレクトリには、Measurement Studio と併用する

ActiveX コントロールのサンプルへのリンクがあります。

– NI-DAQ¥Examples¥VBasicディレクトリには、

Measurement Studio に関連付けられていないサンプルがあり

ます。

• ANSI C 用 NI-DAQmx サンプルは、NI-DAQ¥Examples¥DAQmx 
ANSI C ディレクトリにあります。

• ANSI C 用従来型 NI-DAQ サンプルは、NI-DAQ¥Examples¥VisualC
ディレクトリにあります。

その他のサンプルについては、ni.com/zoneを参照してください。

計測アプリケーションとデバイスの情報
各アプリケーションソフトウェアのパッケージおよびドライバには、計測

および計測デバイス制御用アプリケーションの構築についての情報が含ま

れています。 以下のリファレンス文書では、NI-DAQ 7.0、NI アプリケー

ションソフトウェアのバージョン 7.0（該当する場合）を使用しているこ

とを想定して記載されています。

LabVIEW
はじめて LabVIEW をご使用になる場合には、『LabVIEW 入門』をお読

みになり、LabVIEW の基本操作を習得してください。 スタート→プログ

ラム→ National Instruments → LabVIEW → LabVIEW ドキュメントラ

イブラリを表示を選択します。

『LabVIEW Measurements Manual』には従来型 NI-DAQ および

NI-DAQmx の API 概論が記載されており、計測の概念が説明されていま

す。 スタート→プログラム→ National Instruments → LabVIEW →

LabVIEW ドキュメントライブラリを表示を選択します。

『Taking an NI-DAQmx Measurement in LabVIEW』ヘルプのチュート

リアルでは、LabVIEW での計測をセットアップする方法が段階ごとに説

明されています。また、新しい重要な特徴や概念の説明も記載してありま

す。 ヘルプ→ Taking an NI-DAQmx Measurement を選択してチュート

リアルを開きます。

『LabVIEW 従来型 NI-DAQ VI リファレンスヘルプ』および『LabVIEW 
NI-DAQmx VI Reference Help』には、LabVIEW VI およびプロパティ

についての説明があります。 LabVIEW では、ヘルプを選択し、ご使用の

NI-DAQ API の LabVIEW VI のリファレンスヘルプを選択します。
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LabWindows/CVI
『LabWindows/CVI Help』のデータ集録ライブラリには、従来型

NI-DAQ および NI-DAQmx の API の概要、計測の概念、関数のリファレ

ンスが含まれます。 LabWindows/CVI では、Help → Contents を選択

します。

Measurement Studio
『NI Measurement Studio Help』には、NI-DAQmx API の概念、計測タ

スクおよび概念、関数リファレンスについてが記載されています。 このヘ

ルプファイルは Visual Studio .NET のマニュアルに統合されています。 
Visual Studio .NET では、Help → Contents を選択します。

『Measurement Studio Reference』には、従来型 NI-DAQ API の概要

や、計測の概念、関数リファレンスが記載されています。 Visual Studio 
.NET では、Measurement Studio → Measurement Studio Reference
を選択します。

ANSI C - NI アプリケーションソフトウェア不使用
『Traditional NI-DAQ User Manual 』および『NI-DAQmx Help』には、

API の概念についての説明が記載されています。 『NI-DAQmx Help』に

も、計測の概念についての一般情報が記載されています。 『Traditional 
NI-DAQ C Reference Help』および『NI-DAQmx C Reference Help』

には、C 関数と属性についての説明が記載されています。 スタート→プロ

グラム→ National Instruments → NI-DAQ を選択して、使用している

NI-DAQ API 用のマニュアルのタイトルを選択します。

.NET 言語 - NI アプリケーションソフトウェア不使用
『NI Measurement Studio Help』には、NI-DAQmx API の概念、計測タ

スクおよび概念、関数リファレンスについて記載されています。 このヘル

プファイルは Visual Studio .NET のマニュアルに統合されています。 
Visual Studio .NET では、Help → Contents を選択します。

メモ Visual Studio .NET を使わずに .NET 言語を使用する場合は、

『NI Measurement Studio Help』を表示できない可能性があります。

デバイスの文書
NI-DAQ 7.0 には Device Document Browser があり、サポートのある

DAQ、SCXI やスイッチデバイスのオンライン文書（デバイスのピンの並

び順、特性、操作を説明したヘルプファイル、デバイスのドキュメント

（PDF）など）が含まれます。 CD を挿入して Device Document 
Browser を使用すると、各デバイスのドキュメントを検索、表示、印刷

することができます。 Device Document Browser をインストール後、

デバイスの文書はスタート→プログラム→ National Instruments →

NI-DAQ → Browse Device Documentation から表示できます。
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SCXI およびスイッチのマルチシャーシ構成

『SCXI-1346 Shielded Multi-Chassis Cable Installation Guide』には、

SCXI の開発とスイッチマルチシャーシのアプリケーションのセットアッ

プの説明が記載されています。

スイッチ

『NI Switches Help』には、スイッチモジュールおよび NI-SWITCH 計測

器ドライバ用の技術プログラムサポートがあります。

『NI-SWITCH Instrument Driver Quick Reference Guide』には、API の
概要および関数 /VI の概念の説明が記載されています。

カスタマートレーニング
ナショナルインスツルメンツでは、NI 製品を使用してアプリケーション

開発を行うためのトレーニングコースを用意しています。 トレーニング

コースへのご登録、またはそのコース概要については、ni.com/jp/
trainingをご覧ください。

技術サポート
その他のサポートについては、ni.com/jp/supportまたは ni.com/
zoneを参照してください。

従来型 NI-DAQ と NI-DAQmx を同じコンピュータで
使用する

NI-DAQ の旧バージョンで開発された既存のアプリケーションは従来型

NI-DAQ で動作します。 従来型 NI-DAQ API および NI-DAQmx API の同

じコンピュータでの使用については、以下の制約があります。

• 一度に 1 つの API しかデバイスを制御できません。

– NI-DAQmx でデバイスを使用後、従来型 NI-DAQ でデバイスを

使用する前に、そのデバイスを使用しているすべての

NI-DAQmx のタスクを解除する必要があります。 NI-DAQmx タ

スクを解除するには、DAQmx Clear Task VI または関数を呼び

出します。

– 従来型 NI-DAQ でデバイスを使用後、NI-DAQmx でデバイスを

使用する前に、デバイスをリセットする必要があります。 SCXI
デバイスの場合は、組み合わせて使用している DAQ デバイスを

リセットする必要があります。

• Traditional NI-DAQ Device Reset VI または

Init_DA_Brds関数を呼び出します。
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• 従来型 NI-DAQ ですべてのデバイスをリセットするには、

MAX の従来型 NI-DAQ デバイスフォルダを右クリックし

て、Reset Driver for Traditional NI-DAQ を選択します。

• 1 つの SCXI データ集録システムのすべてのデバイス ó 接続された

DAQデバイスおよび挿入されたSCXIモジュールóをプログラムする

には、同じ API を使用する必要があります。

次のトピックの詳細と説明については、ni.com/support/jaを参照して

ください。

• 従来型 NI-DAQ アプリケーションに NI-DAQmx コードを追加する方

法

• 同じデバイスを使用する、従来型 NI-DAQ アプリケーションおよび

NI-DAQmx アプリケーションの両方を実行する方法

オペレーティングシステム、アプリケーションソフト
ウェア、プログラミング言語、および NI-DAQ 7.0 デ
バイスサポート

NI-DAQmx 7.0 では、現在すべての NI 計測デバイス製品はまだサポート

していません。 将来の NI-DAQ のリリースでは、新規デバイスおよび既存

デバイス用の NI-DAQmx のサポートを追加します。また引き続き従来型

NI-DAQ もサポートします。

オペレーティングシステムサポート
NI-DAQmx、従来型 NI-DAQ、および NI-SWITCH 2.0 は Windows 
2000/NT/XP/Me/98 をサポートします。Windows NT ではサービスパッ

ク 6 またはそれ以降が必要です。 Measurement Studio には Windows 
2000/NT 4.0/XP で動作する Visual Studio .NET 2003 が必要です。 各オペ

レーティングシステムのインストール方法については、ni.com/
support/installから Hardware Installation Wizard を使用します。

他のオペレーティングシステムをサポートする NI-DAQ の旧バージョン

を見つけてダウンロードするには、ni.com/downloadsを参照します。

アプリケーションソフトウェアおよびプログラミング言語サポート
表 1 は、NI-DAQmx および従来型 NI-DAQ でサポートされるアプリケー

ションソフトウェアのバージョンです。 NI のアプリケーションソフトウェ

アを使用しない場合は、表 2 を参照してください。
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表 2 は、NI-DAQmx および従来型 NI-DAQ がサポートするプログラミン

グ言語とそのバージョンです。
 

NI-DAQ の旧バージョンは他のアプリケーションソフトウェアおよび他の

言語のバージョンをサポートします。 ドライバの旧バージョンを見つけて

ダウンロードするには、ni.com/downloadsを参照してください。

デバイスサポート
特定のデバイスモデル名については、CD にある『NI-DAQ 7.0 
Readme』ファイルを参照してください。 表 3 は、NI-DAQmx、従来型

NI-DAQ、および NI-SWITCH 2.0 でサポートされるデバイスの種類です。

表 1 NI-DAQ 7.0 アプリケーションソフトウェアサポート

NI アプリケーションソフ

トウェア

NI-DAQmx でサ

ポートされている

バージョン

従来型 NI-DAQ で

サポートされてい

るバージョン

LabVIEW  7.0 6.0 ～ 7.0

LabVIEW RT モジュール — 6.0 ～ 7.01

LabWindows/CVI  7.0 6.0 ～ 7.0

Measurement Studio  7.0 6.0 ～ 7.02

1 LabVIEW RT を使用する際には該当する DAQ アプリケーションの従来型 NI-DAQ が必要
です。 NI-DAQmx の今後のバージョンには LabVIEW RT のサポートがあります。
2 従来型 NI-DAQ には Measurement Studio C++ や .NET インタフェースは含まれません。

表 2 NI-DAQ 7.0 プログラミング言語サポート

プログラミング言語

NI-DAQmx で

サポートされ

ているバー

ジョン

従来型

NI-DAQ でサ

ポートされて

いるバージョ

ン

ANSI C ✓ ✓

Microsoft Visual C++
Class ライブラリ
C DLL

7.01

6.0 ～ 7.0
—

6.0 ～ 7.0

Visual Basic 6.0（ActiveX 使用） — 6.0

Microsoft .NET 言語
（C# および Visual Basic .NET）

.NET 1.1 —

1 Measurement Studio 7.0 が必要です。
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NI-DAQ 7.0 でサポートされている新規デバイスのリストについては、

NI-DAQ 7.0 CD にある『NI-DAQ 7.0 Readme』ファイルを参照してく

ださい。

表 3 NI-DAQ 7.0 デバイスサポート

デバイス NI-DAQmx
従来型

NI-DAQ NI-SWITCH 2.0

NI PCI-6052E などの PCI および PXI E シ
リーズマルチファンクション DAQ デバイ
ス

✓ ✓ 該当なし

USB および FireWire（IEEE 1394）用

DAQPad デバイス

— ✓ 該当なし

DAQCard E シリーズ PCMCIA デバイス — ✓ 該当なし

NI PCI-6013/6014 16 ビットベーシックマ
ルチファンクション DAQ デバイス

— ✓ 該当なし

NI PXI-6115 などの S シリーズマルチファ
ンクション DAQ デバイス

— ✓ 該当なし

NI 653X シリーズデバイスなどのデジタル

I/O デバイス

— ✓ 該当なし

NI PCI-4551、PCI-4552、PCI および

PXI-4472 ダイナミック信号集録デバイス

— ✓ 該当なし

NI PCI および PXI 671X/673X アナログ出
力デバイス

— ✓ 該当なし

NI 660X カウンタ／タイマ I/O デバイス — ✓ 該当なし

NI SCXI-1530、SCXI-1531、および

SCXI-1540 信号調節モジュール

✓1 ✓ 該当なし

その他すべての SCXI 信号調節モジュール ✓ ✓ 該当なし

SCC シリーズ信号調節モジュール ✓ ✓ 該当なし

NI SCXI-1166 および SCXI-1193 スイッチ
モジュール

✓ — ✓

その他すべての SCXI スイッチモジュール ✓ ✓ ✓

NI PXI-2566 および PXI-2593 スイッチモ
ジュール

✓ — ✓

その他すべての PXI スイッチモジュール — — ✓

NI PXI-4204 および PXI-4220 モジュール ✓ — —

1 これらデバイスは、加速度計、線形電圧差動変圧器（LVDT）、可変差動変圧器（RVDT）仮想チャネルのサポートなしで、
NI-DAQmx でサポートされています。
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NI-DAQmx の今後のバージョンでサポートされ
るデバイス
NI-DAQ の今後のリリースでは、現在は従来型 NI-DAQ でのみサポート

されているデバイスを NI-DAQmx でサポートします。

従来型 NI-DAQ で制約されているデバイス
NI-DAQmx は以下のデバイスをサポートしていません。また、今後の

NI-DAQ のリリースでもサポートしません。 以下のデバイスは従来型

NI-DAQ のみでサポートされます。

• AT E シリーズデバイス

• AT-AO-6/10 アナログ出力デバイス

• AT-DIO-32F 32 ビットパラレル DIO デバイス

• DAQCard-AI-16E-4 および DAQCard-AI-16XE-50 PCMCIA
デバイス

• NI PCI-4451/4452/4454 ダイナミック信号集録生成デバイス

• NI 4350/4351 データロガー

NI-DAQ 7.0 でサポートが廃止されたデバイス
以下のデバイスは NI-DAQ 7.0（NI-DAQmx または従来型 NI-DAQ）でサ

ポートされず、NI-DAQ の今後のバージョンでもサポートされません。 こ
れらのデバイスをプログラムするには、NI-DAQ 6.9.x またはそれ以前の

バージョンが必要です。

• AT-MIO-16F-5 マルチファンクション DAQ デバイス

• DAQCard-500、DAQCard-516、DAQCard-700、
DAQCard-1200、および DAQCard-AO-2DC PCMCIA デバイス

• パラレルポート用 DAQPad-1200 および DAQPad-MIO-16XE-50 デ

バイス

• PC ISA および PC/XT MIO デバイスの Lab-PC シリーズ

• PC-516 16 ビット、50 kS/ 秒 MIO デバイス

• PC-AO-2DC 低コスト AO および電流ループ DAQ デバイス

• PC 用 PC-LPM-16PnP MIO デバイス

• PC 用 PC-OPDIO-16 光絶縁 DIO デバイス

• PC 用 PC-TIO-10 タイミングおよび DIO インタフェース

• PC-1200 12 ビット、100 kS/ 秒 MIO デバイス

• SCXI-1200 12 ビット DAQ および制御モジュール

• SCXI-2000 4 スロットシャーシ

• SCXI-2400 シリアルインタフェースモジュール

• VXI DAQ モジュール、VXI-SC キャリアおよびモジュール、および

VXI バス用 VXI-TB ターミナルブロック
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